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Preface 0
Bruker strives to supply you with instructional and accurate doc-
umentation. We encourage you to tell us how we are doing.
Please send us your suggestions for improvements, corrections,
or bug reports. If there is anything you particularly liked, tell us
as well. With your input and assistance, Bruker can continually
improve its products and documentation.

You can send your messages and correspondence via e-mail,
FAX, telephone, or mail. It is important to include the document
name, product name, version number, and page number in your
response. Here are the addresses and numbers to which you can
send your messages.

e-mail: epr_applications@bruker-biospin.com

FAX: 978-670-8851

Tel. 978-663-7406

mailing
address

EPR Division
Bruker BioSpin Corporation
19 Fortune Drive
Manning Park
Billerica, MA 01821 USA

Thank you for your help.
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Electrical Safety
Electrical Safety 0.1
Do not remove any of the protective covers or panels of the
instrument. They are fitted to protect you and should be opened
by qualified service personnel only.

Power off the instrument and disconnect the line cord before
starting any cleaning work in the spectrometer. Never operate
the instrument with the grounding cord disconnected or by
passed. Facility wiring must include a properly grounded power
receptacle.

Chemical Safety 0.2
Individuals working with hazardous chemicals, toxic substances,
or enclosed liquid samples must take every precaution possible
to avoid exposure to these agents. As a general rule, THINK OF
THE CHEMICAL LABORATORY AS A HAZARDOUS
ENVIRONMENT IN WHICH YOU MUST CONTINUALLY
MAINTAIN A HIGH STANDARD OF VIGILANCE. Do not
assume a cavalier attitude -- the substances with which you work
present very real, and very serious threats to your health and
safety.

Adhere to all currently recommended guidelines for standard
laboratory safety as promulgated by governmental codes and
contemporary laboratory practice. Inform yourself about the
specific risks that are present when you handle actual or poten-
tial carcinogens (cancer-causing agents), explosive materials,
strong acids, or any liquids that are sealed in glass containers.
iv



Chemical Safety
Specifically:

� Be extremely careful when you handle sealed glass samples
that are rapidly heated or cooled. The rapid cooling of some
samples may result in the formation of a solid bolus in the
sample tube that may make the tube prone to explosive rup-
ture.

� Educate yourself about the temperature at which chemicals
evaporate. When a sample gets close to the temperature at
which it evaporates, it may quickly become volatile.

� In general, the safety threat posed by flying glass and vio-
lently escaping gases and liquids should not be underesti-
mated.

� Wear safety glasses, face masks, and other protective cloth-
ing whenever there is any risk of spillage, breakage, or explo-
sion. Protective shields should also be employed when there
is any risk of explosion.

� Be sure that both storage and working areas are properly ven-
tilated. They should be equipped with powerful blowers and
fume heads.

� Store chemicals safely. Avoid integrating containers of chem-
icals that may result in dangerous combinations.

� Practice good housekeeping in work and storage areas. Clean
up spills and refuse promptly. Do not leave volatile, combus-
tible, or acidic liquids exposed on counters, benches, or other
work areas.

� Make certain all chemical containers are properly labeled and
classified, and that especially hazardous materials are appro-
priately designated with clearly understood decals or warn-
ings.

� Never taste or inhale unmarked chemicals.
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Microwave Safety
� All laboratories should be equipped with fire doors, fire
extinguishers, fire smothering materials, and sprinkler sys-
tems or showers, as well as a detailed fire safety plan.

Microwave Safety 0.3

As long as the microwaves are contained in metal structures,
microwaves can be very safe. Here are some precautions which,
if followed, will eliminate the possibility of injury due to the
microwaves.

� Do not have an open waveguide when the microwave power
is on.

� Switch the bridge to standby when you remove or change
EPR cavities.

� Never look down an open waveguide when there is micro-
wave power. The eyes are very susceptible to damage from
microwaves.
vi
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Introduction 1
We have described the basic operations of the Bruker Elexsys
E 500 EPR (Electron Paramagnetic Resonance) spectrometer in
the Elexsys E 500 User�s Manual: Basic Operations. We
strongly suggest users read that manual first before reading this
manual. The Bruker Elexsys E 500 EPR spectrometer features
many advanced functions that facilitate a wide variety of sophis-
ticated experiments. This manual introduces you to the many
advanced functions of the spectrometer. Owing to the abundant
features of the Elexsys E 500 spectrometer, it is almost impossi-
ble to describe every experimental situation or operation in one
volume. We encourage you to explore the information in this
manual to discover the methods and techniques that best suit
your experimental needs. 

How to Find Things 1.1
Chapter 2 This chapter describes the procedure for calibrating cavities and

signal channels so that you may obtain reproducible, quantita-
tive, and high sensitivity spectra.

Chapter 3 In order to maintain your spectrometer in optimal working con-
dition, it is a good idea to periodically test your system�s perfor-
mance. Chapter 3 describes how to measure the sensitivity of the
spectrometer.

Chapter 4 This chapter describes how to configure the spectrometer. It is
important to properly configure the spectrometer especially,
when you use accessories and perform advanced experiments.

Chapter 5 Calibrating the magnetic field precisely is vital for accurately
measuring g-values. We describe the procedure for calibrating
the magnetic field as well as determining g-values.
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How to Find Things
Chapter 6 In addition to the signal channels, the Elexsys E 500 EPR spec-
trometer includes a fast digitizer (ADF) for rapidly acquiring
transient EPR signals. This chapter describes how to perform
both rapid field and time scan experiments.

Chapter 7 The Elexsys E 500 spectrometer has many predefined experi-
ments. As an example, we introduce you to non-linear scans in
this chapter. You can learn how to acquire a non-linear 1D field
sweep spectrum and a 2D non-linear scan spectra. We hope this
introduction stimulates your interest to explore other built-in as
well as user- defined experiments.

Chapter 8 The built-in macros of Xepr simplify a complicated sequence of
operations to a simple mouse click. Chapter 8 provides you
information on how to create your own macros.

Chapter 9 Automatic post-processing provides automatic data processing
and storage after an acquisition. This chapter provides detailed
instructions for this feature.

Chapter 10 By making macros and other functions, you can customize your
Xepr software. To guide other users to use your customized
functions you can implement your own help files for the Xepr
help system. This chapter shows you how to do so in a simple
way.

Chapter 11 Many different microwave bridges are available. This chapter
explains how to change microwave bridges.

Chapter 12 Bruker provides many optional accessories to help customers
succeed with their experiments. The Elexsys E 500 accommo-
dates a wide variety of accessories. In this chapter you can find
information on how to set up the most commonly used accesso-
ries, such as an external frequency counter, goniometer, variable
temperature unit, field frequency lock, and teslameter. 
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How to Find Things
Chapter 13 This chapter describes the function and operation of the many
indicators, inputs, and outputs of the modules in the console.

Chapter 14 Many sophisticated experiments such as double modulation,
quadrature detection, or externally triggered experiments can be
realized. This chapter describes how to set up these advanced
experiments.

Chapters 15 & 16 These chapters describe many system administration issues
related to the Xepr program. Chapter 15 covers the SGI IRIX
operating system and Chapter 16 deals with Linux. Installation
and setup of Xepr is described. The computer workstation is
equipped with full networking capabilities. Not only can you
transfer data through the network but you can also control the
spectrometer remotely. This chapter demonstrates how to per-
form remote operations. It also offers advice on setting up and
troubleshooting printers.

Chapter 17 This chapter describes diagnostics for troubleshooting the acqui-
sition server.
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Typographical Conventions
Typographical Conventions 1.2

Fonts 1.2.1
Special fonts are used in the text to differentiate between normal
manual text and the text displayed in the program.

Times This is the font used for the normal text in the manual.

Helvetica This is the font used for text that is displayed by the program or
must be entered into the program by you.

Special notes 1.2.2
Some special notation is employed in this manual to simplify the
descriptions.

< ... > The content between the brackets needs to be substituted with
proper entries by the user.

> The right bracket indicates sequential selection of the menu
entries. For example, Processing > Filtering > Smoothing
means clicking the Processing button in the menu bar, followed
by clicking Filtering in the sub-menu, and then clicking
Smoothing.

You will see a warning box sometimes in the lefthand margin.
These are meant to point out critical information. In particular, it
warns you about any procedures or operations that may be dan-
gerous to the spectrometer or you. Always read and follow this
advice.

In addition, there are also hint boxes in the lefthand margin
These are meant to be helpful hints and point out important
information.

Warning box.

Hint box.
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EPR Spectrometer Calibration 2
For many experiments, it is vital that your spectrometer is care-
fully calibrated. For example, it is essential to know the precise
values of the magnetic field modulation amplitude in order to
obtain quantitative EPR spectra. The calibration procedures in
this chapter enable you to measure the experimental conditions
produced by the spectrometer with considerable accuracy.

This chapter is not meant to be a general overview of spectrome-
ter calibration and quantitative EPR. Therefore, we highly rec-
ommend the following references which discuss the topic in
much greater detail:

� Poole, C.P. Electron Spin Resonance, a Comprehensive Trea-
tise on Experimental Techniques: First Ed., Interscience,
New York, 1967.

� Poole, C.P. Electron Spin Resonance, a Comprehensive Trea-
tise on Experimental Techniques: Second Ed., Wiley, New
York, 1983.

� Alger, R.S. Electron Paramagnetic Resonance: Interscience,
New York, 1968.
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Standard Samples
Standard Samples 2.1
Standard samples are useful for system performance tests, spec-
trometer calibration, and quantitative concentration measure-
ments. Ideally the standard sample should contain stable, long
lived paramagnetic species, be easily prepared under consistent
and controlled methods, and should be fully characterized with
respect to all spectroscopic parameters such as relaxation times
and hyperfine and fine structure splittings. In addition, the reso-
nance line should be narrow and preferably homogeneous.
Unfortunately, the universal standard sample has not been found.
Many standards have been suggested and each has its own par-
ticular merit. The standard samples supplied with every Bruker
spectrometer are discussed below.

DPPH (�, �� - diphenyl-ß-picryl hydrazyl) 2.1.1
DPPH serves as a reference both in the solid state and in the liq-
uid state when dissolved in benzene or toluene/mineral oil. The
line width measured from the solid is subject to exchange nar-
rowing and thus, varies from under 1 gauss to over 4 gauss,
depending on the solvent that was used for recrystallization. It
has a g factor of 2.0036 ± 0.0003. When dissolved in solution, a
quintet with unresolved hyperfine couplings is observed because
the spin exchange narrowing is reduced as the sample is diluted.
A small single crystal of DPPH is an ideal sample for calibrating
the phase and the field modulation amplitude of the signal chan-
nel of an EPR spectrometer. DPPH has been studied extensively
by:

� Möbius, K. and R. Biehl. Multiple Electron Resonance Spec-
troscopy: Plenum Press, 1979.

� Dalal, N.S., D.E. Kennedy, and C.A. McDowell. J. Chem.
Phys.: 59, 3403 (1979).

DPPH exh ib i t s
g-anisotropy, i.e. the
g-value depends on the
orientation of the sam-
ple with respect to the
magnetic field.
2-2



Standard Samples
� Hyde, H.S., R.C. Sweed, Jr., and G.H. Rist. J. Chem. Phys.:
51, 1404 (1969).

� Dalal, N.S., D.E. Kennedy, and C.A. McDowell. J. Chem.
Phys.: 61, 1989 (1974).

� Dalal, N.S., D.E.Kennedy, and C.A. McDowell. Chem. Phys.
Lett.: 30, 186 (1975).

Weak and Strong Pitch Samples 2.1.2
Pitch in KCl has emerged as a standard because of its long-lived
paramagnetic radicals and low dielectric loss. Because of the
long life of the radicals, it is unsurpassed as a test of spectrome-
ter sensitivity. The pitch is added to a powder of KCl and the
mixture is carefully mechanically mixed to obtain a homoge-
neous sample. After mixing, the sample is heated, pumped, and
sealed under vacuum. Pitch is generally prepared in two concen-
trations: strong pitch which is 0.11% pitch in KCl, and weak
pitch which is 0.0003% pitch in KCl.

To correct for variations in spin concentration, each weak pitch
sample is compared to a �standard� and assigned a correction
factor. The peak to peak line width is typically 1.7 G with a
g-factor of 2.0028. The size (very weak) of the signal renders
pitch ill suited for modulation amplitude calibration. The weak
pitch samples from Bruker Biospin have an estimated concentra-
tion of 1013 spins per centimeter. The samples are calibrated and
the correction factor is printed on the side of the tube. This sam-
ple is prepared for the purpose of measuring instrument perfor-
mance owing to its high stability, however, it is not meant as a
quantitative spin-counting standard.
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Theory of Signal Channel Calibration
Theory of Signal Channel Calibration 2.2
You need to carefully calibrate your spectrometer�s signal chan-
nel reference phase and modulation amplitude in order to obtain
maximum sensitivity, minimum distortion, and quantitatively
reproducible measurements. The SCT/H and SCT/L signal chan-
nels in conjunction with the Xepr software make this calibration
easy to perform. The results of the calibration are saved on disk
for future use. We recommend recalibration at least once a year
to ensure quantitative and reproducible results. Each cavity or
resonator has its own individual calibration file, therefore, this
procedure must be followed for each cavity.

Introduction 2.2.1
Calibration of the signal channel involves two separate yet inter-
dependent procedures. The first procedure is to calibrate the
peak to peak modulation amplitude. For the sake of brevity,
modulation amplitude will be used in place of peak to peak mod-
ulation amplitude. The second procedure is to calibrate the phase
difference between the reference signal and the modulated EPR
signal. Because the calibration and adjustment of the modulation
amplitude can affect the phase difference, the first procedure is
performed first.
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Theory of Signal Channel Calibration
Amplitude Calibration 2.2.2
You calibrate the modulation amplitude by overmodulating a
narrow EPR signal. A crystal of DPPH, with a line width of
approximately 1 G, is a very good sample to use. When the mod-
ulation amplitude is large compared to the line width, the mag-
netic field modulation brings the sample into resonance before
and after the magnet has reached the field for resonance. This
results in a broadening and distortion of the EPR signal. (See
Figure 2-1.) In the limit of an infinitesimally narrow EPR sig-
nal, the peak to peak width of the first derivative EPR signal will
be approximately equal to the peak to peak modulation ampli-
tude. 

The first step of calibrating the modulation amplitude involves
choosing the correct tuning capacitors. The modulation ampli-
fier needs a bit of help to obtain large modulation amplitudes at
modulation frequencies greater than 50 kHz. This is a conse-
quence of the decreasing skin depth with increasing frequency.

Figure 2-1 The signal shape of the DPPH EPR signal as a function of the field
modulation amplitude.
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Theory of Signal Channel Calibration
The modulation coils on the cavity are tuned, or made resonant,
by adding a tuning capacitor in series with the modulation coil.

The calibration routine switches various tuning capacitors in and
out of the circuit until the modulation amplitude is maximized.
The optimal capacitor for that particular frequency as well as the
modulation amplitude for full gain of the modulation amplifier
are recorded and saved with the calibration file. Once this data is
available, the signal channel will then vary the input signal to the
modulation amplifier to produce the modulation amplitude that
you have selected. 

Those familiar with older EPR spectrometers will remember the
tuning boxes for tuning the modulation coils. The above men-
tioned software and hardware makes these tuning boxes unnec-
essary as well as adding great flexibility in the choice of
modulation frequencies.

Figure 2-2 The LC resonant circuit for high frequencies.

Modulation
Coil

Tuning
Capacitor
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Theory of Signal Channel Calibration
Phase Calibration 2.2.3
Once the modulation amplitude has been calibrated, the refer-
ence phase is easily calibrated by studying the phase angle
dependence of the signal intensity. The intensity of the output
signal is proportional to the cosine of the phase difference
between the reference signal and the modulated EPR signal.
(See Figure 2-3.) It is most convenient to determine where the
90� phase difference occurs because first, the absence of a signal
(cos(90�) = 0) is easy to detect and second, the cosine function
(and hence the intensity) changes rapidly with respect to the
phase angle at 90�. In the calibration routine, spectra are
acquired at several different values of the reference phase and
the 90� phase difference is extrapolated from the signal intensi-
ties. The phase angle resulting in maximum signal intensity for
that particular frequency is recorded and saved with the calibra-
tion file.

The phase difference between the modulated EPR signal and the
reference signal depends on several experimental conditions.
The length of the cable leading to the modulation coils, the
inductance of the coils in the particular cavity, the gain setting of
the modulation amplifier, the tuning capacitors, and the signal
channel used can all change the phase difference. However, the
reference phase calibration is performed automatically during
the routine described in this section.

The two editions of the book by C.P. Poole that are mentioned at
the beginning of this chapter are very good references for the
details on the theory of phase sensitive detection and the calibra-
tion of signal channels. We encourage you to explore this topic
further to learn more about calibration.
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Theory of Signal Channel Calibration
Figure 2-3 The signal intensity as a function of the reference phase angle.
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Calibrating the Signal Channel
Calibrating the Signal Channel 2.3
1. Get ready for the calibration routine. Follow the

instructions of Section 3.1 and 3.2 of the Elexsys E 500
User�s Manual: Basic Operations. You should have the
spectrometer turned on, the cavity properly installed with
a Bruker standard DPPH sample in it, and the microwave
bridge and cavity tuned. Remove cryostats from the cavity
because it is easier to position the DPPH sample properly
in the cavity. (Except for the FlexLine resonators: it is
necessary to use the ER 4118CF cryostat when calibrating
FlexLine resonators.) Another advantage is that the reso-
nant frequency of the cavity will be approximately
9.8 GHz without the helium cryostat and the field for the
DPPH signal will be known (approximately 3500 Gauss).
The DPPH sample is a point sample so it is important to
have it roughly centered in the cavity. The sample has a
mark on it indicating where the DPPH is. The distance
from the collet to the center of the cavity is approximately
70 mm.

Figure 2-4 The approximate distance from the collet to
the center of the cavity.

Do not attempt to cali-
brate a cavity with an
E R 4 11 2 HV  o r  E R
4113HV helium cryostat
installed in the cavity.
The c ryos ta t  sample
h o l d er  p re v en t s  t h e
DPPH  s amp le  f rom
being centered properly.

70 mm
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Calibrating the Signal Channel
2. Create a calibration experiment. Click the New
Experiment button in the monitoring panel and the dialog
box will appear. (See Figure 2-5.) Enter a name for the
experiment (calibration for example) in the Experiment
Name column. Click the Calib tab. Make sure the Stan-
dard push button is activated (green). The R.F. button is
for ENDOR calibration. Click the Create button to close
the dialog box. 

3. Open the parameter dialog box. Click the Parame-
ter button to open the Calibration Parameters dialog
box. If the Calibration folder is not in front, click its tab
to bring it to the front. (See Figure 2-6.)

Figure 2-5 Creating a calibration experiment.

Create an
Experiment
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CalibrationClick

Create
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Calibrating the Signal Channel
Figure 2-6 The Calibration Parameters dialog box.
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Calibrating the Signal Channel
4. Set the calibration frequency range. A calibration
is required for each modulation frequency that you intend
to use. The SCT/H signal channel, has a range of 100 kHz
to 6 kHz in 0.1 kHz steps. The SCT/L signal channel cov-
ers the frequency range of 6 kHz to 100 Hz in 1 Hz steps.
Most people will normally run all their spectra using
100 kHz modulation, but under some special circum-
stances, other frequencies may be desirable. A good
approach to take is to calibrate the signal channel every 10
kHz from 100 kHz to 10 kHz. A sufficiently large range
of frequencies is then covered for most EPR experiments.
Enter the Mod. Frequency Start [kHz] (usually
100 kHz), Mod. Frequency End [kHz] as well as the
Mod. Frequency Increment [kHz] values. The start
value  must  be  greater  than  the  end value .  (See
Figure 2-6.) Note that you should set the start and end
values equal to each other for ER 4122SHQE or
ER 4119HS cavities so that only one frequencies at a time
is calibrated. (See the warning in the lefthand margin.)

5. Set initial values for the tuning caps search. The
parameters in this section set the starting values for the
tuning capacitor search. (See Figure 2-6.) The Initial
Modulation Amplitude defines the modulation amplitude
used when optimizing the tuning capacitors. The default
value, 10%, is appropriate for most cavities and resona-
tors. The default Initial Sweep Width of 20 G works well
for a DPPH sample. If you know an approximate optimal
value for the tuning capacitors at 100 kHz, you can enter
that value in Tuning C Start Value. This will save you
time because otherwise the searching routine will start
from 0 nF. Mod Frequency Limit is always set at 50 kHz
because skin depth poses less of a problem at lower fre-
quencies.

The EN 801 ENDOR
resonator should not be
used above 25 kHz.
Consult the Elexsys
E 560 documentation
for instructions on cali-
brating this cavity.

The ER 4122SHQE
and ER 4119HS reso-
nators should only be
calibrated one modula-
t ion f requency a t  a
time! At lower modula-
tion frequencies, the
modulation amplitude
can get  sufficient ly
large to damage the
coils. The Mod. Ampli-
tude Limit needs to be
adjusted separately for
each modulation fre-
quency.
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Calibrating the Signal Channel
6. Adjust the Mod. Amplitude Limit. The Mod. Ampli-
tude Limit parameter limits the size of the signal sent to
the modulation amplifier. This prevents damage to the
coils owing to excessive current. Enter a value of 75% for
an ER 4122 SHQ cavity. For Flex-line resonators, a value
of 10% is more appropriate. A value of 30% works well
for ER 4122SHQE and ER 4119HS cavities. It is always
safe to set this value a bit low as you will adjust this value
later. A 100 G Sweep Width is sufficient for most reso-
nators. (See Figure 2-6.)

7. Enter values for the modulation phase search.
The parameters in this step depend on your calibration
sample. The default values of 1 G Sample Line Width
and 20 G Sweep Width work well with the Bruker DPPH
standard. The signal channel can produce either a first
harmonic (first derivative) or a second harmonic (second
derivative) spectrum. If you have no need for second har-
monic spectra and wish to save a bit of time in the calibra-
tion routine, you may deselect this option by clicking the
Calibrate 2nd Harmonic button. The green color indi-
cates that the option is selected. (See Figure 2-6.)

8. Enter the filename for the calibration file. Click the
Results tab. (See Figure 2-7.) The calibration file name
usually consists of two to four letters that identify the type
o f  c a v i t y  ( S T  f o r  E R 4 1 0 2 S T  o r  S H Q E  f o r
ER 4122SHQE) followed by the serial number of the cav-
ity. This number is found on the back or front of the cav-
ity. For FlexLine series resonators the serial number is
found at the top part of the module block. Enter the cali-
bration file name into the Calibration Data Set box. If
you are re-calibrating, you can click the file name in the
drop down list of the Calibration Data Set. The new val-
ues will be appended to the calibration file or replace pre-
vious values in the file. If you want to start fresh, click the
Delete Data Set button to delete the old calibration data. 

It is not necessary to
calibrate every 100 Hz
from 100 kHz to 10
kHz.  In  pa r t i cu l a r,
FlexLine resonators in
a cryostat with no gas
flow can become suffi-
ciently warm to dam-
age the resonator if you
calibrate more than 20
f req u en c i e s  i n  o ne
experiment.

Better safe than sorry.
It is a good idea to cali-
brate the phase of the
second harmonic when
running the calibration
routine.
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Calibrating the Signal Channel
9. Select the resonator. In almost all cases, the 1st Res-
onator should be selected. (See Figure 2-7.) The
ER 4105DR dual cavity has two sets of modulation coils.
By selecting 1st Resonator or 2nd Resonator, you are
selecting the set of modulation coils that are to be cali-
brated.

Figure 2-7 The Results folder of the Calibration Parameters dialog box.

Select
Resonator

AFC Trap
FilterHigh Pass

Filter

Setup
Scan

Delete
Data Set
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Calibration
File Name

The ER 4105DR dual
cavity is different from
the ER 4116DM dual
m od e  c av i t y.  T h e
ER 4116DM has only
one set of modulation
coils.
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Calibrating the Signal Channel
10. Turn on the AFC Trap and High Pass Filters. The
AFC trap filter blocks any signal components at the AFC
modulation frequency that may contribute to noise in the
EPR signal. The high pass filter suppresses low frequency
signal components that also contribute to added noise in
the EPR signal. These two filters influence the calibration
values of the signal channel. By default they are both
selected. Ensure that both options are selected. (See
Figure 2-7.) Only under very rare circumstances would
you acquire spectra without these filters.

11. Start the Setup Scan. When the Setup Scan function
is activated, the magnetic field is swept rapidly (up to 50
Gauss at about a 30 Hz rate) to provide a �real time� dis-
play of the EPR spectrum on the screen. Click the Setup
Scan button in the Results folder. (See Figure 2-7.) 

Figure 2-8 The Setup Scan window.

Activate Button

Setup Scan
Button Setup Scan

Time Constant
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Calibrating the Signal Channel
A Setup Scan window will appear. Click the Activate
button in the monitoring panel if it is not already acti-
vated. Then click the Setup Scan button in the Setup
Scan window to activate it. (See Figure 2-8.) Leave this
window open so you can adjust the parameters interac-
tively.

12. Set the Microwave Attenuator to approximately
25 dB. Click the Microwave tab. Set the microwave
power to 25 dB. (See Figure 2-9.) 

Figure 2-9 The Microwave folder of the Calibration Parameter dialog box.
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Calibrating the Signal Channel
13. Center your DPPH spectrum in the display. Click
the Absc.1: Field tab. (See Figure 2-10.) Arrange the
Calibration Parameters window and the Setup Scan
dialog box so that you can see both of them at the same
time. Make sure that the Center box is selected (green).
Adjust the Center Field value by entering a field value or
clicking on the up and down arrows until the signal
appears centered in the Setup Scan window. For a
microwave frequency of about 9.8 GHz, DPPH resonates
at 3500 Gauss. Reducing the Sweep Width in the Setup
Scan window can help you to center the signal.

You should be able to
see the DPPH signal by
now. If you do not see
the signal, change the
modulation phase by 90
degree. If you still can
not find the signal, refer
to  Chapte r  8  o f  t he
Elexsys E 500 User�s
Manual: Basic Opera-
tions

Figure 2-10 The Absc.1: Field folder of the Calibration Parameters dialog box.
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Calibrating the Signal Channel
14. Adjust other parameters. Adjust the Receiver Gain
so that the signal fills approximately half of the vertical
display range in the Setup Scan window. Make sure that
the signal channel is set to 100 kHz modulation (or the
maximum modulation frequency you entered in the Cali-
bration folder) and first harmonic detection. A 1 gauss
Modulation Amplitude usually is sufficient.

15. Optimize the DPPH sample position. Move the
sample tube up and down until the maximum signal inten-
sity is attained. (See Figure 2-11.) Avoid moving the
sample from side to side. Perhaps the best technique is to
loosen the collet nuts for the pedestal and sample tube and
move the sample too low. Then use the pedestal to slowly
push the sample up. Sometimes the process of moving the
sample tube in the cavity can cause the AFC to lose lock.
Re-tune the frequency if this happens. If the signal is
clipped, decrease the Receiver Gain. Rotate the sample
tube until the maximum signal intensity is attained. When
you have maximized the signal intensity, secure the sam-
ple tube by tightening the collet nuts. Check the matching
if needed. You may need to re-center the signal by adjust-
ing the Center Field in the Absc.1: Field tab.

The EN 801 ENDOR
resonator should not be
used above 25 kHz.
Consult the Elexsys
E 560 documentation
for instructions on cali-
brating this cavity.
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Calibrating the Signal Channel
Figure 2-11 Fine adjustment of the DPPH sample height in the cavity.

DPPH
Sample
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Calibrating the Signal Channel
16. Close the Setup Scan window. Click the Close but-
ton in the Setup Scan window.

17. Reset some parameters. After centering the DPPH
sample, most of the parameters should be fairly close to
what is needed for the calibration routine. Set the
Receiver Gain to approximately 36 dB. 

18. Start the calibration routine. Click the Result tab.
Move the Calibration Parameters window to the corner
so that you can see the acquisition and the calibration
result at the same time. Click the Run button in the moni-
toring panel to start the calibration routine. 

Figure 2-12 The Acquisition control buttons.
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Calibrating the Signal Channel
19. Adjust the Receiver Gain. Monitor the Receiver
Level while the scan is running. (See Figure 2-13.)

If the needle deflects more than 1/4 of the display, stop the
calibration routine by clicking the Run/Abort button.
Lower the Receiver Gain and restart the calibration by
clicking the Run button again. A warning message will
appear asking if you want to overwrite the existing value.
Click the Yes button to continue. Repeat until the needle
does not deflect more than 1/4 of the display. You may
have to repeat this last step a few times.

Figure 2-13 Monitoring the Receiver Gain.

Receiver
Level
Meter
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Calibrating the Signal Channel
20. Observe the calibration results. The Results folder
consists of a table of parameter values and settings for
each modulation frequency. The first column is the modu-
lation frequency. For modulation frequencies greater than
or equal to 50 kHz, the optimal tuning capacitor value is
listed in the second column. The third column contains the
value of Mod Amp [% max]. Mod Amp [G] in the fourth
column is the measured maximum modulation amplitude
when the corresponding Mod Amp [% max] is used.
Phase #1 and Phase #2, in columns five and six respec-
tively, are the phases at which the first and second har-
monic signals are nulled. (See Figure 2-14.)

Figure 2-14 The calibration results.
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Calibrating the Signal Channel
21. Check the Mod. Amp [G] at 100 kHz. The calibration
routine performs its task sequentially, starting with the
highest modulation frequency and continuing for each
selected modulation frequency. As each parameter is
determined, it is displayed in the table. (See Figure 2-14.)
Wait until the 100 kHz calibration is completed. Click the
Pause button of the Acquisition Control buttons. Note
the value in the fourth column of the table, Mod Amp [G].
Compare the Mod Amp [G] at 100 kHz with the values
listed for your cavity in Table 2-1. If the value obtained by
the calibration routine is slightly less than or approxi-
mately equal to the value listed in Table 2-1, allow the cal-
ibration routine to continue its task by clicking the Pause
button again and proceed to Step 23. If the value exceeds
the values listed in Table 2-1, stop the calibration routine
by clicking the Run/Abort button in the Acquisition
Control buttons. Values that are too high can allow exces-
sive current to flow through the modulation coils of the
cavity at the maximum modulation amplitude, resulting in
damaged modulation coils. 
Elexsys E 500 User�s Manual: Advanced Operations 2-23



Calibrating the Signal Channel
Cavity Maximum Mod. / Gauss 
at 100 kHz

ER 4102ST 32
ER 4105DR 32
ER 4104OR 32
ER 4116DM 10
ER 4103TM 16
ER 4108TMH 32
ER 4106ZRC 10
ER 4106ZRAC 10
ER 4107WZC 10
ER 4107WZAC 10
ER 4115ODC 10
ER 4115ODAC 10
ER 4119HS 25
ER 4122SHQ 15
ER 4122SHQE 25
ER 4114HT 7
ER 4117MX 
(or D-MVT)

10

ER 4117D-R 32
ER 4109EF 10

Table 2-1 Maximum modulation amplitude for EPR cavities.
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Calibrating the Signal Channel
22. Reset the Mod. Amplitude Limit. The Mod. Ampli-
tude Limit parameter which was set in Step 6. limits the
size of the signal sent to the modulation amplifier to pre-
vent any danger of burning out the modulation coils. To
calculate a safer value for Mod. Amplitude Limit use the
following formula:

Mod Amplitude Limit = Mod Amp[%max] 

where Mod Amp[%max] and Mod. Amp [G] are the val-
ues listed in the calibration table and Max. Mod. is the
maximum modulation amplitude listed for your cavity in
Table 2-1. Enter this new value for Mod. Amplitude
Limit in the Calibration tab. Click the Results tab to
bring it to the front. Click the Run button to restart the
calibration routine. 

23. Finish the calibration. When the routine is finished the
Run button will no longer be highlighted and the calibra-
tion data for the lowest modulation frequency is com-
pleted. (I.e. the calibration data in the Results tab are no
longer -1.) 

24. Special Instructions for ER 4122SHQE and
ER 4119HS cavities. It was mentioned on page 12 that
these cavities should be calibrated one frequency at a
time. An additional requirement is that the Mod. Ampli-
tude Limit be set properly at each modulation frequency.
Follow Step 21. and Step 22. for each of the individual
modulation frequencies after you have started the calibra-
tion routine for that frequency.

Max. Mod.
Mod. Amp [G]
------------------------------------
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Calibrating the Signal Channel
25. Adding additional frequencies. If you wish to add
more frequencies to the calibration file, for example lower
frequencies below 10 kHz, the remaining instructions
guide you through the necessary steps. Click the Calibra-
tion tab. Change the Mod. Frequency Incr. (for example,
to 2 kHz). Change the Mod. Frequency Start (for exam-
ple to 5 kHz). Change the Mod Frequency End (for
example to 1 kHz). (See Figure 2-15.) For modulation
frequencies less than 10 kHz you need to reset the Mod.
Amplitude Limit to 10%.

Figure 2-15 Changing the Frequency Range.
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Calibrating the Signal Channel
26. Start the calibration routine. Click the Run button to
start the calibration routine. The low modulation fre-
quency calibration data will be appended to the table. If
there is one or more calibration frequencies already exist-
ing in the previous calibration file, a warning message
will appear on the screen asking you if you want to over-
write the existing value. Click the Yes or No button
(depending on your wishes) to continue the calibration
routine. Notice that the previous calibration data for other
frequencies are still kept in the file.

27. Close the Calibration Parameters dialog box.
Click the Close button in the Calibration Parameters
dialog box. The signal channel is now calibrated for your
cavity and the data saved in the calibration file. The next
time when you connect the Xepr software to the spec-
trometer, this calibration file will be the default calibra-
tion file.
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System Performance Tests 3
This chapter describes procedures for testing the performance of
your Bruker EPR spectrometer. The test measures the spectrom-
eter's sensitivity. The procedure is especially designed to test as
many of the components of the spectrometer as possible with
one simple test. It therefore gives you a good indication of the
overall health of your spectrometer. It is also an excellent crite-
rion for comparing the sensitivity of different spectrometers.
Should your spectrometer or cavity not meet specifications, first
consult Chapter 9 of the Elexsys E 500 User�s Manual: Basic
Operations on troubleshooting. If none of the hints solve the
problem, contact your Bruker EPR service representative.
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Signal to Noise Ratio Test
Signal to Noise Ratio Test 3.1
The signal to noise ratio test is an important part in maintaining
your spectrometer. It is also helpful in diagnosing possible prob-
lems you may encounter especially when you deal with very
weak signals or quantify your EPR signals. The signal to noise
ratio test uses the ER 4122SHQ or ER 4122SHQE cavity and the
weak pitch sample that was shipped with your spectrometer. The
test measures the EPR signal intensity (peak-to-peak height) of
the weak pitch sample at low microwave power (23 dB) and
then measures the noise level under the same conditions except
higher microwave power (0 dB) and higher receiver gain to
characterize the noise better. The formula for calculation of the
signal to noise ratio is:

, [3-1]

where AS and AN are the peak to peak height of the weak pitch
and amplitude of the noise respectively. GS and GN are the
receiver gains used in signal and noise measurements respec-
tively. We use their ratio to correct for the gain difference. PS
and PN are the powers used in two measurements and we use the
square root of the ratio of powers to correct for the power differ-
ence. The factor of 2.5 translates the peak-to-peak noise level to
a RMS (Root Mean Square) noise level. T is the time constant
(in seconds) and we use the square root of the time constant to
normalize the S/N to a one second time constant. C is the weak
pitch correction factor that is printed on the label of the weak
pitch sample. The standard instrument settings for signal and
noise measurements are listed in Table 3-1.

S
N
----

AS
AN
-------

GN
GS
-------

PN
PS
------- 2.5

T C�

-----------------���=
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Signal to Noise Ratio Test
Parameter Signal 
Measurement

Noise 
Measurement

 Modulation
Amplitude

6.0 G 6.0 G

Modulation
Frequency

100 kHz 100 kHz

Receiver Gain 60 dB 80 dB

Phase 0 0

Time Constant 1310.72 ms 1310.72 ms

Conversion Time 163.84 ms 163.84 ms

Center Field 3510 G 1500 G

X Axis Setting Field Sweep Time Scan

 Sweep Width 50 G --

Resolution
of X Axis

1024 points 1024 points

Microwave
Attenuation

23 dB 0 dB

Table 3-1 Parameters for Signal/Noise Measurements with SuperX.
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Signal to Noise Ratio Test
Preparing for the S/N Test 3.1.1
1. Install an ER 4122SHQ or ER 4122SHQE cavity.

(See Section 7.2 of the Elexsys E 500 User�s Manual:
Basic Operations for instructions.) The specification for
the signal to noise ratio is based on an ER 4122SHQ or
ER 4122SHQE cavity using the weak pitch sample. We
strongly suggest using this cavity for the standard test and
keep a record and verify the specification periodically. If
you use other types of cavities to do the signal to noise
ratio test the results and the settings will be different due
to different Q values and the microwave field distribu-
tions of the cavities.

2. Insert the weak pitch sample. Copy down the cali-
bration factor posted on the label of the weak pitch sample
before you insert it. The weak pitch sample should be
inserted in the cavity until the bottom of the label and tape
on the sample tube is flush with the collet. You also
should use the pedestal to hold the weak pitch sample rig-
idly.

3. Turn on the instrument and tune. Turn on the instru-
ment if it is not on yet. Tune the microwave bridge and the
cavity. It is best to wait several hours to let the spectrome-
ter fully warm up because the spectrometer is most sensi-
tive and stable after it has achieved thermal equilibrium.

4. Optimize the AFC. Refer to Section 7.3.2. of the Elex-
sys E 500 User�s Manual: Basic Operations for instruc-
tions or hints.

5. Check the Spectrometer Configuration. Click
Spectrometer Configuration in the Acquisition menu
and click the Signal Channel tab. Make sure you have
the correct calibration file for the cavity you are using.
High Pass Filter and AFC Trap Filter should be acti-

Yo u ne e d  to  p urg e
nitrogen gas through
the cavity to avoid pos-
sible oxygen signals
owing to the high sen-
sitivity of the cavity

The calibration factor
is found on the weak
pitch sample�s label. It
is listed as:

C = C0 x calibration 
factor

It is usually approxi-
mately equal to one and
corrects for variations
in the sample concen-
tration.
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Signal to Noise Ratio Test
vated. If you make any changes, click the Apply button
and then the Close button.(See Figure 3-1.) 

Figure 3-1 The Spectrometer Configuration dialog box.
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Signal to Noise Ratio Test
Acquire the Signal Spectrum 3.1.2
1. Create an experiment to measure the signal.

Click the New Experiment button to bring up the dialog
box. (See Figure 3-2.) Click the C.W. tab and select
Field for Abscissa 1. It is a good idea to assign the
Experiment Name as Signal. Click Create to continue. 

Figure 3-2 Creating an experiment to measure the weak pitch signal.

New Experiment
Button
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Signal to Noise Ratio Test
2. Input the sample information. Click Acquisition in
the menu bar and then Sample Info. (See Figure 3-3.)
Enter the weak pitch information. Click OK to continue.

3. Open the Acquisition Parameters dialog box.
Click the Activate button and then the Acquisition
Parameters button to bring up the dialog box. 

Figure 3-3 The sample information dialog box.
Elexsys E 500 User�s Manual: Advanced Operations 3-7



Signal to Noise Ratio Test
4. Set the Microwave Power. Click the Microwave tab
and set the Attenuation to 23 dB. We also advise you to
select the Before Each Slice Scan option in the Acq.
Fine Tuning box to ensure the acquisition is made under
proper coupling conditions. It will automatically fine tune
the coupling each time a scan starts. (See Figure 3-4.)

 

Figure 3-4 Setting the microwave attenuation.

Automatic
Fine Tuning
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Signal to Noise Ratio Test
5. Set the magnetic field. Click the Absc. 1: Field tab.
Set the Center Field to 3510 G and the Sweep Width to
50 G. Set the Number of Points to 1024. Since a very
long time constant will be used, set the field to the Left
edge to avoid overshoots or undershoots in the first few
data points when you acquire the spectrum. (See
Figure 3-5.)

Figure 3-5 Setting the magnetic field.

Set the
Field Left
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Signal to Noise Ratio Test
6. Set the Scan parameters. Click the Scan tab and
make sure that the Number Of Scans is set to one. (See
Figure 3-6.)

Figure 3-6 Setting the Scan parameters.
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Signal to Noise Ratio Test
7. Set the Signal Channel parameters. Click the Sig-
nal Channel tab to bring the folder to the front. Set the
parameters to those shown in Figure 3-7 or consult Table
3-1. If the Receiver Level meter is off center, change the
Offset to bring the needle back to the center.

Figure 3-7 Setting the Signal Channel parameters.
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Signal to Noise Ratio Test
8. Acquire a signal spectrum. Click the Run button to
acquire a spectrum. It should look similar to Figure 3-8.

9. Store the signal spectrum. Click on the Primary
Properties menu, select Store in the drop down menu to
store the spectrum in memory. Name the spectrum and
store it.

Figure 3-8 The weak pitch signal.
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Signal to Noise Ratio Test
Acquire the Noise Spectrum. 3.1.3
1. Create an experiment to measure the noise. Click

the New Experiment button to bring up the dialog box.
(See Figure 3-9.) Click the C.W. tab and select Time for
Abscissa 1. It is a good idea to assign the Experiment
Name as Noise. Click Create to continue.

2. Open the Acquisition Parameters dialog box.
Click the Activate button if it is not depressed and then
the Acquisition Parameters button to bring up the dialog
box. 

Figure 3-9 Creating a noise measurement experiment.
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Signal to Noise Ratio Test
3. Set the Microwave Power. Click the Microwave tab.
Set the Attenuation to 0 dB. We also advise you to select
the Before Each Slice Scan option in the Acq. Fine
Tuning box to ensure the acquisition is made under
proper coupling conditions. It will automatically fine tune
the coupling each time a scan starts.  (See Figure 3-10.)

Figure 3-10 Setting the microwave power for the noise measurement.

Automatic
Fine Tuning
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Signal to Noise Ratio Test
4. Set the Magnetic Field. Click the Field tab. Set the
Static Field to 1500 G. (See Figure 3-11.) Since a very
long time constant will be used, set a settling delay time
of 2-5 seconds to avoid overshoots or undershoots in the
first few data points when you acquire the spectrum.

Figure 3-11 Setting the magnetic field.

Static
Field

Settling
Delay
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Signal to Noise Ratio Test
5. Set the time sweep parameters. Click the Absc 1:
Time tab. Set the Number of Points to 1024. Set the
Sweep Time to 167.77 s. (See Figure 3-12.)

Figure 3-12 Setting parameters for the Absc.1: Time folder.

Sweep
Time

Number
of Points
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Signal to Noise Ratio Test
6. Set the Scan parameters. Click the Scan tab and
make sure that the Number Of Scans is set to one. (See
Figure 3-13.)

Figure 3-13 Setting the Scan parameters.
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Signal to Noise Ratio Test
7. Set the Signal Channel parameters. Click the Sig-
nal Channel tab to bring the folder to the front. Set the
parameters to those shown in Figure 3-14 or consult
Table 3-1. If the Receiver Level meter is off center,
change the Offset to bring the needle back to the center.

Figure 3-14 Setting the Signal Channel parameters.
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Signal to Noise Ratio Test
8. Get ready to acquire a noise spectrum. Click the
RUN button in the acquisition tool bar to acquire the
noise spectrum. Frequently the baseline will drift since
200 mW microwave power is going to heat up the cavity
and the sample. Wait a few minutes to achieve thermal
equilibrium. Check the tuning and coupling of the system.
Retune the system if necessary. You may also have a
rather large offset due to the excessive power and high
gain. Adjust the offset so that the indicator of the
Receiver Level meter is in the middle. 
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Signal to Noise Ratio Test
9. Acquire a noise spectrum. Click the RUN button in
the acquisition tool bar and acquire the noise spectrum
again. (See Figure 3-15.) If there is no baseline drift,
store the spectrum and continue to the next section. If
there is drift, wait a bit longer and run the noise trace
again.

If there is a linear drift,
you  do  no t  need  to
re-acquire the noise
spec trum. We shal l
subtract it out in the
next step

Figure 3-15 Acquiring a noise spectrum.
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Signal to Noise Ratio Test
10. Correct the linear drift of the baseline if neces-
sary. If the baseline drifts you can click the Baseline
Corr. button in the Tasks bar and then click Polynomial.
Click the 1st order button to perform a linear fit of the
baseline. (See Figure 3-16.)

Figure 3-16 A linear baseline correction of the noise spectrum.
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Signal to Noise Ratio Test
Click Subtract Line (-) to subtract the linear baseline
from the noise spectrum to compensate for linear drifts.
Click OK and store the resulting noise spectrum. (See
Figure 3-17.) Click Return on the Tasks menu.

Measuring the Signal to Noise Ratio 3.1.4
1. Display the noise spectrum in the Primary

dataset. If the noise spectrum is not in the Primary
dataset, click the Primary Dataset List and select the
noise spectrum. 

2. Display the signal spectrum in the Secondary
dataset. Click the Secondary Dataset List and select
the signal spectrum.

Figure 3-17 Storing the noise spectrum.
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Signal to Noise Ratio Test
3. Load the Signal to Noise ProDeL program. Click
the Processing > ProDeL > Load Programs. (See
Figure 3-18.)  

Figure 3-18 Loading the ProDeL program.
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Signal to Noise Ratio Test
A dialog box will appear. Select the path <your home
directory>/xeprFiles/ProDeL/sharedProDeL/Stan-
dard and then the signal2noise file. In the Add Menu
Entry selection, click the yes button. Click Load to con-
tinue. (See Figure 3-19.)

Figure 3-19 Selecting the signal to noise calculation pro-
gram.
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Signal to Noise Ratio Test
4. Run the signal2noise ProDeL program. Click Pro-
cessing in the menu bar and then ProDeL. You will find
signal2noise in the submenu of ProDeL entries. Click
signal2noise to start the program. A dialog box pops up
asking you to enter the weak pitch factor. Enter the num-
ber you copied down from the weak pitch label. Click
Apply to continue. (See Figure 3-20.)

5. Check the S/N ratio. The signal intensity, noise level,
and the signal to noise ratio will be automatically mea-
sured and calculated. The results will be displayed in a
message box. (See Figure 3-21.) 

Figure 3-20 Entering the weak pitch factor.

Figure 3-21 Displaying the signal to noise ratio.
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Signal to Noise Ratio Test
Copy down the signal to noise ratio for your records. The
signal to noise ratio should be greater than 3000 to meet
the specifications of the Bruker EPR instrument. If the
result is lower than the specification value, consult Chap-
ter 8 and 9 of the Elexsys E 500 User�s Manual: Basic
Operations. Sometimes a large cavity background signal
can significantly decrease the test result. Quite often,
waiting longer before acquiring the noise trace helps quite
a bit. If those hints do not help, contact your Bruker ser-
vice representative.

6. Save the results. Click Close to exit the signal to noise
ProDeL program. For your records, you can save these
two spectra in a designated directory on the hard disk.

7. Make a hard copy. Click on the Secondary Proper-
ties Menu and click Align with Primary... (See
Figure 3-22.)

Figure 3-22 Aligning with the primary dataset.

This specification is
only valid for an E500
spectrometer with a
SuperX br id ge  and
E R 4 1 22 S H QE  o r
ER 4122SHQ cavity.
For a normal bridge
an d  a n  E R 4 1 0 2 S T
cavity, please consult
Section 3.1.5.

Align with
Primary
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Signal to Noise Ratio Test
Select Abscissa and then click Align.

Click on the FS button for the Secondary dataset. (See
Figure 3-24.) Click the Print button to make a hard copy.

Figure 3-23 Aligning with the primary dataset.

Figure 3-24 Scaling individual spectra to make a hard copy.
Elexsys E 500 User�s Manual: Advanced Operations 3-27



Signal to Noise Ratio Test
Signal to Noise Ratio Test for an ER 4102ST Cavity 3.1.5
The parameters and the specifications for the ER 4102ST cavity
are different from those for the ER 4122SHQ cavity. The mea-
surement procedure however is identical. Perform the operations
of the previous section except with the following parameters.

The signal to noise ration should be at least 360.

Parameter Signal 
Measurement

Noise 
Measurement

 Modulation
Amplitude

6.0 G 6.0 G

Modulation
Frequency

100 kHz 100 kHz

Receiver Gain 60-70 dB 80 dB

Phase 0 0

Time Constant 1310.72 ms 1310.72 ms

Conversion Time 163.84 ms 163.84 ms

Center Field 3480 G 1500 G

X Axis Setting Field Sweep Time Scan

 Sweep Width 50 G --

Resolution
of X Axis

1024 points 1024 points

Microwave
Attenuation

12 dB 0 dB

Table 3-2 Parameters for Signal/Noise Measurements for an ER 4102ST 
cavity.
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Spectrometer Configuration 4
In order to use specific hardware and accessories such as the
cavity, frequency counter, field frequency lock, teslameter, etc.,
you need to configure your Bruker Elexsys E 500 spectrometer.
To configure the spectrometer, connect the workstation to the
spectrometer. Click Acquisition > Spectrometer Configura-
tion to open the dialog box. 

The Field Folder 4.1
This folder contains the parameters related to the magnetic field.

Figure 4-1 The Field folder.
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The Field Folder
ER032T Field Controller 4.1.1
Calibration Offset: This parameter corrects for the difference in the field value mea-

sured by the Hall probe and the actual field value that the sample
sees. Refer to Chapter 5 to learn how to calibrate the magnetic
field.

Maximum Field: This parameter is the maximum field your magnet can reach. It
depends on the size of your magnet and the magnet power sup-
ply you have. Refer to the specifications of your magnet and
power supply for the maximum field value.

Minimum Field: This parameter is the minimum magnetic field your magnet can
reach. If you do not have the zero crossing option for your mag-
net power supply, the minimum magnetic field is 50 gauss. If
you have the zero crossing option you can set this parameter to 0
gauss.

FF-Lock 4.1.2
Refer to Section 12.4 for more detailed instructions regarding
setting up the optional E 033M FF-Lock accessory.

Type: If you purchased the optional FF-lock from Bruker, you need to
select ER033M in the drop-down list. If you do not have an
FF-lock, select None and go to the next section.

IEEE 488 Address: The acquisition server communicates with the FF-lock through
the IEEE bus. The default address for the FF-lock is 3. Make
sure to set the IEEE address on the FF-lock unit to 3 as well.

Calibration Offset: Since the FF-lock probe is mounted on the side of the magnet
polepiece the field it detects is different from the magnetic field
your sample experiences. 
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The Field Folder
Teslameter (Gaussmeter) 4.1.3
Refer to Section 12.5 for more detailed instructions regarding
setting up the optional E 035M teslameter accessory.

Type: If you purchased an optional teslameter from Bruker, select
ER035M. Otherwise select None and go to the next section.

Modulation: The teslameter probe can operate with two modulation polari-
ties. Select Positive here. If the magnet is wired incorrectly or
the probe is flipped, you may need to select Negative.

IEEE 488 Address: The acquisition server communicates with the teslameter
through the IEEE bus. The default address for the FF-lock is 7.
Make sure to set the IEEE address on the FF-lock unit to 7 as
well.

Calibration Offset: The field measured by the teslameter depends on where you
place the teslameter probe. It does not necessarily reflect the
actual field value that your sample experiences. You can cali-
brate the field offset by inserting an optional intra-cavity probe
in the cavity (if so equipped) or using a standard sample (See
Section 12.5.5.). Enter your calibration result here.
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The Field Folder
Rapid Scan 4.1.4
Refer to Section 6.4 for more detailed instructions regarding
setting up rapid scan experiments.

RSC Coil: When performing rapid scan experiments, you need to select one
set of rapid scan coils. If you use the scan coils mounted on the
magnet, select 200 G. If you use the scan coils assembled in the
cavity, select 50 G. 

RSC Calibration
50 G:

The sweep width of the rapid scan coils needs to be calibrated.
Enter the calibration factor for the 50 G rapid scan coils here.
Refer to Section 6.4 to learn how to calibrate the sweep width of
the rapid scan coils.

RSC Calibration
200 G:

Enter the calibration factor of the 200 G rapid scan coils here.
Refer to Section 6.4 to learn how to calibrate the sweep width of
the rapid scan coils.
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The Misc. Folder
The Misc. Folder 4.2
The Misc. (miscellaneous) folder of the Spectrometer Config-
uration dialog box contains configuration parameters for a vari-
ety of hardware components and accessories.

Microwave Band 4.2.1
Microwave Band: Depending on the microwave bridge you are using you can

select from L-, S-. X-, K-, Q- or W-band.

Autotune
Attenuation:

This value sets the microwave power for the autotuning process.
For a standard cavity, set it to 25 dB. For a resonator with a very
high Q value you can set it to 30 dB or higher. Setting the Atten-
uation too low or too high may cause the autotuning process to
fail.

Figure 4-2 The Microwave Band section of the Misc. folder.
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The Misc. Folder
Microwave Frequency Counter 4.2.2
See Section 12.1 for details on setting up frequency counters.

Type: If you do not have a frequency counter, select MBC. The MBC
(Microwave Bridge Controller) board provides an approximate
(three digits) microwave frequency. You can use an accurate fre-
quency counter to calibrate the microwave frequency and enter
the calibration result into the MBC Calibration Offset. If you
need a more accurate microwave frequency reading, use either
the Bruker frequency counter or another frequency counter pro-
vided by other vendors. For the Bruker frequency counter, select
Bruker in the drop-down list. For other frequency counters you
can select one that Xepr supports. 

IEEE 488 Address: If you are using the frequency counters from vendors other than
Bruker, you need to set the IEEE 488 address to 8. For the
Bruker and MBC options, you do not need to set the IEEE
address.

MBC Calibration
Offset:

This offset is for MBC board calibration only. Use a frequency
counter to calibrate the difference between the frequency
counter and the MBC board and enter the result here. See
Section 12.1.1 for instructions on how to measure the offset.
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The Misc. Folder
Figure 4-3 The Microwave Frequency Counter section of the Misc. folder.
Elexsys E 500 User�s Manual: Advanced Operations 4-7



The Misc. Folder
Temperature Controller 4.2.3
Refer to Section 12.2 and Section 12.3 for more details on set-
ting up and using temperature controllers.

Type: The Bruker Elexsys spectrometer supports two types of tempera-
ture controllers. ER 4111VT, ER 4121VT, and ER 4131VT
variable temperature systems use liquid nitrogen whereas the
ITC 5 system uses liquid helium. Select the temperature control-
ler you wish to use. Refer to Section 12.2 for further details.

IEEE 488 Address: The acquisition server communicates with the ITC5 temperature
controller through the IEEE bus. The default address for the
ITC5 is 24. Make sure to set the IEEE address on the ITC5 tem-
perature controller to 24 as well. The other controllers do not use
the IEEE bus and the value does not affect their operation.

Calibration Offset: Because the sample and thermocouple are not in the same posi-
tion, the temperature measured by the thermocouple may differ
from the actual sample temperature. You can use a temperature

Figure 4-4 The Temperature Controller section of the Misc. folder.
4-8



The Misc. Folder
sensor to calibrate the actual sample temperature and enter the
difference here. Refer to Section 12.2 Section 12.3 for details.

Heater Sensor: For the ITC temperature controller, there are several sensor
inputs that can be used to control the heater. Refer to the temper-
ature controller�s manual to find out which sensor to use and
select the correct sensor. The value does not affect the operation
of the other temperature controllers.

Transient Recorder 4.2.4

Type: Xepr supports several models of optional transient recorders. If
you are using a transient recorder that is listed in the drop-down
list, select it.

IEEE 488 Address: The acquisition server communicates with the transient recorder
through the IEEE bus. The default address is 9. Make sure to set
the IEEE address on the transient recorder to 9 as well.

Figure 4-5 The Transient Recorder section of the Misc. folder.
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The Signal Channel Folder
The Signal Channel Folder 4.3
Refer to Chapter 2 for details regarding signal channel calibra-
tion.

Figure 4-6 The Standard Calibration Data section of the Signal Channel
folder. 
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Other Folders
Calibration Options 4.3.1
Resonator The ER 4105DR resonator has two sets of modulation coils.

Selecting 1  or 2  displays the calibration values for the
Resonator1 or 2 channel of the modulation amplifier module.

Standard Calibration Data 4.3.2
Calibration Data

Set:
Every resonator needs signal channel calibration data for repro-
ducible and quantitative results. The calibration data is stored in
a file on the disk. Select the correct file for the resonator you are
using. Each file contains information such as the modulation
amplitude and phase calibration as well as modulation amplitude
limits and tuning capacitor values.

RF Calibration Data. 4.3.3
This subfolder contains signal channel calibration data for the
RF used in ENDOR experiments. Refer to the ENDOR docu-
mentation for further details.

Other Folders 4.4
There are other folders in the Spectrometer Configuration dia-
log box. They are for ENDOR, FT-EPR, and W-Band. Refer to
their respective user�s manuals for further information.
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Field Offset & g-Factor 5
Because the sample and Hall probe are not physically in the
same location in the magnet, the Hall probe measures a magnetic
field different from that experienced by the sample. This field
difference is often called the field offset. Carefully measuring
the magnetic field offset is critical for precisely measuring g-val-
ues and other EPR parameters. There are several methods to cal-
ibrate the magnetic field. The most direct way of calibrating the
magnetic field is to measure the magnetic field at the sample
using a teslameter (or gaussmeter) with an intra-cavity probe
which you can place in the sample position and then compare
that value with the field value that the Hall probe detects. Alter-
natively, if you do not have a teslameter available you can use a
frequency counter and a sample with known g-value. This
method is described in this chapter. You can also use this method
to measure the g-value of your sample.

Field Calibration Standards 5.1
A standard sample with an accurately measured g-value, which
is used to mark the field value, is called a field calibration stan-
dard. It is also called a g-marker. The criteria for selecting such a
standard sample are:

1. The g-factor has been accurately measured.

2. The EPR signal is isotropic and symmetric with good
reproducibility.

3. The EPR signal has a relatively narrow line width. The
narrower the line width, the more accurately the magnetic
field or g-value can be determined.

4. The EPR signal is strong enough to avoid noise induced
errors.
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Measuring the Field Offset
5. The sample is relatively stable.

Examples of such standard samples are potassium peroxylamine
disulfonate (K2(SO3)NO (known as Fremy�s salt or PADS) in a
10% Na2CO3 degassed aqueous solution and a dilute perylene
solution in degassed concentrated H2SO4. In this chapter we use
perylene radical cation as the standard sample. The g-factor has
been reported to be 2.002569 ± 0.000006. (B. G. Segal, M.
Kaplan, and G. K. Fraenkel, J. Chem. Phys., 43, 4191 (1965);
R. D. Allendoerfer, J. Chem. Phys., 55, 3615 (1971))

Measuring the Field Offset 5.2

Calibrating the Field Offset 5.2.1
1. Insert the sample and tune the system. 
2. Set the Field Offset to zero. Click Acquisition >

Spectrometer Configuration > Field and enter 0 in the
Field Offset box. Click Apply and Close.

3. Create a field sweep experiment.
4. Set appropriate parameters for your sample.

Figure 5-1 shows a parameter set that works well for a
perylene sample. The microwave power is set at 0.05 mW
for the perylene sample to avoid line broadening due to
microwave saturation. The number of data points is set at
4096.
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Measuring the Field Offset
5. Acquire a spectrum. Run the experiment

6. Center the EPR signal. Select a center field that cen-
ters the EPR signal in the sweep or use the sweep tool. 

7. Adjust the sweep width. The following rule of thumb
usually works well:

[5-1]

30 gauss works well for the perylene sample.

Figure 5-1 Appropriate parameters for a perylene sample.

sweep width
# of points

------------------------------ 10 peak-peak linewidth��
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Measuring the Field Offset
8. Measure the magnetic field for the center line.
Zoom in on the center EPR line and move the cursor to
the zero cross over point of the center EPR line. Read the
field value, B0, from the Viewport Selection bar.

9. Determine the field value for the known g factor.
Move the cursor until the g-factor reading from the View-
port Selection bar matches the known sample g-factor.
Read the magnetic field value, B0�, of that point.

Figure 5-2 Zooming in to measure the center EPR line field value.

Move the
Cursor

Read the
Field Value
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Measuring the Field Offset
10. Calculate the Field Offset. The value equals:

Field Offset =�B0 - B0� [5-2]

11. Set the Field Offset value. Click Acquisition > Spec-
trometer Configuration > Field. Enter the value calcu-
lated above in the Calibration Offset box. Click Apply
and then Close.

Figure 5-3 Determining the magnetic field value for the known g-value.

Move the
Cursor to
Match the
g-value

Read the
Field Value
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Measuring the Field Offset
Figure 5-4 Entering the Calibration Offset value.

Enter the
Field Offset
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Measuring the Field Offset
12. Re-acquire the spectrum to check the field off-
set. Zoom in on the center line and read the g-factor at
the zero cross over point. If it matches the given g-factor,
the Field Offset has been calibrated successfully. If it
does not match the given g-factor, repeat Step 8. through
Step 11. Add the result to the Field Offset in the Spec-
trometer Configuration dialog box. Click Apply and
Close. You may need to repeat this procedure several
times to get the Field Offset correct.

Figure 5-5 Verifying the field offset calibration.

Check the

Field Value
g-value &
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Measuring the Field Offset
Tips for Measuring the Field Offset 5.2.2
� Thermal equilibrium. The Hall voltage used for field reg-

ulation has a temperature coefficient. This effect is compen-
sated by use of a thermostat to control the Hall probe
temperature. Very good performance is achieved after about
one hour after turning the spectrometer on. Optimal stability
is attained after 72 hours. Wait until the spectrometer is
warmed up

� Magnet hysteresis. Magnet hysteresis affects the accu-
racy of the field values. You may need to saturate the mag-
nets by setting the magnetic field to ~ 12,000 gauss for about
one minute before you start measurements. Saturating the
magnet first will reduce the hysteresis.

� Select the proper number of data points. You may
need to select 4096 data points to read the field value pre-
cisely. Depending on the sweep width and the line width,
more data points usually give you more accuracy. When you
are close to the correct field you may need to use narrower
sweep width. If the signal is strong you may acquire the sec-
ond harmonic spectrum to precisely locate the field of the
center EPR line.

� Scan slowly. If you sweep the field too fast the magnet may
not be able to follow. Set the sweep time long enough to
avoid any distortion.

� Avoid saturating the sample. Too much microwave
power not only saturates the sample and causes distortion and
broadening of the EPR signal, but also may heat up the sam-
ple. The g-value of the sample may be temperature depen-
dent, resulting in an inaccurate calibration. Frequently the
EPR absorption signal becomes more dispersive under power
saturation, which makes determination of the zero cross over
point more difficult and less accurate.

Saturating the magnet
only applies to 8� or
larger magnet with a
7 kW or greater power
supply.  For p recise
measurements of g-val-
ues and calibration of
the field offset, an 8� or
larger magnet and cor-
responding power sup-
ply is recommended.
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g-Value Measurements
� Do not over-modulate the signal. Over-modulation
causes signal distortion which can also affect the accuracy of
the field offset measurement.

� How often do I need to calibrate the field offset? It
depends on how precisely you need to know the actual field
values. You may need to calibrate the field offset every time
you change the cavity or move the bridge if you need to mea-
sure your g-values more precisely than 4 figures after the
decimal point.

g-Value Measurements 5.3
To precisely determine the g-factor you need to know two val-
ues: the magnetic field and the microwave frequency. Then you
can calculate the g-value based on the formula:

 , [5-3]

where h is Planck�s constant, �� is the Bohr magneton, � is the
microwave frequency in GHz and B0 is the magnetic field in
gauss. Alternatively:

 . [5-4]

The precision of the g-factor measurement depends on how pre-
cisely you can determine the microwave frequency and the mag-
netic field. If you are using a microwave frequency counter, the
magnetic field uncertainty determines the precision.

Precise g-value measurement requires some care. The tips listed
in Section 5.2.2 also hold true for g-value measurements. Con-

g h�
�BB0
-------------=

g 714.4775 �

B0
------�=

A m icr o wa ve  f r e -
q ue n c y  co u n t e r  i s
essential to measure the
g-value to a precision
any greater than two
digits after the decimal
point.
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g-Value Measurements
tributions to field measurement uncertainties are not necessarily
due to instrumental factors. Such factors as line shape, line
width, solvent effects, isotropic or anisotropic interactions, sen-
sitivity to concentration, etc. must be considered.

If you are using the Hall field controller for field measurement,
you can measure g-values to 100 ppm if you have carefully
determined the field offset, followed the hints (as described in
the previous section), and you have a sufficiently narrow EPR
line (< 0.1 G). For more precise g-value determinations, you
must use a teslameter. If you have followed the advice of the
previous section, have carefully calibrated the teslameter offset,
and have a sufficiently narrower line (<0.1 G) you can measure
g-values sometimes down to 100 ppb precision. Consult
Section 12.5 for details on teslameter operation.

Xepr can automatically provide the g-factor based on the fre-
quency and field value it has measured. You only need to place
the mouse pointer to where you want to know the g-factor and
the g-value will be displayed in the selection bar of the viewport.
(See Figure 5-2.) Xepr even has a function that can convert the
field domain to the g-domain (Processing > Transformation >
g-factor). 

These methods, can also be used to interpret hyperfine coupling
constants and zero field splittings.
5-10



The Fast Digitizer & Rapid Scans 6
Many physical and chemical processes occur on time-scales too
short for the magnet and the digitizer in the signal channel to fol-
low them. In order to expand the capabilities of the spectrometer
to shorter time-scales, the spectrometer is equipped with a fast
digitizer and a set of rapid scan coils.

Rapid Time Scan Experiments 6.1
This section describes the use of the fast digitizer for acquiring
fast time scans at a constant magnetic field value.

The Fast Digitizer 6.1.1
The ADF board is a fast, two channel digitizer board capable of
digitizing at a 2 MHz rate. The first channel (Channel A) is
reserved for digitizing EPR signals. The second channel may be
used to digitize other signals, such as the output of a photomulti-
plier tube. The fast digitizer can capture data more quickly than
the integrating ADC (Analog to Digital Converter) of the signal
channel. It has a fixed 12 bit resolution and therefore yields bet-
ter y-resolution than the signal channel digitizer when the con-
version time is less than 2.56 ms. 

The digitizer acquires data at a fixed 2 Msamples/s rate. In order
to change the sweep time for an experiment, the number of data
accumulations for a specific field or time value is increased or
decreased. The fast digitizer contains an on-board accumulator
which accumulates several data values (y-value) at each time or
field step (x-value). The number of accumulations is set by the
software to make maximum use of the selected sweep time.
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Rapid Time Scan Experiments
Performing a Rapid Time Scan Experiment 6.1.2
Before you start, you should have already turned the spectrome-
ter on, inserted your sample, and tuned the spectrometer. Consult
the Elexsys E 500 User�s Manual: Basic Operations for further
details regarding ordinary time scan experiments because both
types of experiments share many common operations and
parameters.

1. Create a time scan experiment using the fast dig-
itizer. Click New Experiment and select the CW sub-
folder. In the Abscissa 1 drop-down list, select Time.
Select Fast digitizer in the Ordinate drop-down list.
Click Create to close the dialog box. (See Figure 6-1.)

Figure 6-1 Creating a time scan experiment.
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Rapid Time Scan Experiments
2. Click the Acquisition Parameters button to open
the Acquisition Parameters dialog box.

3. Set common EPR parameters. Set the microwave
power, modulation amplitude, and receiver gain to appro-
priate values.

4. Set the Static Field. Set the Static Field in the Field
folder so that it coincides with the top of your EPR signal.

Figure 6-2 The Fast Digitizer subfolder.
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Rapid Time Scan Experiments
5. Set Auto Offset to Off in the Scan folder. In a time
scan experiment, you are usually interested in the initial
and final intensities and this information is lost if Auto
Offset is set to On.

6. Set the Sweep Time. Change either the Sweep Time
or Accumulations per Point in the Fast Digitizer folder.
When you change one parameter, the other automatically
updates to the proper value.

7. Set an appropriate time constant. Because this class
of experiments is measuring rapidly changing signals, you
must insure your time constant is low enough that it does
not distort the acquired signal. A good rule of thumb if
you have a strong signal is:

Time Constant = Number of Accumulations * 500 ns / 4. [6-1]

If your signal is weak, you may need to compromise and
increase the time constant.

8. Run the experiment. Click the Run button to acquire
the time scan.
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Rapid Time Scan Experiments
Fast Digitizer Parameters 6.1.3
Refer to Figure 6-2 to identify the various Fast Digitizer
parameters.

Sweep Time As was mentioned previously, a number of parameters deter-
mine the Sweep Time. In Internal Sweep mode:

Sweep Time = Accumulations per Point [6-2]
* Number of points * 500 ns.

The maximum Sweep Time is 134 seconds (with the default
options) corresponding to 65535 maximum Accumulations per
Point.

Accumulations
per Point

This parameter determines the time resolution and consequently
the Sweep Time in Internal Sweep mode.

Time Resolution = Accumulations per Point * 500 ns. [6-3]

The minimum Accumulations per Point is 1 and the maximum
value is 65535.

Trigger Mode There are four different Trigger Modes. Internal Sweep is the
default mode in which the internal clock triggers the beginning
of the sweep. Equation [6-2] relates the Accumulations per
Point and Sweep Time. In this mode, if one parameter is
changed, the other is automatically updated to fulfill Equation
[6-2]. 
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Rapid Time Scan Experiments
The second mode is Internal Point mode in which each point is
triggered by the internal clock. In this mode, the Accumula-
tions per Point becomes more independent than in the first
mode. The Sweep Time is specified (< 134 seconds) and the
Accumulations per Point can be set to values:

1��� Accumulations per Point��� [6-4]
Sweep Time / Number of Points * 500 ns.

There are two analogous modes, External Sweep and External
Point in which the experiments are synchronized to an external
trigger as opposed to the internal clock. The external signal is
applied to the cable labeled Ext. Trigger that is connected to the
AUX connector of the ADF board. (See Section 14.2.3.)

Trigger Slope If you have selected one of the external trigger modes, you can
select whether the Falling or Rising edge of the external trigger
pulse triggers the acquisition.

Input Mode There are two Fast Digitizer input channels. Channel A is
reserved for EPR signals, but channel B is available for other
signals such as the output of a photomultiplier tube, etc. You
have the option of choosing to record channel A, B, or both
A & B simultaneously in this drop-down list.
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The Rapid Field Scan Experiment
The Rapid Field Scan Experiment 6.2
To sweep the magnetic field rapidly we need to employ a special
device called the Rapid Scan Controller (RSC). It has a pro-
grammable ramp generator which is used to set the shape of the
field sweep. It generates very fast field sweep cycles to match
the speed of the ADF board. The center field of the rapid field
scans is centered about the static field supplied by the main mag-
net.

The field sweep cycle is applied to the rapid scan coils. The
cycle consists of three distinct regimes. (See Figure 6-3.) The
acquis i t ion  occurs  dur ing the  Ramp-up  per iod.  The
Ramp-down and Delay times are necessary to return to the ini-
tial magnetic field value. 

Since the inductance of the rapid scan coils is much lower than
that of the electromagnet, the field can be swept much faster.
There are two rapid scan coils. The internal rapid scan coils are
built in some of the Bruker cavities. The external rapid scan
coils are mounted on the magnet pole caps. The maximum rapid
scan sweep widths are 50 G for internal rapid scan coils and 200
G for external rapid scan coils respectively. You can select the
rapid scan coils and adjust the calibration factors of the sweep
width in the configuration menu.

Figure 6-3 The rapid field sweep cycle.
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The Rapid Field Scan Experiment
Configuring the Rapid Scan Experiment 6.2.1
The ADF board should be already connected when the spec-
trometer is delivered. You may need to connect the rapid scan
coil and configure the Xepr program.

1. Connect the Rapid Scan Coils. As mentioned before,
there are two rapid scan coils; the 200 G rapid scan coils
that are mounted to the pole caps of the magnet and the 50
G rapid scan coils that are built in some Bruker cavities
such as the standard cavity ER 4102ST. Connect the
orange cable from the Modulation Amplifier RS 200 G
connector in the console to the connector of the 200 G
rapid scan coils on the magnet. Connect the yellow cable
from the Modulation Amplifier RS 50 G connector to
the left connector (labeled R.S.) of the Bruker cavity. 

2. Configure the spectrometer. Turn on the spectrome-
ter and connect the workstation to the spectrometer. Select
Acquisition > Spectrometer Configurations. Clicking
the Field tab, you can find the Rapid Scan section. In
this section, select 50 G or 200 G as the rapid scan coils
(RSC) depending upon which rapid scan coil you want to
use. Click Apply. Underneath, there are calibration factors
of the rapid scan width for 50 G and 200 G coils respec-
tively. We will discuss this calibration in Section 6.4.

Not all Bruker cavities
are equipped with 50 G
rapid scan coils. If the
cavity you are using
does not have an R.S.
connector,  you can
only use 200 G rapid
scan coils.
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The Rapid Field Scan Experiment
Defining a Rapid Scan Experiment 6.2.2
After you have configured the rapid scan hardware, you need to
define a rapid scan experiments. It is a little different from the
regular experiments with the signal channel.

1. Create a New Experiment. Click the New Experi-
ment button. Click the CW tab in the dialog box if it is
not in front.

2. Select Field (Rapid Scan). In the Abscissa 1
drop-down list,  select Field (Rapid Scan) .  (See
Figure 6-4.)

Figure 6-4 Selecting Field (Rapid scan) for
Abscissa 1.
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The Rapid Field Scan Experiment
3. Select Fast Digitizer. In the drop-down list of the Ordi-
nate select Fast digitizer instead of Signal channel.
Click Create to close the dialog box. (See Figure 6-5.)

4. Set common EPR parameters. Click the Acquisition
Parameters button to open the dialog box. Set the micro-
wave power, modulation amplitude, and receiver gain to
appropriate values. The Time Constant in the Signal
Channel subfolder should be set very short, otherwise
distortion may occur.

Figure 6-5 Selecting Fast digitizer as Ordinate.
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The Rapid Field Scan Experiment
5. Set Sweep Quantity: Field parameters. In the
Abscissa 1 Sweep Quantity: Field section enter the
Center Field value for your experiment. Enter the desired
Sweep width. The maximum sweep width depends on
the rapid scan coils you are using and selected in the Sys-
tem Configuration folder. By default the Number of
Points is set at 4096 which gives you a reasonable resolu-
tion in most cases. We shall keep the Center Field Offset
value at zero for now. (See Section 6.4 for details on the
Center Field Offset parameter.)

Figure 6-6 Parameters for rapid field scans.
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The Rapid Field Scan Experiment
6. Set the RSC Trigger and Input Mode parameters.
Select Internal as the RSC Trigger Mode. Select A as
Input Mode. Channel A is reserved for EPR signals.

7. Select an appropriate Sweep Ramp-up Time.
Since the minimum signal channel time constant is 0.01
ms, you need to set the Sweep Ramp-up Time long
enough so that the time sweeping through the upper peak
and the lower peak of an EPR line is at least 0.1 ms (or 10
times the Time Constant) to avoid distortion. 

8. Set the Sweep Ramp-down Time. The Sweep
Ramp-down Time is the time for the field to fly back.
The optimal Sweep Ramp-down time depends on your
experiment and other settings. The best way to set an opti-
mal Sweep Ramp-down Time is lengthen it until there
are no flyback glitches appearing in your spectrum. 

9. Set the Sweep Delay Time. If you set the scan number
to more than 1 in the Scan subfolder you need to set a
proper Sweep Delay Time so that the field can settle
after fly-back. The optimal Sweep Delay Time depends
on your experiment and other settings. The best way to set
an optimal Sweep Delay Time is lengthen it until there
are no flyback glitches appearing in your spectrum.

10. Run the experiment. Click the Run button to acquire
the time scan.

The Sweep Ramp-up
Time ,  Number  o f
Points, and the Accu-
mulations per Point
are related. More data
points usually provide
better resolution but
longer sweep time or
less Accumulations
per Point. You need to
ba l ance  t hese  t h ree
parameters to achieve
the acceptable distor-
tion,  resolution, and
acquisition time.
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The Rapid Field Scan Experiment
Rapid Scan Parameters 6.2.3
Refer to Figure 6-6 to identify the various Fast Digitizer
parameters.

Center Field The static field about which the magnetic field is rapidly swept.

Sweep Width The width of the rapid scan magnetic field sweep. It has a maxi-
mum value of 50 G for the 50 G rapid scan coils and 200 G for
the 200 G rapid scan coils.

Center Field Offset There is a Center Field Offset in order to compensate for the
field hysteresis caused by the rapid scan. (See Section 6.4.)

Number of Points The number of points acquired during the rapid scan experiment.

Input Mode There are two Fast Digitizer input channels. Channel A is
reserved for EPR signals, but channel B is available for other
signals such as the output of a photomultiplier tube, etc. You
have the option of choosing to record channel A, B, or both
A & B simultaneously in this drop-down list.

RSC Trigger Mode The acquisition can be triggered in Internal mode in which
pressing the Run button initiates the acquisition. You may also
select to trigger the acquisition in External mode with an exter-
nal trigger. (See Section 14.2.4.)
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The Rapid Field Scan Experiment
A sweep cycle consists of three sections, the Sweep Ramp-up,
Sweep Ramp-down, and  Sweep Delay Times .  (See
Figure 6-7.)

Sweep Rampr-up
Time

This is the field sweep during which the actual acquisition takes
place. It equals

Sweep Ramp-up Time = Accumulations per Point [6-5]
* Number of points * 500 ns.

(Refer to Section 6.1.3.) When you set the Sweep Ramp-up
Time and the Number of Points, Xepr will automatically set
the Accumulations per Point.

Figure 6-7 The rapid field sweep cycle.
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The Rapid Field Scan Experiment
Sweep
Ramp-down

Time

This is the �fly-back� time during which the field returns to its
starting position. No acquisition is done. It is part of the dead
time. If this parameter is set too low, the field is not yet fully
back to its starting value when the next acquisition begins and
generates glitches caused by the fly-back trace in the next spec-
trum. The minimum Ramp-down time is 0.1 ms.

Delay
Time

After the ramp down time, there is a delay time during which the
system can recover from overshoots after the fly-back. This is
also part of the dead-time. This is the time delay between suc-
cessive sweeps when using multiple sweeps. Depending on the
sweep width, a sufficiently long delay time is needed to avoid
glitches and distortion. The minimum Delay time is 0.1 ms. If
the Overload LED on the Field Controller turns red it is an
indication that the Sweep Delay Time is too short.

Repetition
Frequency

The sweep Repetition Frequency is the reciprocal of the sum
of Ramp-up, Ramp-down, and Delay times. It indicates the
rate of successive sweeps when multiple scans are acquired.

Accumulations per
Point

The value of the Accumulations per Point will be set automat-
ically in accordance with Equation [6-5] when you set the
Sweep Ramp-up Time. However, you can also set the Accu-
mulations per Point. If you do so the Sweep Ramp-up Time
will be adjusted automatically by the software. It is analogous to
Accumulations per Point described in Section 6.1.3.
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2D Experiment with Rapid Scan
2D Experiment with Rapid Scan 6.3
You can combine rapid field scans with a time scan into a 2D
experiment using the fast digitizer. 

1. Create a 2D experiment. Click the New Experiment
button. Select Field (Rapid scan) as Abscissa 1 and
Time as Abscissa 2. Select Fast digitizer as Ordinate.
Click the Create button to close the dialog box. (See
Figure 6-8.)

Figure 6-8 Defining a 2D rapid scan experiment.
6-16



2D Experiment with Rapid Scan
2. Select parameters for rapid field scan. Click the
Acquisition Parameters button to open the dialog box.
Set the parameters in the Absc.1 Field the same way as
for the Rapid Field Scan experiment described in
Section 6.2.2.

3. Set parameters for Absc. 2: Delay. Click the
Absc. 2: Delay tab. Set the Delay time in ms between
rapid field scans. Although you can set the Delay time to
0, the minimum delay time is the minimum time neces-
sary for communication and data transfer. The Delay
Since Acq. Starts displays the overall time since the
acquisition starts. Each slice will be labeled by the time
when the acquisition of this slice starts. You need to
choose the number of data points or slices on the Y-axis
and enter this value into the Number of Points. (See
Figure 6-9.)

4. Run the experiment. Click the Run button to acquire
the 2D experiment.

Figure 6-9 Parameters for Absc. 2 Delay.
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Field Sweep Calibration
Field Sweep Calibration 6.4
You need to calibrate the field sweep width for rapid scan. The
standard sample for calibration depends on which RSC coil you
use. For the 200 G RSC coil you can use a commercially avail-
able CaO sample. The Mn+2 impurity in CaO is a good standard
for the calibration of the 200 G RSC coils. A 1 mM TEMPOL
solution can be used for 50 G RSC coil calibration. 

1. Prepare for the calibration. Insert the appropriate
sample in the cavity and tune the system.

2. Acquire a regular field sweep EPR spectrum. Cre-
ate a regular field experiment using the signal channel.
Acquire an EPR field sweep spectrum with either 200 G
or 50 G sweep width. Center the EPR signal. Measure the
field difference between two characteristic EPR lines.

3. Create a Rapid Scan experiment. Click New Exper-
iment. Select Field (Rapid scan) in Absc. 1. Select Fast
Digitizer in the Ordinate drop-down list. Click OK.

4. Select parameters. Click the Activate button and open
the parameters dialog box. Select appropriate parameters
for the experiment.

5. Acquire a Rapid Scan spectrum. Click the Run but-
ton.

6. Adjust the RSC Calibration factor. Acquire the rapid
scan spectrum. Carefully adjust the corresponding RSC
Calibration factor in the System Configuration dialog
box until the distance between the EPR lines matches the
distance you measured in the regular field sweep spec-
trum using the signal channel. Click Apply each time you
change the calibration factor. After you are satisfied with
the results, click Save to store the calibration factor.
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Field Sweep Calibration
7. Set the Center Field Offset. The center field in a rapid
field scan experiment may differ from that in the regular
field sweep experiment. Measure the line positions of the
EPR signals in the rapid scan and conventional EPR
experiments. The offset is equal to:

Center Field Offset = Brapid scan - Bconventional. [6-6]

Enter the difference in the Center Field Offset in the
Absc. 1 Field folder of the Acquisition Parameters dia-
log box. The Center Field Offset may be different when
you change the field sweep width of the rapid field sweep.
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Nonlinear Sweeps 7
So far, all the experiments we have discussed are linear acquisi-
tions, i.e. the data points are evenly distributed with a constant
step-size between the individual datapoints of the dataset. How-
ever, a nonlinear acquisition is more convenient in certain occa-
sions. For example, if we need to scan through base line in larger
steps and scan through the signal area in smaller steps to achieve
better resolution or we need a coarse scan over a temperature
range beyond the phase transition but need a very small incre-
ment around the phase transition temperature. Other examples
are non-equal increments of sample concentrations, microwave
power, sample angles, time intervals, etc. The Bruker Elexsys
spectrometer provides not only nonlinear field sweeps but also
nonlinear scans for a variety of other variables in 2D experi-
ments. In this chapter we introduce the nonlinear scan feature of
the Bruker Elexsys spectrometer.
Elexsys E 500 User�s Manual: Advanced Operations



Nonlinear Field Sweeps
Nonlinear Field Sweeps 7.1
This is an example of a nonlinear field sweep experiment. The
sample used in this experiment is a ruby crystal. The EPR spec-
trum of the ruby crystal at certain orientation spans up to 5000
gauss with relatively narrow linewidths. With a linear field
sweep we need to increase the number of data points signifi-
cantly to achieve reasonable resolution and spend most of the
acquisition time measuring the baseline where there is no EPR
signal. With the nonlinear acquisition capability of the Elexsys
we can sweep the magnetic field near the EPR signal with small
field increments and with large steps where there is no signal.
Figure 7-1 shows the spectrum of a ruby crystal with a linear
field sweep. 

Figure 7-1 A linear field sweep of the ruby crystal.
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Nonlinear Field Sweeps
Performing Nonlinear Field Sweeps 7.1.1
1. Create a nonlinear field sweep experiment. Click

the New Experiment button. In the CW folder, select
Field (single point) as Abscissa 1. Click Create to
close the dialog box. (See Figure 7-2.)

2. Open the Parameter dialog box. Click the Parame-
ter button. Click the Activate button.

3. Select a user defined sweep. Click the tab of the
Field folder. Select an appropriate Center Field for your
sample. Click the arrow button of Sweep Direction in
the Field Sweep Options section. In the drop-down list
select User Sweep Up. (See Figure 7-3.)

Figure 7-2 Creating a nonlinear field sweep experiment.
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Figure 7-3 Selecting a user defined field sweep.
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4. Set up the field. Edit the field values you would like to
use in the User Sweep Data box. (See Figure 7-4.)) 

Figure 7-4 Entering the field values for a nonlinear field sweep.
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In this example, we use increments as large as 100 G
while sweeping through the sections with no EPR signal
and 2 G increments while sweeping through the EPR sig-
nal area. 

5. Adjust the other parameters. Select appropriate
parameters such as receiver gain, etc., for your sample in
the other folders of the Parameter window. Click Close
to exit the Parameter dialog box.

6. Acquire the spectrum. Click the Run button to start
the acquisition. The nonlinear field sweep of the ruby
crystal is shown in Figure 7-5. 

The total number of the
field values is 413. The
f i e l d  v a l ue s  y o u
entered are stored in a
buffe r  with l imited
size. (See the discus-
s i on  a t  t h e  e nd  o f
Section 7.1.2.)

Figure 7-5 A nonlinear field sweep of the ruby crystal.
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Comparison of the Results 7.1.2
Figure 7-6 shows the difference between the linear field sweep
and the nonlinear field sweep spectra. Curve A is the linear field
sweep in which the total number of the data points is 512.
Curve B is the nonlinear field sweep in which the total number
of data points is 413. Although the overall data points in the non-
linear sweep is less than that in the linear sweep, they are con-
centrated in the EPR signal areas. 

Figure 7-6 A comparison of the linear field sweep (A: 512 points) and the nonlin-
ear field sweep (B: 413 points).
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Nonlinear Field Sweeps
Therefore, the resolution in the signal area is much better in the
nonlinear field sweep than that in the regular linear field sweep.
(See Figure 7-7.) 

The field values you entered are sent to a buffer. The size of the
buffer is limited. The maximum number is approximately 512.
The maximum number of data points may vary depending on
how many digits each field value has. After clicking the Acti-
vate button the actual number of the data points is displayed in
the Number of Points box. If the number you entered exceeds
the size of the buffer it will be automatically truncated to fit the
buffer.

Figure 7-7 An expanded display of the signal region. A: is from the linear field
sweep. B: is from the nonlinear sweep.
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Nonlinear Scans in a 2D Experiment
Nonlinear Scans in a 2D Experiment 7.2
In a 2D experiment we scan two independent variables. For
example we can select the magnetic field as Abscissa 1 and
select the time, temperature, sample concentration, or the micro-
wave power as Abscissa 2. We do not have to increment the
second variable with a constant step-size. Instead, we can use a
nonlinear acquisition to distribute the data points according to
our needs. In this example we are going to measure the power
saturation behavior of a DDPH sample by creating a 2D field vs.
microwave power experiment with a nonlinear increment in the
microwave attenuation. 

1. Create a 2D experiment. Click the New Experiment
button. Select Field as Abscissa 1. Select Microwave
Power as Abscissa 2. Click Create to close the dialog
box. (See Figure 7-8.)

Figure 7-8 Creating a 2D experiment.
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Nonlinear Scans in a 2D Experiment
2. Select a user-defined increment. Click the Parame-
ter button to open the dialog box. Click the Absc. 2 MW
Att. folder. Click Sweep Type and select User defined
up (or User defined down) in the drop-down list. (See
Figure 7-9.) 

3. Enter the microwave attenuation values. In the
User Sweep Data (dB) box, input the microwave atten-
uation values manually. By default, the attenuation incre-
ment is set at 1 dB and the total number of microwave
attenuation settings is 61. This is too fine at low micro-
wave powers since the saturation curve is usually plotted

Figure 7-9 Selecting the user-defined scan for microwave attenuation.
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Nonlinear Scans in a 2D Experiment
as peak intensity versus the square root of microwave
power (mW). Here we can set the microwave attenuation
in a 1 dB increment between 0 dB to 20 dB and 2, 3, or 5
dB increments at the low microwave range. The total
number of microwave attenuations is reduced to 33
instead of 61. (See Figure 7-10.)

4. Adjust the other parameters. Select appropriate
parameters such as receiver gain, etc., for your sample in
the other folders of the Parameter window. Click Close
to exit the Parameter dialog box.

5. Acquire the spectrum. Click the Run button to
acquire the spectrum. Process the 2D dataset. The micro-
wave power saturation curve (peak intensity vs. square
root of microwave power is shown in Figure 7-11.

Figure 7-10 Entering the microwave attenuation values in the User Sweep Data
box.
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Nonlinear Scans in a 2D Experiment
You can apply the nonlinear acquisition function to other 2D
experiments. The name and the appearance of the second
abscissa may be different but you can always select a user
defined sweep to achieve a nonlinear acquisition. You can even
select both the field sweep and the second variable as user
defined sweeps.

Figure 7-11 The microwave power saturation curve of DPPH sample acquired with
a nonlinear 2D acquisition.
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Macros 8
We have implemented macros in Xepr to give users more conve-
nience and freedom to customize their software. A macro is a
stored list of commands that can be executed in order to auto-
mate routine tasks such as data processing or data acquisition. It
is especially convenient for routine processing of large amounts
of spectra. In the first section we will introduce the automatic
recording method to make a macro. You do not need to know
any macro commands or terms to create your own macro. The
second section will guide you through the basic commands of a
macro so you can write your own macro using a text editor. This
method allows you to use arguments and create dialog boxes in a
macro.
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Recording a Macro 8.1
Xepr makes it easy to record a macro and assign a User Button
to the macro in order to easily execute the macro. This section
guides you, step by step, through recording your macro.

Xepr keeps a history of the commands you have executed. The
recording process described here simply takes this history and
saves it into a macro file.

1. Get ready for recording. That includes, for example,
loading a dataset, etc. Any procedures that are necessary
for the operation but you do not want to include in the
macro should be performed before you start.

2. Open the Command Line. Click Options > Com-
mands & History. (See Figure 8-1.) This opens a dialog
box called Xepr Command Line.

Figure 8-1 Opening the Commands & History dialog
box.
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Recording a Macro
3. Start recording. Click Options > Record Macro. (See
Figure 8-2.)

4. Name your macro. A dialog box appears, asking for
the name you want to call the macro. Type a name in the
File box. You can choose into which directory you want
to put the macro file. By default it is saved in the ~/xepr-
Files/Macros subdirectory under your home directory.
The program will automatically add an .xmc extension to
the file name.

Figure 8-2 Starting to record a macro.
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Recording a Macro
5. Record the macro. Click the Record button at the left
bottom corner to start recording the macro.  (See
Figure 8-3.)

6. Perform the operations. Perform the operations, in
sequence, you wish to record in the macro.

Figure 8-3 Setting a macro name and its path.
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Recording a Macro
7. Stop recording. After you have finished your opera-
tions, click Options > Stop Recorder. (See Figure 8-4.)

Figure 8-4 Stopping the recording.
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Recording a Macro
8. View the contents of the macro. A dialog box con-
taining all the macro commands you just recorded
appears. Click on the Close button. (See Figure 8-5.)

9. Test your macro. Return to the conditions before you
started recording the macro, e.g. select the dataset that is
displayed in the Primary. Type the macro filename (with-
out the *.xmc extension) in the command line followed by
<Enter> to execute the macro.

Figure 8-5 A dialog box showing the macro commands
you recorded.

Figure 8-6 Executing the macro from the command line.

Command
Line
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Making a Macro User Button
Making a Macro User Button 8.2
Typing a macro filename in the Xepr Command Line is the not
the most convenient means of executing a macro. A User But-
ton in the Tasks bar makes running a macro as easy as clicking
a button.

1. Load the macro. First load the macro. Click Options >
Command & History > File > Load macro. If you have
just recorded a macro, you do not need to load that macro.

2. Open the Xepr Accelerators dialog box. Click on
User Buttons in Tasks (See Figure 8-7.) to activate the
Xepr Accelerators dialog box. (See Figure 8-8.)

Figure 8-7 The Tasks menu.

User
Buttons
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Making a Macro User Button
3. Define the macro. Click on define button. If you can
not find define button you can click File > Define
Macro.

4. Name the user button. In the acDefButton dialog box
type a name for the button. (See Figure 8-9.)

5. Select a hot key for your macro. You need to assign
a hot key for your macro in the Key column. Special rules
apply to assigning a hot key. You can find those rules in
the Help menu. 

Figure 8-8 Defining the user button.

Figure 8-9 Defining the user button properties.
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Making a Macro User Button
6. Enter a command line. Enter the macro filename with-
out the *.xmc extension. (See Figure 8-9.)

7. Assign a color to the button. Grouping buttons by
color helps organize your macros. To choose a color other
than the default color, click the desired Group button.

8. Finish defining the user button. Click Apply and
then Close to finish making the user button. The newly
defined button should appear in the Xepr Accelerators
dialog box.(See Figure 8-10.)

9. Test your macro. Return to the conditions before you
started recording the macro, e.g. select the dataset that is
displayed in the Primary. Click on the user button to exe-
cute the macro.

Figure 8-10 The macro buttons in the Xepr Accelera-
tors box.
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Writing a Macro with a Text Editor
Writing a Macro with a Text Editor 8.3
You can also write a macro using any text editor. Simply save
your file with an *.xmc extension for macro files. Writing a
macro with this method allows you to use arguments, create a
dialog box, direct the macro to terminate upon an error, and
choose whether the macro executed commands will be recorded
in the data history.

Special Macro Commands 8.3.1
In addition to the normal Xepr commands that are executed by
the macro, there are special macro commands that are preceded
by a �%� character. These special commands control how the
macro executes and allow you to pass data to the various Xepr
commands in the macro. All special macro commands must be
uppercase.

%DESC This command briefly describes the macro. The string after
%DESC is similar to the title of a dataset. For example,
%DESC Example indicates this macro is an example and the
string �Example� will appear in the dialog box as a title when
you load the macro. It will also be displayed when you type the
macro name into the command line.

%TERM If this statement is present, the macro terminates if an internal
error occurs. No additional statement is needed.

%NOHIS If this options is present, commands in your macro will not gen-
erate history output. Instead, only the macro itself will produce a
history line like any other Xepr command. 
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Writing a Macro with a Text Editor
%ARG This statement defines an argument. An argument is the means
by which you create a prompt or dialog box to input and pass
data to the Xepr commands in your macro. Argument syntax is
as follows:

%ARG <name> (<type>) <flag> '<default>'

� name. The argument requires a name so that it can be refer-
enced by the Xepr commands of the macro. You can use any
alphanumeric characters in the name. The name will appear
in prompts or dialog boxes.

� type. Type specifies the data type of the argument. To deter-
mine the data type required by an Xepr command, use the
Help system. (See Section 4.7 of the Elexsys E 500 User�s
Manual: Basic Operations for more information on using the
Xepr Help system.) For example, Figure 8-11 shows the syn-
tax description for the clHistory Xepr command. Here we see
that this command requires a word and a boolean argument.
Note that the datatype must be delimited by parentheses.

Figure 8-11 Syntax description of the clHistory Xepr
command.
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Writing a Macro with a Text Editor
The data type must be one of the following:

� Flag. There are three flags available that determine how the
argument value will be entered.

! The argument value is required right from the start.

# The argument value will be entered in a dialog box.

? The default value will be used if the argument value is not
entered.

� �<default>� The string enclosed by the apostrophes defines
the default value. If no default value is specified, the last
value for that argument will be the default value. For switch
or boolean arguments, this string defines the allowed values,
e.g. '<value1|value2|value3>', where the first one is the
default value.

Data Type Definition

INT_ARG integer

CARD_ARG cardinal number (integer ����

FLOAT_ARG floating point number

COLOR_ARG color (used to change background colors, etc.)

WORD_ARG a single word

TEXT_ARG text string (can contain spaces and punctuation)

SWITCH_ARG several strings, only one of which can be selected

BOOL_ARG logic value with only two possible values, On or Off

PAF_ARG pointer to a file

Table 8-1 Definition of data types.
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Writing a Macro with a Text Editor
To call an argument in you macro body, simply type $<name>
in place of using a constant value.

An Argument
Example

As an example, the following section of a macro file will pro-
duce the following dialog box to prompt you for input. (See
Figure 8-12.)

%DESC Macro loading & displaying a dataset   
%NOHIS
%TERM 
%ARG INT_ARG (INT_ARG)# '1'
%ARG CARD_ARG (CARD_ARG)#
%ARG FLOAT_ARG (FLOAT_ARG)#
%ARG COLOR_ARG (COLOR_ARG)#
%ARG WORD_ARG (WORD_ARG)#
%ARG TEXT_ARG (TEXT_ARG)#
%ARG SWITCH_ARG (SWITCH_ARG)# 'Choice1|Choice2|Choice3'
%ARG BOOL_ARG (BOOL_ARG)# 'On|Off'
%ARG PAF_ARG (PAF_ARG)# 
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Writing a Macro with a Text Editor
Figure 8-12 A dialog box prompting for input.
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Writing a Macro with a Text Editor
The Macro Body 8.3.2
The macro body consists of comments and commands. Lines
starting with an asterisk (*) are marked as comments and are
ignored by Xepr. Any Xepr command can be a macro command.
Refer to the Xepr software manual or Help for available Xepr
commands. No end statement is necessary.

A Macro Example 8.3.3
The following example macro prompts you for a data filename,
a data handle, and whether you want to convert the abscissa
type. It then loads the selected data file into Xepr under the spec-
ified handle number, displays it in the current Primary viewport,
and then converts the abscissa to the selected type. The com-
mands in the macro will not appear in the history except the
macro itself. It will terminate upon internal error. It contains
three arguments: the file name, the data handle number, and the
abscissa type.

%DESC Macro loading & displaying a dataset
%NOHIS
%TERM
%ARG paF (PAF_ARG) #
%ARG number (CARD_ARG) #
%ARG axis (SWITCH_ARG) # 'indexed|index-gauged|n-tuple'
* Load the dataset
ddLoad $paF $number
* switch off all other datasets in current viewport
vpCurrent -1 Secondary 0
vpCurrent -1 Qualifier 0
prNoOp -1
* now display newly loaded data set
vpCurrent -1 $number
ddAbscType $number $axis
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Writing a Macro with a Text Editor
Type the above example in a text editor and save it as exam-
ple.xmc. Load the macro and enter example in the command
line. You can also follow the procedure in Section 8.2 to make it
a user button.

The prompt for the macro will look as follows.

Figure 8-13 An example prompt.
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Automatic Post-Processing 9
The Xepr software offers an automatic post processing feature.
After an acquisition is finished, this feature executes a sequence
of commands that you have defined. This feature can combine
acquisition, data processing, and data storage operations into one
action. It also accepts task-bar routines and user-made macros.
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Activating Auto Post-Processing
Activating Auto Post-Processing 9.1
Let us start with a simple example: we wish to acquire a spec-
trum, double integrate the spectrum, and save the original and
double integrated spectra automatically.

1. Open the auto post-processing dialog box. Click
Acquisition > Auto Post-Processing in the menu bar. A
dialog box appears.

Figure 9-1 Opening the Automatic Define #1 dialog
box.

Auto
Post-
Processing
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Activating Auto Post-Processing
2. Define the auto post-processing commands and
options. (See Figure 9-2.)

Enable Click on to activate auto post-processing.

Raw-Save If you select store&save the raw (unprocessed) spectrum will
be saved as filename_R.DSC and filename_R.DTA files where
filename is defined under Save-Path/File. If you select
store_only the raw spectrum will be stored temporarily under
the title defined in Save-Title and the handle number indicated

Figure 9-2 The auto post-processing definition dialog
box.
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Activating Auto Post-Processing
by $nr-Start. none specifies the raw dataset is to be neither
saved nor stored.

FFT-Type If you want to perform a Fast Fourier Transformation you need
to select either 1D or 2D for one or two dimensional transforms.
Otherwise select none.

Command Command 1, 2, and 3 define the Xepr commands to be exe-
cuted. Each entry accepts one command. You may enter as many
as three commands in this dialog box. Refer to the next section
for entering more than three commands. In this example we use
the command for automatic double integration. To find the Xepr
command for the function you want to use, execute that function
and look at either Help > Main Help or Options > Command
& History. You can also enter the name of a macro or ProDeL
program in the command line.

Post-Save If you select store&save the post-processed spectrum will be
saved as filename_P.DSC and filename_P.DTA files where file-
name is defined under Save-Path/File. If you select store_only
the processed spectrum will be stored temporarily under the title
defined in Save-Title and the handle number indicated by
$nr-Start. none specifies the processed dataset is to be neither
saved nor stored.

Save-Title Enter the title you want to use if you selected save&store or
store_only options.

Save-Path/File Enter the path followed by the filename if you selected the
save&store option in Raw-Save or Post-Save. Make sure the
directory exists and you have permission to write to that direc-
tory. You can use a variable, $nr as part of the file name so that
the file name automatically increments when multiple acquisi-
tions are set. For example, you can set the file name as test$nr
and the saved files will be test1_R, test2_R ..., if you clicked
the Raw-Save button and set $nr-Start to 1. (See next item.)
9-4



Activating Auto Post-Processing
$nr-Start If you choose to save the spectrum and use $nr in the file name
this is the initial value of the $nr variable. If you choose to store
the spectra only, this is the handle number assigned to the data
stored in the data table. It will automatically update to the first
available handle number if it is set to -1. You can force the han-
dle number to a specific value by entering that number.

3. Close the dialog box. Click the Define button to close
the dialog box.
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Activating Auto Post-Processing
4. Check the auto post-processing routine. This
command allows you to run auto post-processing without
acquiring a spectrum.

Load a spectrum in the Primary Dataset and then click
Acquisition > Check Post-Processing  to check
whether the auto post-processing routine operates prop-

Figure 9-3 Checking auto post-processing.

Check
Post-
Processing
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Activating Auto Post-Processing
erly. If you selected save&store in the Auto Post-Pro-
cessing definition dialog box, you need to check whether
the files have been saved and stored. If you do not need
these files, delete them. Otherwise you will receive a
warning message for overwriting the existing file when
you actually execute the auto post-processing routine.

5. Run auto post-processing. Create an experiment and
set up the parameters. Click Run to acquire the spectrum.
Upon completion of the acquisition, Xepr executes the
auto post-processing routine. Figure 9-4 shows the result
of the double integration of the raw spectrum. The origi-
nal spectrum and the processed dataset have been saved
a n d  s t o r e d  a s  Au toPos tP rocess_R  a n d
AutoPostProcess_P files respectively.

Figure 9-4 Result of auto post-processing.

Double
Integration
Result
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Multiple Auto Post-Processing Routines
Multiple Auto Post-Processing Routines 9.2
Only three commands can be executed from one auto post-pro-
cessing routine. In order to execute more commands, there are
two additional post-processing routines. Only the first one (in
the Acquisition menu list) can be triggered when the acquisition
is finished. If you need to use more than three commands you
must activate the other two auto post-processing routines called
Auto #2 and Auto #3.

Setting Up More than Three Commands 9.2.1
1. Call Auto #2 and/or Auto #3. Click Acquisition >

Auto Post-Processing. Enter prAuto2 in one of the
command lines of the dialog box. 

Figure 9-5 Setting up auto post-processing.

Call
Auto #2
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Multiple Auto Post-Processing Routines
You can also enter prAuto3 if needed and if there is a
command entry available. (See Figure 9-5.) In this exam-
ple, the Primary dataset will be copied and pasted to the
Secondary Dataset. This way we will be able to apply
different processes to the original dataset. Then it calls the
second auto post-processing function Auto #2.

2. Open the second auto post-processing dialog
box. Click Processing > Automatic > Define #2 to
open the dialog box. (See Figure 9-6.) 

Figure 9-6 Opening the Automatic Define #2 dialog
box.

Open
Auto #2
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Multiple Auto Post-Processing Routines
3. Define Auto #2. The dialog box for defining this routine
is exactly the same as the previous one. You need to
Enable this function by clicking the on button. In this
example, we enter the command for double integrating the
Primary data in Command 1 and call the third auto
pos t -p rocess ing  rou t ine  in  Command 2 .  (S ee
Figure 9-7.)

Figure 9-7 Defining the Auto #2 routine.

Call
Auto #3
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Multiple Auto Post-Processing Routines
4. Open the third auto post-processing dialog box.
Click Processing > Automatic > Define #3 to open the
dialog box. (See Figure 9-8.) 

Figure 9-8 Opening the Automatic Define #3 dialog
box.

Define
#3
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Multiple Auto Post-Processing Routines
5. Define Auto #3. The items in this dialog box are the
same as for the other two. Remember to activate this func-
tion by clicking the Enable on button. In this example we
are going to peak pick the Secondary Dataset.

6. Check the auto post-processing routines. Load a
spectrum into the Primary Dataset. Click Processing >
Automatic > Check #2 or Check #3 to see if the
Auto #2 or Auto #3 routines function properly. If you
called Auto #3 from Auto #2, both auto post-processing
routines will be checked when you click Check #2. Oth-
erwise they must be checked independently. (See
Figure 9-10.)

Figure 9-9 Defining the Auto #3 routine.
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Multiple Auto Post-Processing Routines
When you activate the chain of auto processing routines,
you need to be careful about the sequence in which it exe-
cutes, especially when you want to automatically store or
save the results. You can test the routines with the Check
#1 command to make sure the execution order is correct.

Figure 9-10 Checking the Auto #2 and/or Auto #3 rou-
tines.

Check
#2Check

#3
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Multiple Auto Post-Processing Routines
7. Execute the multiple auto post-processing rou-
tines. Create or load an experiment and set up the param-
eters. Click Run to acquire the spectrum. The auto
post-processing routines should execute sequentially. In
this example the results of the auto-processing are shown
in Figure 9-11. 

Figure 9-11 Results of a series of auto post-processing routines.
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Implementing Help 10
One of the powerful features of the Xepr software is that you can
customize your Xepr program by utilizing Xepr macros and
ProDeL programs. In order to share these customized routines
and functions with your fellow users, they must know how to
use them. The Xepr help system allows you to implement your
own instructions for these customized functions or routines. The
help files can include definitions, descriptions, command and
argument syntax, helpful hints, related command, etc. This chap-
ter will describe how to implement your own help files in the
Xepr help system.

Writing a Help File 10.1

Help File Format 10.1.1
Xepr help files are plain ASCII text files. You can use any text
editor to compose the help file. No special format is required.
There are two important statements: DESC and MORE. DESC
indicates the start of the text to be displayed in the help window.
All text preceding the statement is not displayed. If the file is too
long to display in one help window, type the MORE command
into the help file to divide the file into more manageable sec-
tions. When viewing the help file, the More button in the help
dialog box advances you to the next section. You can use MORE
as many times as you wish if the file is very long. The Back but-
ton in the help dialog box returns you to the previous section.
The following page shows an example help file.
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Writing a Help File
PURPOSE
  sets data byte sequence of a Dataset
DESC
DESCRIPTION
  Sets the byte sequence used to represent binary values in the
  current dataset.
MORE
DIALOG PARAMETERS
  Binary coordinate values in a BES3T-file can
  be represented in two different formats:

    MSB first: the bytes are saved starting with the most
               significant byte. This is the format used on SPARC and
               MOTOROLA microprocessors based machines.
    LSB first: the bytes are saved starting with the least
               significant byte. This is the format used on INTEL 
               microprocessors based machines.

  The format thus defined is applied to all binary values of a
  dataset.

SEE ALSO
  BES3T-Documentation
MORE
  It is not necessary to change the byte sequence of a dataset
  if you want to read in dataset files on another machine, because 
  BES3T-compliance requires the ability to read both byte sequences.
  Changing the byte sequence to that of the target machine just
  saves the time required to internally swap all data bytes.

SYNTAX

COMMAND LINE USAGE
  The dataset indicated by <#> is modified, not the current selec-
tion.

EXAMPLES
  ddByteSeq 4 MSB first

SEE ALSO
  ddLoad, ddSave
MORE
TECHNICAL ASPECTS
  This command changes the BSEQ entry in the BES3T .PAR
  file. 

  Changing the format only affects the way data are saved to
  disk, the memory representation in the Xepr program remains

  unchanged.
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Writing a Help File
Help Filenames 10.1.2
The help filename for a command must be identical to the com-
mand name. No extension is needed. For example, if the macro
you made is called eXample and saved as eXample.xmc, the
help file for this macro must be named eXample without exten-
sion.

Where to Put the Help Files 10.1.3
Access to a help file is determined by the location of the file. If
you want every user from all accounts to be able to see a help
file you need to save the file in the /usr/xepr/sharedHelp
folder. Note that you need root privileges to do so. If you want to
limit access to one user account, e.g. xuser, save the file in
/usr/people/xuser/xeprFiles/Help on an SGI system running
IRIX and only those who log in as xuser have access to this help
file. For a Linux system, put the file in the /home/xuser/xepr-
Files/Help directory.
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Accessing Help
Accessing Help 10.2
You can always click the Help button in the menu bar and click
Main Help. Enter the command name in the Selection box and
click Keyword. Click the Apply button and a help dialog box
appears and displays the content of the help file for that particu-
lar command. (See Figure 10-1.) 

Alternatively, you can execute the command and then click Help
> Main Help in the menu bar. The command you just executed
will appear in the Selection box. Click Keyword and Apply
buttons to view the help contents.

If your macro or ProDeL program prompts you for user input,
there will be a Help button in the dialog box. Click the Help but-
ton in the dialog box and the contents of the help file for that
routine is displayed.

Figure 10-1 Accessing Help.
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Figure 10-2 The Help button of the prompt dialog box.
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Changing Microwave Bridges 11

Removing the Microwave Bridge 11.1
1. Turn off the spectrometer. Follow the procedures in

Chapter 3 of the Elexsys E 500 User�s Manual: Basic
Operations to turn off the spectrometer if it is still on.
Close the water valves.

2. Remove the cavity. Follow the instructions of
Section 7.2 of the Elexsys E 500 User�s Manual: Basic
Operations to remove the cavity. Remove the waveguide
extension from the bridge as well. 

3. Disconnect the cooling water. Not all bridges require
water cooling. If the current bridge has water cooling, first
close the water valves for the bridge. Disconnect the water
hose to and from the bridge. (See Figure 11-1.) Block the
water hose to prevent water spillage.

Figure 11-1 The cooling water connectors for the microwave bridge.
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Removing the Microwave Bridge
4. Disconnect the power supply cable. There are two
clips used to secure the connection of the power supply
cable to the bridge. Press both clips with your thumb and
index finger and pull out the power supply cable. (See
Figure 11-2.)

5. Disconnect the remote control cable. There are two
clips, one on the top and one on the bottom of the remote
control cable connector. Flip both clips out against the
bridge back panel. Then remove the remote control cable.
(See Figure 11-2.)

6. Disconnect the signal cable. The signal cable has a
BNC connector. Disconnect the signal cable carefully. 

7. Disconnect other connections. Depending on the
bridge, you may have other connections such as an iris
motor controller cable, frequency counter cable, FF Lock
cable, etc. Disconnect all these connections. (See
Figure 11-3.)

8. Remove the bridge from the bridge table. Unless
you need to put the new bridge on top of the old bridge,
remove the bridge from the bridge table and place it in a

Figure 11-2 The power supply, remote control, and signal cable connectors.
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Removing the Microwave Bridge
safe place. Cover the waveguide opening on the bridge
with the waveguide cover to prevent dust from entering
the waveguide. 

Figure 11-3 Other bridge connections.
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Installing a Microwave Bridge
Installing a Microwave Bridge 11.2
1. Put the microwave bridge on top of the bridge

table. Some non X-band bridges actually sit on top of the
X-band bridge.

2. Attach the waveguide extension. For some cavities
you need to attach the waveguide extension to the bridge.

Align the waveguide 

Figure 11-4 The waveguide extension.
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Installing a Microwave Bridge
gasket in the correct direction (Refer to Figure 11-5.) and
tighten the waveguide screws.

3. Adjust the bridge position. Adjust the position of the
bridge so that the waveguide extension is approximately
centered (right to left) in the magnet.

4. Install the EPR cavity. Follow the instructions in Sec-
tion 7.2 of the Elexsys E 500 User�s Manual: Basic Oper-
ations in order to install the cavity. Adjust the bridge
position to center the cavity in the magnet. Secure the cav-
ity position with either the waveguide stabilizers or a cav-
ity mounting device.

5. Connect the cooling water. If cooling water is
required, connect the cooling water hoses to the connec-
tors and open the water valves for the bridge. Turn on the
heat exchanger to test for any water leakage. Make sure
there is no leakage from the connections. Turn off the heat
exchanger.

6. Connect the power supply cable. Line up the pins
and push in the bridge power supply cable connector. 

7. Connect the remote control cable. One side of the
connectors is wider and the other side is narrower. Line

Figure 11-5 Installing the waveguide gasket properly.
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Installing a Microwave Bridge
them up and push in the connector. Flip the two clips to
secure the connection.

8. Connect the signal cable. The signal cable has a BNC
connector. Push it in and rotate to secure the connection.
There are two 50 ohm signal output from the bridge. Con-
nect the signal cable to either one of them.

9. Connect other accessories. If you have auto tuning
capabilities, connect the iris motor cable. If you have
other accessories to connect to the bridge, connect them
accordingly.
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Installing a Microwave Bridge
10. Set the DIP switches on the microwave bridge
controller. The microwave bridge controller is the top
unit of the console. There is a dip switch unit in the micro-
wave bridge controller. The DIP switches need to be set
correctly to suit your bridge so that the tuning picture will
be displayed correctly. The are four dip switches. The
switches are from left to the right, SW1-SW4. The set-
tings for these switches for commonly used bridges are
listed in Table 11-1. 

Figure 11-6 The microwave bridge controller.
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Notes
11. Turn on the spectrometer. Follow the instructions in
Chapter 3 to turn on the spectrometer. Open the bridge
tuning dialog box. Check if the tuning picture is correct. If
you see an abnormal tuning picture, you might have
wrong DIP switch settings.

Bridge Type SW1 SW2 SW3 SW4

 X-, S-, L-, band Gunn
bridge, 60 dB

attenuator

Down Down Up Up

X-band Klystron
bridge, 60 dB

attenuator

Up Up Up Up

Q-band Gunn bridge
without cooling water

Up Up Up Down

Q- and K-band Gunn
bridge with cooling

water

Down Up Up Down

Table 11-1 DIP switch settings for commonly used bridges
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Installing & Using Accessories 12
Bruker offers many optional accessories for the Elexsys series
spectrometers. In this chapter, we shall concentrate on aspects
that directly relate to the use of these products with the Xepr
software. Most of the accessories have their own individual
manuals: consult their documentation for further information
and details.
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Frequency Counters
Frequency Counters 12.1
Precise microwave frequency measurement is crucial for pre-
cisely measuring g-values and calibrating magnetic field values.
Xepr supports several frequency counters. This section describes
how to connect and configure these supported counters cor-
rectly. Remember to click the Apply and Save buttons to acti-
vate the changes and save the configuration.

The MBC Board 12.1.1
The MBC (Microwave Bridge Controller) board supplies micro-
wave frequency readings from control voltages in the bridge. If
you do not have a frequency counter, this is your only option.
Click Acquisition > Spectrometer Configuration > Misc.
(See Figure 12-1.) Select MBC from the drop-down list in the
Frequency Counter section. (See Figure 12-2.)

Figure 12-1 Configuring a frequency counter.
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Frequency Counters
It is possible to calibrate the frequency displayed by the MBC
board if you have a frequency counter available to you. (See
Section 12.1.3 to learn how to connect the counter to the
bridge.) 

1. Record the frequency reading of the MBC board.
2. Record the frequency reading of the frequency

counter.
3. Calculate the MBC Calibration Offset. The offset

equals:

MBC Calibration Offset = �Counter - �MBC [12-1]

4. Enter the value for the MBC Calibration Offset.
(See Figure 12-1.)

Figure 12-2 Selecting the proper frequency counter.

The frequencies read
from the MBC board
are not precise enough
for  prec ise  g-value
measurements.
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Frequency Counters
The Bruker Frequency Counter 12.1.2
The Bruker frequency counter is optional for L-, S-, and X-band
bridges. The frequency counter is mounted in the front panel of
the bridge. It provides more accurate readings of the microwave
frequency than the MBC board. 

Connect the cable labeled MBCT-MWB 4001589 to the
RS232 connector on the back of the bridge. (See Figure 12-3.)
Click Acquisition > Spectrometer Configuration > Misc. In
the Frequency Counter section select Bruker in the drop-down
list. (See Figure 12-1 and Figure 12-2.)

Frequency Counters by Other Vendors 12.1.3
Xepr supports the following frequency counters offered by other
vendors:

HP 5340A EIP 545A
HP 5342A EIP 548A
HP 5350A EIP 625A
HP 5352A EIP 628A
HP 53150A

Figure 12-3 The frequency counter RS232 connector on the back of the bridge.
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Frequency Counters
You need to set the IEEE address of your frequency counter to 8.
Refer to your frequency counter manual for instructions on set-
ting the address. Connect the microwave output on the back of
the bridge to the input of the frequency counter with a high qual-
ity microwave cable with SMA connectors on both ends. (See
Figure 12-4.) Connect the IEEE-488 cable from the back of the
Elexsys console to the IEEE connector of your frequency
counter. You may have to open the back panel of the console to
locate the cable.

Turn on the frequency counter and the Elexsys E 500 spectrome-
ter. Click Acquisition > Spectrometer Configuration > Misc.
Select the proper frequency counter in the drop-down list. (See
Figure 12-1, and Figure 12-2.)

You must set the bridge to Operate mode in order to read the
frequency from the frequency counter.

Figure 12-4 Microwave outputs on the back of the microwave bridge.

Microwave
Outputs

When you connect the
frequency counter for
the first time, you may
need to click the Acti-
vate button to initiate
co m m un i c a t i o n s
between Xepr and the
the frequency counter.
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ER 41X1VT Variable Temperature Systems
ER 41X1VT Variable Temperature Systems12.2
These variable temperature systems are used for liquid nitrogen
and above room temperature experiments. Refer to the manuals
of your variable temperature unit for assembly and operation
instructions. In this section we provide instructions for connect-
ing the temperature controller to the Elexsys E 500 spectrometer
and configuring the Xepr software.

The X in the model number corresponds to the numbers one,
two, or three. Xepr fully supports the newest temperature con-
troller, BVT 3000 (ER 4131 VT). The older BVT 2000
(ER 4121 VT) and BVT 1000 (ER 4111 VT) temperature con-
trollers are only partially supported. The following steps
describe connecting and configuring the controller. 

1. Connect the RS 232 cable. (For ER 4131VT and
ER 4121VT systems.) Open the front door of the con-
sole. Use the RS 232 cable to connect the RS 232 connec-
tor of the BVT temperature controller to the RS2
connector of the ACPU board in the Elexsys console.
(See Figure 12-5.)

2. Connect the Slow Device Bus cable. (For
ER 4111VT systems only.) Open the front door of the
console. Connect the COMPUTER connector on the
BVT 1000 temperature controller to the SLD connector
on the SIP board of the acquisition server using a 25 pin
Slow Device Bus cable. (See Figure 12-5.)

Th es e  un i t s  a r e
optional accessories
and you may or may
not have ordered them.
If you require an acces-
sory, contact your local
Bruker EPR sales rep-
resenta tive for pur-
chase information.
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ER 41X1VT Variable Temperature Sys-
3. Configure the temperature controller. Turn on the
temperature controller and the spectrometer. Connect to
the spectrometer. Click Acquisition > Spectrometer
Configuration > Misc. Select the variable temperature
system you are using in the Type drop-down list. Click
Apply. If you plan on using the temperature controller in
the future, click Save. Then click Close to close the dia-
log box. (See Figure 12-6.)

Figure 12-5 Connecting the RS 232 cable to the console.

RS2
Connector

SLD
Connector
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Figure 12-6 Setting the Temperature Controller type.

Select
Model
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ER 41X1VT Variable Temperature Sys-
4. Define an experiment that uses the temperature
controller. Create a new experiment with the Temp.
Unit button activated (green). (See Figure 12-7.) Open
the Acquisition Parameters dialog box where you will
find the VTU folder. This folder allows you to set the tem-
perature after you click the Activate button. For the
ER 4131 VT controller there is another sub-folder that
gives you remote control of many controller parameters
such as gas flow and N2 evaporator boiler power. (See the
ER 4131 VT User �s  manual  for  detai ls . ) For the
ER 4121 VT and ER 4111 VT controllers you can set the
temperature but you need to manually control other con-
troller operating parameters. 

Figure 12-7 Defining an experiment using a temperature
controller.

Consult the documen-
t a t i on  fo r  t he
ER 4131VT to learn
more details about its
operation.
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ER 4112HV Variable Temperature Systems12.3
The Bruker Elexsys E 500 series spectrometers support the
ER 4112HV temperature controller unit for liquid helium. In this
section we provide instructions for connecting the ITC 503 tem-
perature controller to the Elexsys E 500 spectrometer and con-
figuring the Xepr software. It is assumed that you are already
familiar with the operation of the temperature controller. If not,
consult the Oxford Instruments documentation.

Setting the Controller Up 12.3.1
1. Connect the controller to the console. Connect the

IEEE 488 cable from the back of the spectrometer con-
sole to the IEEE 488 connector of your ITC 503 tempera-
ture controller. You may have to open the back panel of
the console to locate the cable.

2. Connect to the spectrometer. Turn on the spectrom-
eter and the ITC 503 temperature controller. After the
acquisition server is booted, connect to the spectrometer. 

3. Set the IEEE address. Click Acquisition > Spec-
trometer Configuration > Misc. In the Type drop-down
list, select ITC 5 for your temperature controller. The
default IEEE address is 24 for both the temperature con-
troller and the Xepr software. 

4. Enter the temperature offset. If you have carefully
calibrated the temperature difference between the sample
and the temperature sensor, you can enter this temperature
offset in the Calibration Offset box.

This unit is an optional
accessory and you may
o r  m ay  n o t  h av e
o rd er ed  i t .  I f  y o u
require an accessory,
co n t a c t  y o u r  l oc a l
Bruker EPR sales rep-
resenta tive for pur-
chase information.

Consult the documen-
t a t i on  fo r  t he
ER 4112HV to learn
more details about its
assembly and opera-
tion.
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ER 4112HV Variable Temperature Sys-
The Calibration Offset equals:

Calibration Offset = Tactual - TITC [12-2]

where Tactual is the actual temperature at the sample and
TITC is the temperature measured with the cryostat tem-
perature sensor.

5. Select a sensor. In the Heater Sensor section select
the temperature sensor you are using on the ITC 503 con-
troller to control the sample temperature. Unless you have
multiple helium cryostats in your lab, you usually should
select Sensor 1. Click Apply. If you plan on using the
temperature controller in the future, click Save. Then
click Close to close the dialog box. (See Figure 12-8.)

Figure 12-8 Configuring the ITC 503 temperature controller.
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ER 4112HV Variable Temperature Systems
6. Define an experiment that uses the ITC 503. Cre-
ate a new experiment with the Temp. Unit button acti-
vated (green). Click Create to close the dialog box. (See
Figure 12-9.)

The Temperature Folder 12.3.2
If you click the Acquisition Parameters button you will find a
new folder labeled VTU. Click the Activate button in the main
application window to interactively control the ITC 503 unit.
There are two sub-folders in the VTU folder. In the Tempera-
ture folder you find the following parameters: 

Temperature [K] Enter the set temperature here. The set temperature is the desired
temperature for the experiment and hence the temperature the
variable temperature accessory attempts to obtain and maintain.

Figure 12-9 Defining an experiment using a temperature
controller.
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ER 4112HV Variable Temperature Sys-
Temp Settling
Time [s]

You cannot conclude that just because the temperature sensor
has attained your set temperature that your sample has attained
this temperature as well. The sample temperature will change
more slowly because of the larger thermal mass of the sample as
well as any possible phase transitions. If you are performing a
quick temperature survey, you can set this value to a few sec-
onds. If you are performing a careful study such as a phase tran-
sition temperature determination, it is advisable to wait at least
10 min. if you are changing your set temperature by 10 K jumps.
Enter the desired delay after the set temperature is reached here.

Tolerance The Xepr EPR software waits until the set temperature is
reached before it acquires an EPR spectrum. In physical mea-
surements there is no such thing as exactly the same tempera-
ture. By entering a value for the tolerance, you specify how
closely the measured temperature matches the set temperature
before the Xepr software acquires an EPR spectrum. 

Figure 12-10 The Temperature folder.
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ER 4112HV Variable Temperature Systems
The ITC5 Control Folder 12.3.3
In the ITC5 Control folder you can change many ITC 503
parameters remotely. Among your choices and options are:

ITC Operation
Mode

REMOTE specifies that the Xepr software remotely controls the
temperature controller. If you must access controls on the front
panel of the temperature controller manually, select LOCAL
mode.

Unlock PID
Settings

If this option is activated (green) you can change the parameters
in the P.I.D. Parameters section. If inactive, the temperature
controller operates in Auto PID mode.

Figure 12-11 The ITC5 Control folder.
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ER 4112HV Variable Temperature Sys-
Heater Control In Auto mode, the temperature controller stabilizes the tempera-
ture at the set temperature by controlling the Heater Power
automatically. Under some unusual circumstances you may need
to specify a constant Heater Power value. Select Manual mode
to manually control the Heater Power.

Gas Flow Control If you have a transfer line with a motorized needle valve, the
temperature controller can automatically control the cryogen
flow when Auto mode is selected. Normally, you should select
Manual mode to adjust the Gas Flow manually and let the
heater stabilize the temperature first. Once a stable temperature
with Auto Heater Control is reached, you can activate Auto
Gas Flow Control. If you initially set both Gas Flow Control
and Heater Control to Auto mode at the same time, the two reg-
ulation loops can fight each other, causing wild temperature
oscillations.

Gas Flow If you selected Manual Gas Flow Control mode, you can
change the needle valve position here. Zero corresponds to fully
closed and 99.9 corresponds to fully open. Note that the flow
does not vary linearly with needle valve position. If you selected
Auto mode, the current needle valve position is displayed.

Heater Power
[% of limit]

If you selected Manual Heater Control mode, you can change
the Heater Power here. Zero corresponds to no power and 100
corresponds to full power. If you selected Auto mode, the dis-
play is grayed out.

Heater Power
Limit[%]

The Heater Power Limit allows you to limit the amount of
power applied to the heater. 100% corresponds to 40 V. This
value should be set to 87.5% for all Helium variable temperature
controllers in order to operate at the standard 35 V heater limit.

Current Heater
Power[%]

The Current Heater Power is displayed here.
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ER 4112HV Variable Temperature Systems
Normally you should run experiments using Auto PID mode.
Under some circumstances, you may need to change the PID
values.

Proportional The Proportional term corresponds to the reciprocal of the feed-
back gain. Consult your cryostat data sheet in the cryostat man-
ual for the appropriate value for your set temperature. You need
to activate (green) the Unlock PID Settings button in ITC
Operation Modes to make any changes in this parameter.

Integral The Integral term corresponds to the time constant of the feed-
back loop. Consult your cryostat data sheet in the cryostat man-
ual for the appropriate value for your set temperature. You need
to activate (green) the Unlock PID Settings button in ITC
Operation Modes to make any changes in this parameter.

Derivative The Derivative term controls the response of the controller to
rapid changes in temperature. Consult your cryostat data sheet in
the cryostat manual for the appropriate value for your set tem-
perature. You need to activate (green) the Unlock PID Settings
button in ITC Operation Modes to make any changes in this
parameter.

There is a Temperature box in the Monitoring Panel which
displays the current temperature. It turns to green when the mea-
sured temperature reaches the set temperature within the speci-
fied tolerance. There are built-in 2D experiments available in the
New Experiments for your variable temperature studies.
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The E 033M Field Frequency Lock
The E 033M Field Frequency Lock 12.4
If you have warmed up your spectrometer sufficiently, you can
usually perform stable field sweep experiments. Sometimes the
microwave frequency can drift owing to a number of external
influences. For example, sample heating can occur at high
microwave (or RF in ENDOR experiments) power levels. With
very long data acquisitions, the room temperature and hence the
cavity frequency can change. Frequency drift results in drift of
the apparent field for resonance owing to the Zeeman effect. 

This drift affects two different classes of experiments. In static
magnetic field experiments such as ENDOR or time sweeps in
which you set your magnetic field to a specific point in your
EPR signal, you will drift away from that specific point, result-
ing in baseline distortions and changing intensities. In magnetic
field sweep experiments requiring signal averaging of weak and
particularly narrow signals, the frequency drift produces a
broadening or smearing of the EPR lines.

The FF-Lock (Field-Frequency Lock) unit corrects for these
drifts by locking to an external g = 2 EPR standard. As the
microwave frequency changes, the FF-Lock adjusts the mag-
netic field to keep the EPR standard in resonance. In order to sta-
bilize at fields where g ��2 or to perform field sweeps, there are
a set of offset coils on the FF-Lock probe. By changing the mag-
netic field offset at the probe, we change the magnetic field
value at which the FF-Lock locks the magnetic field. The
FF-Lock has a total operating range of 120 Gauss, i.e. ± 60 G
either side of g=2.0.

This unit is an optional
accessory and you may
o r  m ay  n o t  h av e
o rd er ed  i t .  I f  y o u
require an accessory,
co n t a c t  y o u r  l oc a l
Bruker EPR sales rep-
resenta tive for pur-
chase information.
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The E 033M Field Frequency Lock
Installing an FF-Lock 12.4.1
If the FF-Lock is not currently installed in your console, you
need to follow the instructions in this section.

1. Install the FF-Lock probe head. Follow the instruc-
tions of the FF-Lock manual to mount the FF-Lock probe
head and connect the semi-rigid cable to the microwave
bridge.

2. Remove the blank panel. Open the front door of the
Elexsys console. Remove the blank panel under the
microwave bridge controller of the console. There are two
panels. You can use whichever one is available. 

3. Install the FF-Lock unit into the console. Align the
FF-Lock unit to the support brackets in the console and
slide it in. Secure the unit with the mounting screws.

4. Change the ER 032 T cable connections. Open the
back door of the console. There is a cable labeled
ER 032 T connected to the 5 pin connector on the back of
t h e  f i e l d  c o n t r o l l e r.  ( S e e  t h e  d o t t e d  a r r o w  i n
Figure 12-12.) Disconnect the cable and reconnect it to
the MAG. OUT 5 pin connector on the back of the
FF-Lock. (See Figure 12-12.)
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The E 033M Field Frequency Lock
5. Connect MAG. IN to the field controller. Using
another 5 pin cable connect the MAG. IN signal of the
FF-Lock to the 5 pin connector on the back of the field
controller where the ER 032 T cable was connected.

6. Connect the sweep address cable. Use the 15 pin
ribbon cable to connect SWA OUT of the field controller
to SWA IN of the FF-Lock. (See Figure 12-12.)

Figure 12-12 Back view of the FF-Lock (above) and field controller (below).
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Elexsys E 500 User�s Manual: Advanced Operations 12-19



The E 033M Field Frequency Lock
7. Connect the power supply cable. Locate the
FF-Lock Burndy cable from the power rack on the back of
the console. Connect it to the Burndy connector on the
back of the FF-Lock. (See Figure 12-13.)

8. Connect the IEC 625 cable. There is an IEC 625
cable connected to the front of the GSI board of the acqui-
sition server. Connect the other end to the IEC 625 con-
nector on the back of the FF-Lock. (See Figure 12-13.)

9. Connect the FF-Lock probe head. There are two
cables coming out of the FF-Lock probe head. The Modu-
lation/Sweep cable (triax) needs to be connected to
MOD OUT on the back of the FF-Lock. The Signal cable
(coax) needs to be connected to SIG IN on the back of the
FF-Lock. (See Figure 12-13.) 

Figure 12-13 Back view of the FF-Lock.
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The E 033M Field Frequency Lock
10. Check the IEEE 488 address. The default IEEE 488
address is three. The DIP switches for setting the address
define a binary number. Therefore three corresponds to
switches 1 and 2 on. Switches 6 and 7 should be on for
proper communication. All other switches should be off.
The switches are rocker switches and on corresponds to
having the upper part pressed in. (See Figure 12-13.)

11. Configure the FF-Lock. Follow the instructions in
Section 4.1 to configure the FF-Lock.

Using the FF-Lock in Lock-in Mode 12.4.2
The lock-in mode of the FF-Lock allows you to keep an EPR
signal in resonance despite shifts in frequency. It also allows you
to perform stable field-sweeps over very long periods of time in
which the microwave frequency can drift. 

1. Get ready for using the FF-Lock. Set the microwave
bridge controller to Operate mode. 

2. Define a field sweep experiment. 
3. Select the center field and sweep width. As men-

tioned in the introduction the FF-Lock can lock over a
± 60 G range centered at g = 2. Set the center field value
to a value that corresponds to g = 2 at your microwave fre-
quency. Set the sweep width to less than 120 G. To ensure
that we can lock the FF-Lock, set the current magnetic
field to the center field value.

4. Open the FF-Lock/Teslameter dialog box. Click
the FF-Lock/Teslameter button and open the dialog box.
(See Figure 12-14.)

The  FF-Loc k  on ly
works at X-band.
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The E 033M Field Frequency Lock
5. Click the Lock-In button. In the FF-Lock/Teslameter
dialog box click the Lock-In button. The FF-Lock will
start to lock onto the current field. This procedure takes
approximately 3-5 seconds and the FF-Lock box in the
monitoring panel informs you of the progress. (See
Figure 12-15.)

Figure 12-14 The FF-Lock dialog box.

Figure 12-15 Locking the field.
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The E 033M Field Frequency Lock
During the locking process the FF-Lock finds the mag-
netic field offset (produced by the offset coils) required to
bring the internal g=2 standard in resonance. This value
appears in the FF-Lock [G] display of the monitoring
panel. It corresponds to the difference between the present
magnetic field and the field for resonance of the g = 2
standard. This value will change as you sweep the field.
(See Figure 12-16.)

6. Sweep the field with the FF-Lock. When the Lock-In
procedure has been successfully completed, the FF-Lock
then takes over control of the field from the Hall field
controller after you click the Run button. The FF-Lock
now controls both the Center Field and the Sweep
Width. Once the FF-Lock is locked, all acquisition
parameters, including the field sweep parameters, may be
changed without unlocking it first.

Figure 12-16 The magnetic field offset of the FF-Lock.
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The E 033M Field Frequency Lock
Troubleshooting Locking Problems 12.4.3
If the Lock-In procedure is unsuccessful after its fifth attempt,
an error message appears in the FF-Lock window. (See
Figure 12-17.)

If this happens, check if:

� The magnetic field is in the locking range of the FF-Lock
(± 60 G centered at g = 2).

� The microwave bridge is not in STAND BY mode.

� The SMA connectors on the semi-rigid microwave cable are
sufficiently tight. (Do not over-tighten them!)

If for any reason the FF-Lock should lose its lock during an
acquisition, the message �Lost Lock� will be displayed in the
FF-Lock box of the monitoring panel. (See Figure 12-18.)  

Figure 12-17 Failure to lock the field.

Figure 12-18 Lost lock.
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The E 033M Field Frequency Lock
Then the field control is automatically transferred back to the
Hall field controller until the FF-Lock catches up of its own
accord, or is locked in again. If this happens, the acquired data
will have to be discarded.

The FF-Lock has a total operating range of 120 Gauss, i.e.
± 60 G either side of g=2.0. Hence if the field sweep is centered
at g=2.0, the maximum sweep width is 120 G. The further away
the center field is from g=2.0, the smaller the maximum possible
sweep becomes. The maximum sweep width (in Gauss) is given
by the formula:

SWMax = 2 * (60 - |OF|) [12-3]

where OF is the difference between the center field and the mag-
netic field where g=2.0. If the presently set sweep width and
center field exceed this limit, an appropriate error message is
displayed.
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The E 033M Field Frequency Lock
Marker ode 12.4.4
So far, we have used the FF-Lock in Lock In mode. The second
mode for the FF-Lock is Marker Mode. What this mode does is
to supply a marker on your acquired spectrum to indicate where
the g=2 standard is in resonance. (You are marking where g=2 is
in your spectrum.) This mode is useful for calibrating the field
difference between the FF-Lock probe and the sample.

1. Activate the Marker Mode. Open the
FF-Lock/Teslameter dialog box. Click the Marker
Mode button. (See Figure 12-19.) The Marker Field box
will show Unknown.

Figure 12-19 Activating the Marker Mode.
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The E 033M Field Frequency Lock
2. Create an FF-Lock field Marker. Click the X-Marker
button to open the dialog box. In the X Parameter
drop-down menu,  se lec t  FFMarkerF ie ld .  (See
Figure 12-20.)

Figure 12-20 Creating an FF-Lock Marker.
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The E 033M Field Frequency Lock
3. Sweep the field. Click the Run button. After the field
sweep finishes the FF-Lock Field Marker will move to
the field for resonance of the g=2 standard in the FF-Lock
probe. A more accurate field value can be found in the
FF-Lock/Teslameter dialog box. (See Figure 12-21.)

4. Calibrate the field difference. The FF-Lock probe
and the sample are not physically in the same place in the
magnet. Therefore there will be a field difference between
the sample and FF-Lock probe. To calibrate this differ-
ence, insert your Bruker DPPH standard and follow
instructions 1-3. Subtract the DPPH field for resonance
from the marker field and record this difference.

Figure 12-21 The FF-Lock Marker.
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The E 033M Field Frequency Lock
Calibration Offset = Bmarker - BDPPH [12-4]

5. Enter the Calibration Offset. Click Acquisition >
Spectrometer Configuration. In the Field folder of the
dialog box enter the value you measured in the previous
step into the Calibration Offset box in the FF-Lock sec-
tion. (See Figure 12-22.) 

6. Verify the Calibration Offset. Reacquire the DPPH
spectrum in Marker Mode. The marker position and the
DPPH field for resonance should coincide.

Figure 12-22 Changing the FF-Lock Marker position.
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The E 033M Field Frequency Lock
Out of Locking Range Errors 12.4.5
If you set the field position or the Calibration Offset out of the
locking range you will receive a �No Resonance� error mes-
sage in the FF-Lock/Teslameter dialog box. (See Figure 12-23.)
Reset the magnetic field position to remedy this error.

Figure 12-23 The No Resonance error message.
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The E 035M Teslameter
The E 035M Teslameter 12.5
The Bruker E 035M teslameter (gaussmeter) is designed for pre-
cisely measuring the magnetic field B0 and uses the proton
nuclear magnetic resonance frequency to measure the magnetic
field. Since the resonant frequency can be measured precisely,
the resulting resolution of the magnetic field value can be 1 mil-
ligauss. This section describes how to connect it to the Elexsys
console as well as how to use it with the Xepr software.

Installing a Teslameter 12.5.1
1. Mount the teslameter probe. Follow the instructions

of the teslameter manual to mount the teslameter probe.
Select the probe that covers the field range at which you
are working.

2. Remove the blank panel. Open the front door of the
Elexsys console. Remove the blank dummy panel under
the microwave bridge controller of the console. There are
two panels. You can use whichever one is available. 

3. Install the teslameter unit into the console. Align
the teslameter unit to the support brackets in the console
and slide it in. Secure the unit with the mounting screws.

4. Connect the teslameter cable. Use the connecting
cable to connect the teslameter probe to the teslameter
cable connector on the rear panel of the teslameter unit.
(See Figure 12-24.)

This unit is an optional
accessory and you may
o r  m ay  n o t  h av e
o rd er ed  i t .  I f  y o u
require an accessory,
co n t a c t  y o u r  l oc a l
Bruker EPR sales rep-
resenta tive for pur-
chase information.

Consult the teslameter
documentation for fur-
ther details.
Elexsys E 500 User�s Manual: Advanced Operations 12-31



The E 035M Teslameter
5. Connect the power supply cable. Locate the
teslameter Burndy cable from the power rack on the back
of the console. Connect it to the Burndy connector on the
rear panel of the teslameter unit. (See Figure 12-24.)

6. Connect the IEC 625 cable. There is an IEC 625
cable connected to the front of the GSI board of the acqui-
sition server. Connect the other end to the IEC 625 con-
nector on the back of the teslameter. (See Figure 12-24.)

7. Check the IEEE 488 address. The default IEEE 488
address is seven. The DIP switches for setting the address
define a binary number. Therefore seven corresponds to
switches 1, 2 and 3 on. Switches 6 and 7 should be on for
proper communication. All other switches should be off.
The switches are rocker switches and on corresponds to
having the lower part pressed in. (See Figure 12-24.)

Figure 12-24 Rear view of the teslameter unit.
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The E 035M Teslameter
8. Configure the teslameter. Follow the instructions in
Section 4.1 to configure the teslameter.

Using the Teslameter 12.5.2
1. Define a field sweep experiment. Create a field

sweep experiment. Before you activate the teslameter,
acquire a spectrum. Center the spectrum and adjust the
parameters.

2. Open the FF-Lock/Teslameter dialog box. Click
the FF-Lock/Teslameter button in the experiment tool
bar to open the dialog box. (See Figure 12-25.)

3. Activate the teslameter. Click the Standard Control
tab. Select the Lock Resolution from the drop-down list.
We recommend that you start with low resolution e.g.
0.1 G and increase the resolution after the teslameter finds
the field. Click the Use Teslameter button to activate it.
The teslameter will start to search for the current field
position. (See Figure 12-26.)

Figure 12-25 The FF-Lock/Teslameter button.
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The E 035M Teslameter
After the teslameter finds the field position it will display
the field value in the TM Field box of the monitoring
panel. (See Figure 12-27.)

4. Acquire a spectrum. Click the Run button to start the
field sweep. 

Figure 12-26 The Standard Control folder.

Figure 12-27 Display of the TM Field.
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The E 035M Teslameter
The Standard Control Folder 12.5.3
The Standard Control folder contains the following parameters
and options:

Use Teslameter Click this button to activate (green) the teslameter. Clicking
again toggles it off.

Lock Resolution This parameter determines the precision of the field measure-
ment. The choices are 0.1, 0.01, and 0.001 G. As the precision
becomes finer, the measurement takes longer and hence requires
slower field sweeps.

Modulation The teslameter probe has modulation coils to detect the proton
NMR resonance. Depending on the polarity of the magnet or
how you installed the teslameter probe, you may have to switch
the polarity from positive to negative in order to lock the
teslameter.

Figure 12-28 The Standard Control folder.
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The Optional Control Folder 12.5.4
The Optional Control folder contains the following parameters
and options:

Field Search
Direction

Before you can measure magnetic fields with the teslameter, the
module must first find the proton resonance. In order to expedite
the search for the signal, you can specify the direction of the
search. For example, if you were originally at 3000 G and you
have changed your magnetic field to 4000, you should choose
Up as your search direction. Should you want to stop the search
for the signal, click the Stop Search button.

Field Search
Limit [G]

In order to find the proton resonance more quickly, you may nar-
row the search range. Enter appropriate values for Upper Field
Search Limit and Lower Field Search Limit. Make sure that
the search range covers the field your experiment defined and
does not exceed the cover range of the probe you use. (See
Figure 12-29.) 

Figure 12-29 The Optional Control folder.
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The E 035M Teslameter
Calibrating the Field Offset 12.5.5
The teslameter measures the field value where the teslameter
probe is located. It could be slightly different from the field that
sample experiences because they are not physically in the same
position. To correct the field value you can calibrate the teslame-
ter by setting the Calibration Offset. There are two ways to cal-
ibrate the field. You can either use a field marker or the optional
intra-cavity probe (E 035M-1009).

� Calibrate the field offset using the intra-cavity
probe. Follow the intra-cavity probe user�s manual for
installation and operation. Record the intra-cavity probe
(Bsample) and teslameter probe (Bteslameter) readings. 

� Calibrate the field offset with a field marker. Insert a
field marker sample to the cavity. Tune and match the cavity.
Calculate the field value (Bsample) by using the known g-fac-
tor of the field marker and the microwave frequency. 

 . [12-5]

Record this value as well as the field value for the g-value
standard read by the teslameter (Bteslameter). 

The Calibration Offset equals:

Calibration Offset = Bsample - Bteslameter , [12-6]

where Bsample is the field measured with the intra-cavity probe
or g-value standard and Bteslameter is the field read by the
teslameter. In the Teslameter section of the Field folder enter
the difference into the Calibration Offset. Click Apply and
close the Spectrometer Configuration dialog box.

Open the Spectrometer Configuration dialog box. 

Bsample 714.4775 �

g
---�=
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The E 035M Teslameter
If you calibrate the field offset of the field controller at the same
time and enter the difference in the Field Offset in the Spec-
trometer Configuration dialog box, you may use the center
field tool with the teslameter activated.

Troubleshooting 12.5.6
If the teslameter cannot find the field position or it keeps search-
ing for a long time the modulation may have the wrong phase.
Deactivate the teslameter by clicking the Stop Search button in
the Optional Control folder. Select Negative from the Modula-
tion drop-down list in the Standard Control folder. Press the
Use Teslameter button again.

The field values of spectra acquired with the teslameter are the
teslameter�s readings. You may have problems using the acquisi-
tion tools such as the Center Field tool or the Center Field &
Sweep Width tool. This is because the tool�s readings are those
of the teslameter�s. What is actually required by the field con-
troller to center the spectrum are the values measured by the hall
probe. To solve this problem you can either set the center field
before activating the teslameter or calibrate both the teslameter
and the Field Offset of the field controller. Refer to Chapter 5
and the previous section for the calibration process.
12-38



The ER 218PG1 Goniometer
The ER 218PG1 Goniometer 12.6
A goniometer is a necessity when the EPR signal of a sample is
orientationly dependent such as single crystals or other ordered
samples. Xepr can control the programmable goniometer from
the software. This section provides you step-by-step instructions
on how to use a Bruker programmable goniometer with the
Elexsys E 500 spectrometer.

Installing a Programmable Goniometer 12.6.1
Please refer to the Programmable Goniometer ER 218PG1
User�s Manual for how to install a goniometer. There are two
cables you must connect to the Elexsys console.

1. Connect the Slow Device Bus cable. Open the front
door of the console. Connect the Slow Device Bus con-
nector (25 pin) on the goniometer electronic box mounted
on the magnet to the SLD connector on the SIP board of
the acquisition server using a 25 pin Slow Device Bus
cable. (See Figure 12-30.)

2. Connect the power supply cable. Locate the Burndy
cable labeled Goniometer from the power rack on the
back of the console. You may have to open the back of the
console to locate the cable. Connect it to the power supply
Burndy cable of the goniometer control unit 

This unit is an optional
accessory and you may
o r  m ay  n o t  h av e
o rd er ed  i t .  I f  y o u
require an accessory,
co n t a c t  y o u r  l oc a l
Bruker EPR sales rep-
resenta tive for pur-
chase information.
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The ER 218PG1 Goniometer
Configuring the Goniometer 12.6.2
1. Define a goniometer experiment. Open the New

Experiment dialog box. Click the Goniometer button to
activate it. If you want to acquire a 2D spectra you can
select Sample angle (Goniometer) in the Abscissa 2
drop-down list. Click Create to close the dialog box. (See
Figure 12-31.)

Figure 12-30 Connecting the control cable.

SIP
board

SLD
connector
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The ER 218PG1 Goniometer
2. Open the Acquisition Parameters dialog box.
Click the Goniometer tab. (See Figure 12-32.)

Figure 12-31 Defining a goniometer experiment.

Press
Goniometer

Figure 12-32 The Goniometer folder in the Acquisition Parameter dialog box.

Initialize

Define
Zero

Set
Angle
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The ER 218PG1 Goniometer
3. Initialize the goniometer. Make sure the shaft is in
place. Click the Activate button. Click the Initialize
Goniometer button in the Goniometer folder. The soft-
ware will search for the 0 notch on the goniometer and
in i t i a l ize  tha t  po in t  as  the  �home�  po in t .  (See
Figure 12-32.) Meanwhile the angle display in the moni-
to r ing  pane l  w i l l  tu rn  f rom red  to  g reen .  (See
Figure 12-33.)

4. Define the zero angle. You can define any angle to be
the new zero, regardless of the present goniometer angle.
Click the Define Zero Angle button to set the current
sample angle as the new zero.

5. Set the angle. Enter a value in the Angle box. The goni-
ometer will turn to that angle.

Figure 12-33 The goniometer angle display.
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The ER 218PG1 Goniometer
6. Set up for a 2D experiment. If you create a 2D exper-
iment you can set the angle range and angle increment in
the Absc. 2: Angle folder. (See Figure 12-34.)

Select Each Slice Scan for Acq Fine Tuning parameter
in the Microwave folder. The acquisition software will
perform a fine tune before acquiring each slice of the 2D
spectrum. This option is particularly important because
changing the orientation of the sample with a programma-

Figure 12-34 Setup for a 2D spectra using the programmable goniometer.
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The ER 218PG1 Goniometer
ble goniometer causes the frequency and coupling to
change.

7. Example. Figure 12-35 shows an example 2D spectra of
a ruby crystal. The angle increment is 1 degree. It is dis-
played as a contour plot.

Figure 12-35 Road map of a ruby crystal using the programmable goniometer.
12-44



Wiring and Configuration 13
This chapter describes the connectors on the front panel of many
of the modules and boards in the console. It also guides you
through configuring the signal paths using the software.

Console Module Arrangement 13.1

Figure 13-1 Console module arrangement.

Optional NMR 
Teslameter

Optional Field- 
Frequency Lock

Modulation 
Amplifier

Ventilator 

Field Controller

SCT/L

Computer 
Rack

Ventilator 

ADF RSC

Microwave Bridge 
Controller

SCT-PS

HCPU

Optional 
ENDOR Unit

SCT/H
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Connectors and Indicators in a Nutshell

T

Connectors and Indicators in a Nutshell 13.2
This section lists in table format the important information about
the connectors and LED indicators of the console modules.

SCT Connectors 13.2.1

Connector Module Description Enabled Signal

SWADV SCT-PS sweep advance signal for Hall 
field controller

always TTL output

SIG. IN SCT-PS signal input for all signal chan-
nels (routed via the backplane)

Signal I/O:
Signal Input:

Internal

analog input
1 Vpp max.

50 �

EXT. MOD 
OUT

SCT/H or L modulation output signal Signal I/O:
Modulation Output:

External

analog output
0-5 Vpp sine wave

into 50 �

MOD REF SCT/H or L modulation reference signal always digital output
±5V square wave

ESR OUT SCT/H or L EPR signal after lock-in, time 
constant, and offset adjustment

always analog output
3 V full scale

LOCK OUT SCT/H or L EPR signal after lock-in, but 
before time constant and offset 

adjustment

always analog output
150 mV full scale

into 50 �

EXT. SIG. IN SCT/H or L signal input for one signal 
channel

Signal I/O:
Signal Input:

External

analog input
1 Vpp max.

50 �

EXT. TRGa SCT/H or L external experiment trigger Signal I/O:
External Trigger:

On

TTL input

able 13-1 Connector definitions and descriptions for the SCT modules.
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T

EXT. TRGb SCT/H or L external lock-in frequency Signal I/O:
External Lock In:

On

TTL input

EXT. MOD. 
IN

Mod.Amplifier external modulation input Signal I/O:
Modulation Input:

External

analog input
10 Vpp max.

RS IN Mod.Amplifier rapid scan input Rapid Scan
experiment

analog input
ramp 5 Vpp max.

RESONA-
TOR 1

Mod.Amplifier 1st resonator modulation
output

Signal I/O:
Resonator: 1

analog output
300 Vpp sine wave 

max.

RESONA-
TOR 2

Mod.Amplifier 2nd resonator modulation
output

Signal I/O:
Resonator: 2

analog output
300 Vpp sine wave 

max.

RS OUT
50 G

Mod.Amplifier 50 G rapid scan coil output Spectrometer Configurati
on: Field: RSC Coil: 50 G
& Rapid Scan experiment

analog output
30 Vpp ramp max.

RS OUT
200 G

Mod.Amplifier 200 G rapid scan coil output Spectrometer Configurati
on: Field: RSC Coil:

200 G
& Rapid Scan experiment

analog output
30 Vpp ramp max.

Connector Module Description Enabled Signal

able 13-1 Connector definitions and descriptions for the SCT modules.
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Connectors and Indicators in a Nutshell
SCT LED Indicators 13.2.2

Indicator Module Color Indication

+15 V SCT-PS green +15 V present

-15 V SCT-PS green -15 V present

+5 V SCT-PS green +5 V present

TEMP SCT-PS red temperature fault

R SCT/H or L green transputer software loaded

A SCT/H or L green unit is acquiring spectra

Q SCT/H or L green quadrature detection

E SCT/H or L red transputer error

O SCT/H or L red AC overflow

M SCT/H or L red modulation overload

Table 13-2 Indicator definitions and descriptions for the SCT modules.
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Connectors and Indicators in a Nutshell
HCPU Hall Field Controller LED Indicators 13.2.3

Green LED Red LED Indication

off off ER032T is not initialized.

on off ER032T is operating correctly.

on on An input error has occurred. The red LED remains active until the error is 
cleared by a correct entry. Both LEDs also remain active after booting if no 
calibration file has been read. The calibration file is read after you have con-
nected to the instrument.

off on Software has crashed. Rebooting is required.

on blinking A field regulation fault has occurred. The ER032T cannot attain the desired 
field value.

blinking off A temperature regulation fault has occurred. This occurs momentarily dur-
ing a normal booting process.

blinking blinking Both field and temperature regulation faults have occurred.

blinking on Both an input error and temperature regulation fault have occurred. The 
input error indicator (red LED on) will overwrite a field regulation fault 
indicator (red LED blinking).

Table 13-3 Indicator definitions and descriptions for the Hall field controller
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Connectors and Indicators in a Nutshell
Transputer Connectors 13.2.4
Each module contains one input and two output connectors. In
order for a unit to work, it must have at least one cable con-
nected to the input. The output connectors are used for buffering
and fanning out the transputer signals to other units. The chain
of cables starts at the OUT connectors of the Transputer board
next to the Acquisition Server. The black end of the Transputer
cable connects to OUT and the red end connects to IN.

IN The input connector. This is the input connector for the
transputer cable.

OUT1 & OUT2 The output connectors. These are the output connectors for
transfer of transputer communications to other units.

Figure 13-2 The ACPU (Acquisition CPU) rack.

ACPU
Board

Transputer
Connectors
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Connectors and Indicators in a Nutshell
A typical  t ransputer  cable configurat ion is  shown in
Figure 13-4.

Figure 13-3 The Transputer connectors of the HCPU
board.

Figure 13-4 Transputer cable configuration for an E 500
spectrometer.

Transputer
Connectors
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SCT-PS
SCT-PS 13.3
The SCT-PS signal channel power supply module has one
input, one output, and four LED indicators for the voltages
required by the signal channel modules.

SCT-PS Connectors 13.3.1
SWADV The sweep advance output. This TTL signal synchronizes

the digitization of the EPR signal with the magnetic field sweep.
The signal first goes from the SCT-PS board to the RSC rapid
scan board and then further on to this connector on the Hall field
controller. These connections are seldom changed.

SIG. IN The signal input. The signal from the bridge supplied to this
connector is distributed through the back plane of the rack to the
individual signal channel modules. 

Figure 13-5 The SCT-PS (signal channel power supply)
module.

+15 V
-15 V

+5 V
TEMP

SWADV
SIG. IN
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SCT-PS
SCT-PS Indicators 13.3.2
+15 V The +15 V indicator. Normally this indicator is green, mean-

ing +15 volts is supplied to the signal channel.

-15 V The -15 V indicator. When this indicator is green, -15 volts is
supplied to the signal channel.

+5 V The +5 V indicator. When this indicator is green, +5 volts is
supplied to the signal channel.

TEMP The temperature fault indicator. Under normal conditions
this indicator is off. If this indicator turns to red a temperature
fault exists. The console may be overheated. Check if the fans
on the back panel are on. Check the filters of the ventilator units
and clean them if they are dirty. If all else fails, contact your
local Bruker EPR service representative for help.
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SCT
SCT 13.4
There are two types: the high frequency signal channel (SCT/H)
and the low frequency signal channel (SCT/L). The connectors
and indicators arrangements are identical in both. 

SCT Connectors 13.4.1
EXT. MOD. OUT The external modulation output connector. This connec-

tor provides an analog modulation output signal. It is a 0-5 Vpp
sine wave into 50 �. To activate the output, select External for
Parameters > Signal Channel > Signal I/O > Modulation
Output.

MOD. REF. The modulation reference output connector. This con-
nector provides a digital modulation reference output. It is a

Figure 13-6 The signal channel module.

 MOD REF

EXT. MOD OUT 

Indicators
 ESR OUT

LOCK OUT

 EXT. TRG

EXT. SIG. IN
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SCT
±5 V square wave signal with a frequency equal to the modula-
tion frequency. It is always enabled.

ESR OUT The EPR signal output connector. This is an analog EPR
signal output. Full scale corresponds to 3 V into 50 �. The signal
is obtained after the lock-in amplifier, time constant filter, and
DC offset adjustment and just before the digitizer. It is always
enabled.

LOCK OUT The unfiltered EPR output connector. This is also an ana-
log EPR signal output. Full scale corresponds to 150 mV into
50 �. LOCK OUT differs from ESR OUT in that the signal is
obtained after the lock-in amplifier but before the time constant
filter and the DC offset adjustment. It is always enabled. It is
most often used in double modulation experiments.

EXT. SIG. IN The external signal input connector. Normally, the signal
channel obtains its signal from the SIG. IN connector of the
SCT-PS via the back plane of the rack. This connector is
designed for external signal input into individual signal chan-
nels. It accepts a 1 Vpp maximum analog signal and the imped-
ance is 50 ohm. To enable external signal input, select External
for Parameters > Signal Channel > Signal I/O > Signal
Input.

EXT. TRG The external trigger input connector. The signal applied
to this connector can perform two different and mutually exclu-
sive functions. The first function of the connector is as an exter-
nal trigger input to start an acquisition. It requires a TTL level
signal (> 2V) to trigger the acquisition. To enable the external
trigger function, click the External Trigger button (until it is
green or active) in Parameters > Signal Channel > Signal
I/O.

The second function for this input is as an external modulation
reference for demodulating the EPR signal. It requires a TTL
level square wave signal (> 2V) with the same frequency as the
Elexsys E 500 User�s Manual: Advanced Operations 13-11



SCT
modulation frequency. To enable the external modulation refer-
ence function, click the External Lock In button (until it is
green or active) in Parameters > Signal Channel > Signal
I/O.

Transputer
Connectors

See Section 13.2.4.

SCT Indicators 13.4.2
R The ready LED. The LED blinks when the transputer software

is loading. It remains a steady green when the signal channel is
ready for acquiring a signal. If this led is not on after you turn on
the console there may be a problem with booting the signal
channel transputer.

A The acquisition LED. When an acquisition with this signal
channel is in progress, this LED is lit.

Q The quadrature LED. When a quadrature detection acquisi-
tion is in progress, this LED is lit, indicating that two signal
channels are acquiring in parallel.

E The error LED. It indicates a transputer error when lit. 

O The overload LED. This indicator lights when there is an AC
overflow. Turn down the receiver gain, microwave power, or
reduce the AFC gain if this occurs.

M The modulation overload LED. This indicator lights when
the modulation amplifier is overdriven. Turn down the modula-
tion amplitude if this occurs.
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Modulation Amplifier
Modulation Amplifier 13.5
The Modulation Amplifier module has two SMB input connec-
tors and four twin-ax output connectors.

Modulation Amplifier Connectors 13.5.1
EXT. MOD. IN The external modulation input connector. This connector

is for input of an external (i.e. not from either signal channel)
modulation signal. It accepts an analog input with up to 10 Vpp.
In order to enable external modulation (and disable internal
modulation), select External for Parameters > Signal Chan-
nel > Signal I/O > Modulation Input.

Figure 13-7 The Modulation Amplifier.

EXT. MOD. IN

RS IN

RESONATOR 1

RESONATOR 2

RS OUT 50 G

RS OUT 200 G
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Modulation Amplifier
RS IN The rapid scan input connector. This connector is for input
of the rapid scan ramp. It accepts an analog input of a maximum
5 volt ramp. It is enabled whenever a rapid scan experiment is
active. The RSC cable is normally attached to this connector.

RESONATOR 1 The first modulation output connector. This connector
provides the modulation output for the first resonator. It is an
analog sine wave output supplying up to 300 Vpp. It is activated
by selecting 1 for Parameters > Signal Channel > Signal I/O
> Resonator.

RESONATOR 2 The second modulation output connector. This connec-
tor is similar to RESONATOR 1 except it is for RESONATOR
2 and is used for the second set of modulation coils for the
ER 4114DR dual resonator. The two outputs cannot be used
simultaneously. To enable RESONATOR 2, select 2 for
Parameters > Signal Channel > Signal I/O > Resonator. 

RS OUT 50 G The 50 G rapid scan output connector. This is the rapid
scan ramp output for the 50 G rapid scan coil. It supplies an ana-
log ramp output with up to 30 Vpp. To activate it, create a rapid
scan experiment and select 50 G for Acquisition > Spectrome-
ter Configuration > Field > RSC Coil.

RS OUT 200 G The 200 G rapid scan output connector. This is the rapid
scan ramp output for the 200 G rapid scan coil. It supplies an
analog ramp output with up to 30 Vpp. To activate it, create a
rapid scan experiment and select 200 G for Acquisition >
Spectrometer Configuration > Field > RSC Coil.
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HCPU
HCPU 13.6
The HCPU Hall controller power unit has two LEDs, the
SWADV connector, and three transputer connectors.

HCPU Indicators 13.6.1
Green & Red LED The status indicator LEDs. The meaning of the green and

red LEDs is somewhat complicated. Refer to Table 13-3 for
complete definitions.

HCPU Connectors 13.6.2
SWADV The sweep address advance input. This TTL signal syn-

chronizes the digitization of the EPR signal with the magnetic
field sweep. The signal first goes from the SCT-PS board to the

Figure 13-8 The HCPU.

Red LED

SWADV

Green LED

Transputer
Connectors
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HCPU
RSC rapid scan board and then further on to this connector on
the Hall field controller. These connections are seldom changed.

Transputer
Connectors

See Section 13.2.4.
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ADF
ADF 13.7
The ADF is a fast digitizer board. It has three LED indicators
and three connectors.

ADF Indicators 13.7.1
READY The ready LED. This green LED indicates that the ADF board

is ready. When the console is turned on this LED should be lit.

Figure 13-9 The ADF board.
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ADF
T The external trigger LED. When this yellow LED is on it
indicates that the ADF is using an external trigger. 

C The converting LED. This indicates that the ADF is digitizing
data.

ADF Connectors 13.7.2
CLK OUT The clock out connector. This connector supplies the TTL

clock signal from the ADF. 

AUX The auxiliary connector. This is a 25 pin connector. The pin
out is shown in Figure 13-10. Most of the pins are specifically
reserved for spectrometer operation and are not available for
general use. The pins available to users are highlighted in
Figure 13-10. The most important is pin 5, the external trigger
input. There is a cable labeled TRIGGER connected to this pin.
You can use it to externally trigger the ADF with a TTL level
pulse. To enable the external trigger, select External Sweep for
Parameters > Fast Digitizer > Trigger Mode. In the Trigger
Slope drop-down menu in the same menu, you must also select
whether the rising or falling edge triggers the acquisition. If your
spectrometer is equipped with an optional ENDOR unit, the
Trigger cable should be connected to the T connector of the EIF
board.
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ADF
AI The analog input connector. The AI connector has two dif-
ferential input pairs for the signal to be digitized. The first pair is
reserved for digitizing the EPR signal. It connects to the ESR
OUT connector of the signal channel in the standard configura-
tion. It is referred to as Channel A. The second pair can be used
to digitize other signals. There is a cable connected to the second
channel (Channel B) labeled as ADF ENDOR. If you have an

Figure 13-10 The ADF board AUX connector pin layout.

1 PP 0 (in/out)

2 PP 2 (in/out)

3 ADV (out)

4 BUSY (out)

5 EXTRG (in)5 EXTRG (in)

6 MODOUT (out)

7 PP 3 (in/out)

8 PP 4 (in/out)

9 nc

10 nc

11 nc

12 nc

13 SWEND (out)

PP 1 (in/out) 14

GND 15GND 15

GND 16GND 16

GND 17GND 17

GND 18GND 18

GND 19GND 19

+5 Volt (fused/out) 20+5 Volt (fused/out) 20

+5 Volt (fused/out) 21+5 Volt (fused/out) 21

PP 5 (in/out) 22

PP 6 (in/out) 23

PP 7 (in/out) 24

ACK (in) 25
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ADF
optional ENDOR unit, it is connected to the ADF connector of
the DICE box. The center conductor is the non-inverting input
and the shield is the inverting input. The impedance of the inputs
is 200 �. The voltage range is ±2.5 V full scale. For a pin-out see
Figure 13-11. 

There are options for digitizing either Channel A or B or both
channels. For a rapid field scan experiment, select A, B or A&B
for Parameters > Field > Rapid Scan Options > Input
Mode. For a rapid time sweep, select the appropriate values for
Parameters > Fast Digitizer > Input Mode.

Figure 13-11 The ADF board AI connector pin layout.

1 +15 Volt (fused)

2 Analog inp. 2 (noninv.)

3 GND

4 Analog inp. 1 (noninv.)

5 Analog inp. 1 (inv.)

-15 Volt (fused) 6

Analog inp. 2 (inv.) 7

GND 8

GND 9
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RSC 13.8
The RSC (Rapid Scan Controller) board is essentially a pro-
grammable ramp generator. It supplies the signal that is ampli-
fied by the modulation amplifier. This board is used in
conjunction with the ADF board to acquire field sweep signals
rapidly. It has four indicators and seven connectors.

RSC Indicators 13.8.1
READY The ready LED. This LED is the ready indicator for the RSC

board. It is lit after the first time you initiate the rapid scan func-
tion.

S The sweep LED. This LED indicates a rapid field sweep is
active.

T The trigger LED. This LED indicates the RSC board is ready
for a trigger.

M The modulation overload LED. This LED indicates that the
modulation amplifier (that supplies the current to the rapid scan
coils) is overloaded.

RSC Connectors 13.8.2
RSC The rapid scan output. This is the rapid scan voltage output.

It is an analog signal ranging ± 1 V into 50 � and drives the
modulation amplifier through its RS connector. 

10 MHz The external clock input. This connector allows you to input
an external 10 MHz TTL external clock signal.

ZPH The zero phase output. This connector supplies a 50 �s neg-
ative TTL pulse upon the start of the rapid scan ramp	�This pulse
is useful for synchronizing other events with the sweep.
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RSC
MOD IN The modulation input. An external modulation signal sup-
plied here simply goes out the MOD OUT connector.

MOD OUT The modulation output. The signal supplied to the MOD IN
connector comes out of this connector.

TRG The trigger input. The RSC board can be triggered by an
external signal (generated by an external event such as a laser
pulse) applied to this input. The board is triggered by the falling
edge of a TTL level signal. (Note that this can be inverted by
using jumper J8 on the RSC board.)

I/O The input/output connector. This connector is reserved for
use by Bruker.
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RSC
Figure 13-12 The RSC board.
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Experiment Setup 14
A standard Bruker Elexsys EPR spectrometer is equipped with a
high frequency signal channel (6-100 kHz), low frequency sig-
nal channel (100-10,000 Hz), and rapid digitizer (ADF) for per-
forming routine field/time scan experiments. By rerouting the
signal paths using the inputs and outputs of the front panels of
the modules and selecting options in the software, many custom
experiments such as double modulation can be implemented.
The previous chapter describes the connections, indicators, and
parameters available to you for configuring your experiments.
This chapter presents how to set up the experiments. Standard
Experiments describes configuring experiments that do not
require any wiring changes or extra components. Custom Exper-
iments describes experiments that need extra wiring or devices.
Figure 14-1 shows the symbols and figure legends used in this
chapter.

Figure 14-1 A key to the symbol and figure legends.

Standard internal wiring (via backplane)

Standard external wiring (via cable)

Extra cable connections for special
Experiments

Trigger (rising edge)

Trigger (falling edge)
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Standard Experiments
Standard Experiments 14.1

Field or Time Sweeps with the Signal Channel 14.1.1

These are the most basic CW EPR experiments. The Elexsys
E 500 User�s Manual: Basic Operations gives a complete
description of these experiments. All connections either through
internal back connections or through external cables are standard
and ready for use in the default configuration of the spectrome-
ter. Remember, if you use an ER 4105DR double resonator, you
need to connect both the Resonator 1 and Resonator 2 cables
from the Modulation Amplifier unit to the double resonator.

For modulation frequencies between 100 and 6 kHz, the SCT/H
(high frequency) signal channel is automatically selected by the
software. If you choose a modulation frequency between 6 kHz
and 100 Hz, the SCT/L (low frequency) signal channel is auto-
matically selected.

Figure 14-2 Configuration for field or time sweeps with the SCT/H or SCT/L sig-
nal channels.

From
Bridge

To
Field Controller
(via ADF) To Modulation Coil

Or
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Standard Experiments
Field or Time Sweeps with the Fast Digitizer (ADF) 14.1.2
When the acquisition is shorter than 5 seconds, you should use
the fast digitizer (ADF) to acquire a field or time scan instead of
the signal channel digitizer. A complete description of this
experiment is given in Section 6.1 of this manual. All connec-
tions either through internal back connections or through exter-
nal cables are standard and ready for use in the default
configuration of the spectrometer.

Figure 14-3 Configuration for field or time sweeps with the ADF.
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Rapid Field Scans with the Fast Digitizer (ADF) 14.1.3
The combination of the ADF (fast digitizer) and RSC (Rapid
Scan Controller) with rapid sweep coils provides a tool to
acquire spectra of short lived species. A complete description of
this experiment is given in Section 6.2 of this manual. All con-
nections either through internal back connections or through
external cables are standard and ready for use in the default con-
figuration of the spectrometer.

Figure 14-4 Configuration for rapid field scans with the ADF.
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Custom Experiments 14.2
This section provides instructions on configuring custom experi-
ments. You need to attach external cable(s), have special
optional Bruker equipment, or supply your own external equip-
ment to set these experiments up.

Quadrature Detection 14.2.1
Quadrature detection simply means acquiring both the in-phase
and phase-quadrature components of the field modulated EPR
signal. This detection scheme proves very useful in satura-
tion-transfer experiments. The acquisition requires two signal
channels with a 90° mutual phase difference to acquire the EPR
signal. Most consoles are delivered with one SCT/H (high fre-
quency) and one SCT/L (low frequency) signal channel. In
order to perform this experiment, you must purchase a second
SCT/H (or SCT/L) signal channel.

Figure 14-5 Configuration for quadrature detection.
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It is assumed that you have already created a standard field or
time sweep experiment.

1. Install the second signal channel. Turn off the spec-
trometer. Install a second SCT/H (high frequency) signal
channel, B, next to the SCT/L (low frequency) signal
channel. Connect a transputer cable from OUT2 of signal
channel A to IN on signal channel B. (See Figure 14-5.)
Turn on the console and connect the workstation to the
spectrometer.

2. Set up for quadrature detection. Open the Parame-
ter dialog box and select the Signal Channel folder.
Click the Detection tab and press the Quadrature
Detection button. (See Figure 14-6.) Press the Activate
button.

These instructions are
for modulation frequen-
cies greater than 6 kHz.
For lower frequencies,
s imp ly  subs t i t u t e
SCT/L for SCT/H.
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Figure 14-6 The Quadrature Detection button.
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3. Check the phase of signal channel A. Although the
phase of the signal channel A has been calibrated during
the signal channel calibration it still could be a few
degrees off. Moving a modulation cable can produce
phase shifts of a few degrees. Use a strong sample such as
DPPH to check the phase. Change the Modulation
Phase from 0° to 90° in the Signal Channel Detection
folder. Adjust the Modulation Phase to minimize the
signal. It is convenient to monitor the signal with the
Setup Scan feature. When the signal is minimized, shift
the Modulation Phase by -90° to maximize the signal.

Pressing the <Ctrl> key
and clicking the up or
d o wn  a r ro w k e y
changes the phase by
90°.
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Figure 14-7 Calibrating the phase of signal channel A.
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4. Calibrate the phase of signal channel B. The phase
of the two signal channels might be slightly different.
Therefore the phase difference may not be exactly 90°
when you set the Quad Detection Phase to 90°. To cali-
brate the difference, set the Quad Detection Phase to
90°. Check if the signal from signal channel B is mini-
mized. Adjust the Quad Detection Phase until the sig-
nal from signal channel B is minimized. Using the Setup
Scan function helps you to interactively optimize the
phase. You need to select A&B in the Setup Scan SCT
drop-down list to view signals from both signal channels
simultaneously.

When you calibrate the
phase difference, use
low microwave power
to avoid saturating the
EPR signal.
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Figure 14-8 Calibrating the phase of signal channel B.
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5. Acquire a quadrature spectrum. Click the Run but-
ton to acquire a quadrature spectrum. The Q LED indica-
tors on both signal channels should light up.

6. View the signals from both channels. The resultant
spectrum is complex in which the real part is the signal
detected by the signal channel A and the imaginary part is
the signal detected by the signal channel B. Click the
Re/Im button in the Tool bar to display the two signals
respectively. (See Figure 14-9.)

Figure 14-9 Viewing the signals from both signal channels.
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Externally Triggered Sweeps with the Signal Channel 14.2.2
If you need to synchronize an external event such as a lamp flash
with your EPR acquisition, you can trigger the acquisition exter-
nally. This section describes how to trigger a field or time sweep
using the signal channel. It is assumed that you have already cre-
ated a standard field or time sweep experiment.

1. Provide an external trigger. Connect an external
cable carrying a TTL (5 volt) positive-going trigger pulse
to the EXT. TRIG connector of the signal channel. Take
care about the impedance, i.e. make sure the trigger volt-
age is high enough after the cable is connected. Also note
that the acquisition is triggered by a rising slope. 

2. Enable the external trigger in the software. Open
the Parameter dialog box and click the Signal Channel
tab. Click the Signal I/O tab and then the External Trig-
ger button to activate it (green).

Figure 14-10 Configuration for externally triggered sweeps with the signal channel.
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3. Acquire a spectrum. After clicking the Run button,
the spectrometer waits for the external trigger to start the
acquisition.

Figure 14-11 Enabling the External Trigger.
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Externally Triggered Sweeps with the ADF 14.2.3
You can also use the ADF for externally triggered acquisitions.
It is assumed that you have already created a field or time sweep
experiment with Fast Digitizer as the Ordinate as described in
Section 6.1.

1. Provide an external trigger for the ADF. Connect a
TTL (5 volt) trigger pulse to the cable labeled Ext. Trig-
ger from the AUX connector of the ADF board. Take care
about the impedance, i.e. make sure the trigger voltage is
high enough after the cable is connected. 

Figure 14-12 Configuration for externally triggered sweeps with the ADF.

Field Controller
ADF

To Modulation CoilsFrom
Bridge

CH A

TTLor

AUX

AI

SWADV
Elexsys E 500 User�s Manual: Advanced Operations 14-15



Custom Experiments
2. Enable the External Trigger. Open the Parameter
dialog box and click the Fast Digitizer folder. Select
External Sweep or External Point from the Trigger
Mode drop-down list. (See Figure 14-13.)

3. Define the Trigger Slope. In the Fast Digitizer folder,
select Rising  or Falling  from the Trigger Slope
drop-down list. (See Figure 14-13.) Either the rising or
falling edge can be used to trigger the acquisition. 

4. Acquire a spectrum. After clicking the Run button,
the spectrometer waits for the external trigger to start the
acquisition.

Figure 14-13 Defining the external trigger.
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Externally Triggered Rapid Field Sweeps 14.2.4
You can use an external trigger to start a rapid field sweep using
the ADF and RSC. It is assumed that you have already created a
rapid field sweep experiment as described in Section 6.2. 

1. Provide an external trigger. Connect an external
cable carrying a TTL (5 volt) positive-going trigger pulse
to  the  TRG  connec tor  of  the  RSC  board .  (See
Figure 14-14.) Take care about the impedance, i.e. make
sure the trigger voltage is high enough after the cable is
connected. 

Figure 14-14 Configuration for externally triggered rapid field sweeps.
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2. Enable the External Trigger for the RSC. Open the
Parameter dialog box and click the Absc. 1: Field
folder. Select External from the RSC Trigger Mode
drop-down list. (See Figure 14-15

3. Acquire a spectrum. After clicking the Run button,
the spectrometer waits for the external trigger to start the
acquisition.

Figure 14-15 Enabling the RSC Trigger Mode.
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External Field Modulation 14.2.5
The Bruker Elexsys spectrometer provides a high frequency sig-
nal channel and a low frequency signal channel. They cover a
frequency range from 100 kHz to 100 Hz modulation frequency.
However if you want to use your own field modulation, you can
do so by connecting your modulation source (e.g. a function
generator) to the console. It is assumed that you have already
created a standard field or time sweep experiment. 

1. Cable connections. Connect the output from the func-
tion generator to EXT. MOD. IN on the Modulation
Amplifier board and EXT. TRIG on the signal channel.
You may need a phase shifter to adjust the modulation
phase. 

Connect the cable to
EXT.TRIG on  th e
SCT/L signal channel if
the frequency is less
than 6 kHz.

Figure 14-16 Configuration for external field modulation.
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2. Enable external modulation. Open the Parameter
dialog box and click the Signal I/O tab of the Signal
Channel folder. (See Figure 14-17.) Select External
from the Modulation Input drop-down list. Click Exter-
nal Lock In to activate it (green). You must change the
modulation phase by using an external phase shifter. The
Ext. Lock In Delay does not change the phase in this case
as it does for double modulation. 

3. Acquire a spectrum. Click the Run button.

If you use a modulation
frequency lower than
6 kHz, select a modula-
tion frequency lower
t h a n  6  k Hz  i n  t h e
Detection folder. This
forces the software to
use the SCT/L (low fre-
quency) signal channel.

Figure 14-17 Parameter setup for external modulation.
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Other Forms of Modulation 14.2.6
Field modulation is not the only means to detect your EPR sig-
nal. For example, you can use a light chopper to modulate the
sample illumination and thereby selectively detect the EPR sig-
nals from transient species. It is assumed that you have already
created a standard field or time sweep experiment.

1. Connect the modulation source to the console.
Most light choppers supply a train of TTL pulses synchro-
nized with the light chopping. Other modulation devices
also often have a TTL synchronization signal. Connect a
cable from the modulation device to the EXT. TRIG of
the low frequency signal channel (SCT/L) to supply a ref-
erence signal.

This section describes a
low frequency (<6 kHz)
experiment. For higher
frequencies, simply sub-
s t i t u t e  SCT/H  f o r
SCT/L and enter a mod-
ulation frequency of
100 kHz in the Detec-
tion folder.

Figure 14-18 Configuration for external modulation using the SCT/L signal channel.
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2. Enable external modulation. Open the Parameter
dialog box and click the Signal I/O tab of the Signal
Channel folder. (See Figure 14-19.) Click External
Lock In to activate it (green). You must change the modu-
lation phase by using an external phase shifter. The Ext.
Lock In Delay does not change the phase in this case. 

Figure 14-19 Parameter setup for the optical modulation.
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3. Set more parameters. Since this is a low frequency
modulation experiment, we recommend deactivating (not
green) the High Pass Filter button and selecting the
Lock In Integrator option to reduce the noise. (See
Figure 14-19.) Make sure you enter a modulation fre-
quency value below 6 kHz in the Modulation Frequency
of the Detection folder. This forces the acquisition soft-
ware to use the low frequency signal channel.

4. Acquire a spectrum. Click the Run button.
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Sweeps with Double Modulation 14.2.7
Because light choppers are limited to low modulation frequen-
cies, high frequency (100 kHz) field modulation is often used
together with light chopping to improve the sensitivity. The field
modulated signal is first demodulated by the SCT/H high fre-
quency signal channel. The unfiltered (i.e. before the time con-
stant filter) output signal is fed into the SCT/L low frequency
signal channel where the light-chopped signal is demodulated. It
is assumed that you have already created a standard field or time
sweep experiment.

1. Connect the signal cable to the SCT/H signal
channel. Disconnect the signal cable connected to Sig.
In of the SCT-PS board. Connect it to EXT. SIG. IN of
the high frequency signal channel (SCT/H). (See
Figure 14-20.)

Figure 14-20 Configuration for double modulation (field and optical) experiments.
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2. Connect LOCK OUT to EXT. SIG. IN. Connect LOCK
OUT of the high frequency signal channel (SCT/H) to
EXT. SIG. IN of the low frequency signal channel
(SCT/L) with an external cable. (See Figure 14-20.)

3. Connect EXT. MOD OUT to EXT MOD. IN. Connect
EXT. MOD OUT of the high frequency signal channel
(SCT/H) to EXT. MOD. IN of the Modulation Amplifier
with an external cable. (See Figure 14-20.)

4. Provide a TTL reference to EXT. TRIG. Connect the
cable carrying the pulses from the light chopper or other
low frequency modulation supplier to EXT. TRIG of the
l o w  f r e q u e n c y  s i g n a l  c h a n n e l  (SCT/L ) .  ( S e e
Figure 14-20.)
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5. Enable Double Modulation. Open the Parameter
dialog box and click the Signal Channel folder. Click the
Double Modulation tab. Activate (green) Double Modu-
lation. Select Second in the Detecting SCT drop-down
list. Select First in the Field Modulation SCT drop-down
list. You may need to reduce Receiver Gain values for
both signal channels. Note that the Time Constant in this
folder controls the time constant for the low frequency
(Detecting SCT) signal channel. (See Figure 14-21.)

Figure 14-21 Enabling Double Modulation.
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6. Set up the Signal I/O. Click the Signal I/O tab. Select
External for Signal Input, Modulation Input, and Mod-
ulation Output. (See Figure 14-22.)

Figure 14-22 Enabling external inputs and outputs in Signal I/O.
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7. Configure Double Mod. Signal I/O. Click the Dou-
ble Mod. Signal I/O tab. Select External for Signal
Input. You may need to activate the High Pass Filter and
the Lock In Integrator to reduce the noise. Click Exter-
nal Lock In to activate it (green). (See Figure 14-23.)

Figure 14-23 Configuring Double Mod. Signal I/O.
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8. Adjust the low frequency modulation phase. You
can adjust the phase of the low frequency modulation.
Convert the phase value in degrees you want to adjust to
delay time (in �s) based on the following formula:

[14-1]

Enter the value in the Ext. Lock In Delay box. (See
Figure 14-23.)

9. Acquire a spectrum. Click the Run button.

Delay(�s) Phase 1000�

360 Modulation Frequency(kHz)�
----------------------------------------------------------------------------------=
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Triggered Quadrature Detection with the ADF 14.2.8
We described quadrature detection with two signal channels in
Section 14.2.1. We can also perform this experiment with the
fast digitizer (ADF) instead of the signal channel digitizer. First
follow the instructions in Section 14.2.1. It is assumed that you
have already created a field or time sweep experiment with Fast
Digitizer as the Ordinate. 

Figure 14-24 Configuration for triggered sweeps with quadrature detection using the
ADF.
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1. Cable connections. Connect the two ESR OUT sig-
nals from the two identical signal channels to Channel A
and Channel B of the AI connectors on the ADF board.
(See Section 13.7.2 for the pin lay out of the AI connector
of the ADF board.) You can use the cable labeled ADF
ENDOR on the AI connector as Channel B. You also need
to send a TTL trigger pulse to the cable labeled Ext. Trig-
ger from the AUX connector on the ADF board. (See
Figure 14-24.)

2. Set up the parameters. Open the Parameter dialog
box and click the Fast Digitizer tab. Select External
Sweep  or  External Point  in the Trigger Mode
drop-down list. Select the appropriate Trigger Slope for
your trigger pulse. Select A&B in the Input Mode. (See
Figure 14-25.) The signal from the Channel A is stored as
the real part of the spectrum while the signal from Chan-
nel B is stored as the imaginary part of the spectrum. You
can view each of them by clicking the Re/Im button in the
Tool bar.

3. Acquire a spectrum. Click the Run button.

Figure 14-25 Setting up the ADF for quadrature detection.
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Transient Quadrature Signal Capture with the ADF 14.2.9
You may need to digitize transient signals that are not detected
by the signal channels. An example of such a direct-detected sig-
nal would be the quadrature signals from a transient bridge.
Connect the two transient signal outputs, e.g. I and Q to Chan-
nel A and Channel B of the AI connector of the ADF board
respectively. You can use the cables labeled SCT and ADF
ENDOR. Send a TTL trigger pulse to the external trigger of the
AUX connector of the ADF board. The parameter settings are
similar to those in the previous section.

Figure 14-26 Configuration for transient quadrature signal capture using the ADF.
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Externally Controlled Field Sweep with the ADF 14.2.10
If you have your own field sweep device you can direct the field
sweep pulses to the external trigger input of the AUX connector
on the ADF board and the SWADV (sweep address advance) on
the field controller board.

You must enable external point triggering and define the slope in
the digitizer parameter menu. Table 14-1 shows the sweep

Figure 14-27 Externally controlled field sweeps using the ADF.
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address advances per pulse (field advances on the negative edge
of the trigger).

X-resolution steps/pulse

512 8

1024 4

2048 2

4096 1

8192 1/2

Table 14-1 Sweep address advances per pulse
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Xepr Under SGI IRIX 15
Bruker delivers either SGI O2 or Linux workstations for the user
interface of the Elexsys series EPR spectrometers. This chapter
describes various system administration issues related to the
Xepr program for the SGI O2 workstation. The names or terms
described in this chapter may differ slightly for the Linux sys-
tem, but the principles are the same. Refer to Chapter 16 for
details if you have a Linux workstation
Most of the commands and operations in this chapter require
root or super user privileges. In addition, the commands also
require at least some basic knowledge of the UNIX operating
system. This chapter assumes that you already are familiar with
general administration of the UNIX operating system. Be cau-
tious when making changes to the workstation configuration:
some mistakes can lead to an unusable workstation. Consult
your local Bruker EPR service representative if you are unsure
of the changes you are making.

General Information 15.1
The SGI O2 workstation comes with two Ethernet cards and the
IRIX 6.5 UNIX operating system. IRIX 6.3 is no longer sup-
ported, although Xepr still functions under 6.3. 

If you wish to check the hardware inventory (system ID, RAM,
CPU, IP address, etc.) for your workstation, use the shell com-
mand hinv. If you prefer to use a GUI (Graphical User Interface)
tool, select Toolchest > System > System Manager > About
This System to check the hardware inventory.
The system as delivered by Bruker has two visible accounts: the
root account with the password xepr@sgi and the xuser
account with the password user@xepr. For your security,
change the root password immediately after the system has been
installed.

Most of the Xepr files reside in the /usr/xepr folder. 
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Network Settings 15.2

ec0 and ec1 15.2.1
The two Ethernet cards in the workstation are labeled ec0 and
ec1. ec0 is used for connecting to the outside world and is con-
figured as the primary interface. ec1 is devoted to communica-
tions between the workstation and the acquisition server (OS9)
of the spectrometer and is configured as the secondary interface.
When the workstation is delivered, the hostname and IP address
of ec0 are set to default values. You need to ask your local net-
work administrator to assign a hostname and an IP address for
your workstation. Change the hostname and IP address of ec0
only. Never change the hostname and IP address of ec1. 

NFS (Network File System) 15.2.2
Xepr uses NFS to transfer files between the UNIX workstation
and the acquisition server. Never turn off or deactivate NFS.

UNS (Unified Name Service) 15.2.3
UNS allows you to use easily remembered host names instead of
easily forgotten IP addresses. The most common services are
files, DNS (Domain Name Service), and NIS (Network Infor-
mation Service).

Files This is the most controllable way to provide network informa-
tion. Entries in the /etc/hosts file connect an IP address with a
corresponding host name. You can simply edit this file to define
the names and IP addresses of the computers in your local net-
work as well as on the Internet. The hosts file must contain the
local host.

Never change ec1 to
primary.
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Network Settings
The format is:

IP address hostname.subdomain.domain hostname
127.0.0.1 localhost

123.123.123 Elexsys.university.edu Elexsys

192.168.99.1 Xepr

192.168.99.5 E500

DNS Your local network usually has one or more DNS servers. You
can get the IP addresses of the DNS servers from your local net-
work administrator.

NIS Although NIS offers many benefits, the complexity and integra-
tion with other products can lead to problems. Do not activate or
use NIS on the EPR workstation.

To configure UNS, you can either modify the /etc/nss-
witch.conf file or select Toolchest > System > System Man-
ager > Networking and Connectivity > Modify Networking
Settings. We recommend the following configuration: 

files none none

If you really need to use a DNS server, you can configure it as
follows:

files DNS none

Routing 15.2.4
Although the EPR workstation has two Ethernet cards and is
able to function as a router, doing so will jeopardize the commu-
nication between the workstation and the EPR acquisition
server. Modification of the routing table could also direct net-
work traffic to ec1, which would slow down the response of the
Xepr program or even cause the system to hang up.
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UNIX Workstation Configuration 15.3

Flags 15.3.1
Flags are used to activate and deactivate various services that the
workstation can offer. Here is the standard configuration for an
SGI IRIX workstation as delivered by Bruker. You can check the
configuration by entering chkconfig in a UNIX shell. The net-
work and nfs services must be on to allow the workstation to
communicate with the acquisition server properly. Although you
can turn on more services than the basic configuration, keep in
mind that the more services you turn on, especially network
related services, the slower the workstation responds.

Flag Status Flag Status

appletalk off privileges on

 array off proclaim_relayagent off

autoconfig_ipaddress off proclaim_server off

autofs on proxymngr off

automount off rarpd off

bsdlpr on routed off

desktop on rsvpd off

fontserver off rtmond on

gated off rwhod off

ipaliases on sar off

isdnd off savecore on

lockd on sdpd on

Table 15-1 Standard configuration for workstation services.
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To turn a flag on or off, type 

chkconfig <flag> <on|off>

where <flag> is the service you want to turn on or off followed
by either on or off. Rebooting the Unix workstation is the easiest
way to ensure the newly selected service is properly started.

lp on sendmail on

mediad on snetd on

mrouted off soundscheme on

named off timed on

nds off timeslave off

network on verbose on

netwr_client off visuallogin on

nfs on vswap on

noiconlogin off webface off

nostickytmp off windowsystem on

ns_admin off xdm on

ns_fasttrack on yp off

nsd on ypmaster off

pmcd on ypserv off

Flag Status Flag Status

Table 15-1 Standard configuration for workstation services.
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Swap Space 15.3.2
The best way to determine the optimal swap space size is to try
several sizes. We recommend setting the swap space size to four
times the RAM size. When the swap space is not large enough
there will be an error message in the /var/adm/SYSLOG file or
in the console window. If you routinely process several large 2D
datasets in Xepr you may need to increase your swap space.
There are two types of swap space: the hard disk swap space and
the swap file. The swap file is slower than the hard disk swap
space. To increase the hard disk swap space you need to reparti-
tion the hard drive which wipes out the contents of the hard disk.
The fastest swap space configuration is to have swap spaces on
both the system hard disk and the secondary hard disk.

Security 15.3.3
Functionality, accessibility, and convenience may compromise
the system security. Balancing these considerations is not a sim-
ple job. Refer to the SGI workstation administrative manual for
security settings that best suit you. We suggest the following.

Lock accounts There are a few accounts utilized by Xepr such as the guest and
lp accounts. Never delete the guest and lp accounts. Instead,
lock these accounts and other �open to the public� accounts such
as demos, EZsetup, OutOfBox, etc. 

Root and Super
User

Avoid logging in as root or super user. Only do so when you
must perform system administration tasks. Xepr should be run
out of your personal user account or xuser account.

Transitive Trust The UNIX operating system allows users to set host-to-host
equivalency (in the /etc/hosts.equiv file), user-to-user equiva-
lency (in the ~/.rhosts file), and ftp user equivalency (in the
~/ .ne t rc  f i l e ) .  I n  h i g h  s e c u r i ty  e n v i r o n m e n t s ,  t h e
/etc/host.equiv file is blank and the ~/.rhosts and ~/.netrc files
in the user accounts are usually removed. 
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Reinstalling or Upgrading Xepr
Reinstalling or Upgrading Xepr 15.4

List of Important Files 15.4.1
The following files are very important and must be backed up
before you reinstall the operating system or the Xepr software. 

License File The file license.dat can be found in three possible locations:

/usr/xepr/sharedSetup/

/usr/Bruker/flexlm/licenses/

/usr/local/flexlm/Bruker/licenses/

Hall Probe
Calibration File

/ us r / xep r /Acqu is i t i onServe r /OS9/Serve rs
/FUSETUP/FUEr032t/hall####.cal and hall####.dat (where
#### is the serial number.)

ACPU Information /usr/xepr/AcquisitionServer/admin/ServerSetup

Signal Channel
Calibration Files

/usr/xepr/AcquisitionServer/OS9/Servers/<Server name: e.g.
E500, E580, etc.>/FUSETUP/FUSct/CalibData/*.cal

Spectrometer.ini
File

/usr/xepr/Acquis i t ionServer/OS9/Servers/<Server
name>/Spectrometer.ini

Pulse System
Configuration

Files

If you have an E 580 or E 680: /usr/xepr/Acquisition-
Server /OS9/Serve rs /< S e r v e r
name>/FUSETUP/FUFTEpr/XBand (and/or WBand)/*.cfg
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Performing an Installation or Upgrade 15.4.2
1. Check the current version of Xepr. Use the shell

command Xepr -i to determine the version of the cur-
rently installed Xepr software.

2. Follow the instructions in the release note. Login
as root to install Xepr. Read the release note on the Xepr
CD first. Follow the instructions for installing Xepr. Use
the default installation settings to avoid any unforeseen
problems. Sometimes you may need to delete the
/usr/xepr folder before you install the Xepr software. 

3. Restore the backed up files. Put the files you backed
up in Section 15.4.1 into the folders from which they
came.

4. Install the acquisition server. Each time you reinstall
Xepr or upgrade the acquisition package you must rein-
stall the acquisition server. The acquisition server installa-
t i o n  s c r i p t  i s  l o c a t e d  i n  t h e  f o l d e r
/usr/xepr/AcquisitionServer/admin/. Make sure you
have the correct ServerSetup file. Change to the above
directory and type ./installServer to install the acquisi-
tion server.

5. Reboot the UNIX workstation. If you do not, the
upgrade or installation will not work properly.
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Initial Setup of Xepr 15.5
Normally users have their own account. If you do not have an
account yet ask the system administrator to create one for you. If
you are responsible for the system and want to create a user�s
account, refer to the SGI workstation manual or help to find out
how to create a user�s account. A user�s account has a user�s
account name, user ID, and a password to log into the account.
After you log into your account, you can configure your desktop,
windows, UNIX shell type, and other features. You can also
change your password. Refer to the Toolchest help menu for
configuration of your account. When you run Xepr for the first
time in your own account, Xepr will automatically configure
your home directory to setup Xepr.

Setting Up Xepr for Your Account 15.5.1
1. Find the Xepr icon. Click the Toolchest > Find > Icon

Catalog > Applications. A window of application pro-
gram icons will appear. (See Figure 15-1.)

Figure 15-1 Opening the Applications icon window.

Applications
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Initial Setup of Xepr
2. Setup a desktop icon for Xepr. In the Applications
i con window you  can f ind the  Xepr  icon .  (See
Figure 15-2.) Drag the icon onto to the desktop. Now you
can launch the Xepr software from the Desktop.

3. Start Xepr program for the first time. Double click
the Xepr icon. The Xepr program will automatically con-
figure your account to run Xepr and launch the Xepr pro-
gram.

Figure 15-2 The Xepr icon.

Xepr
Icon
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Initial Setup of Xepr
Setting Up the Properties of the Xepr Software 15.5.2
1. Maximize the Xepr window. Since Xepr has so many

components, a full screen window is recommended. Click
the maximize button on the right top corner. 

2. Select the monitoring panel position. First make
sure the spectrometer is on and booted. You can choose
either to put the monitoring panel above or below the
Viewport. Click the Properties button in the menu bar,
and then Panel Properties. A dialog window will appear.
Cl ick  ei ther  Top  or  Bottom  and then OK .  (See
Figure 15-3.)

Figure 15-3 Selecting the monitoring panel position.

Panel
Properties

Monitoring
Position
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Initial Setup of Xepr
3. Connect to spectrometer. Click Acquisition in the
menu bar and then Connect To Spectrometer. A dialog
box will appear prompting for the Server Name. Enter
the acquisition server�s name in the blank box and click
OK. (See Figure 15-4.) If you do not know the acquisi-
tion server�s name, ask the system administrator. The typ-
ical servers names are e500, e580, e600, or e680,
depending on the type of spectrometer.

Figure 15-4 Connecting to the spectrometer.

Enter
Server
Name
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Initial Setup of Xepr
4. Set up the printer. Click File in the menu bar and then
Setup Printer. A dialog box appears. Click the arrow but-
ton next to the Printer Type. A drop-down list of printers
will appear. Select the correct Printer Type for your
printer. The Printer Command has been set by default as
lp -c -dXeprPrinter, where XeprPrinter is the default
name of the Xepr printer. Do not change this command
unless you have changed the printer name. The Preview
Command should be set to xpsview -or landscape.
Now that the critical settings are selected, you can choose
the other options which are available in the dialog box.
Click Set to exit this dialog box. (See Figure 15-5.) 

Figure 15-5 Setting up the printer.
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Initial Setup of Xepr
5. Test the printer. Load an EPR spectrum. Display the
spectrum in the viewport.  Click Print  in the File
drop-down menu. A dialog box appears. Select the proper
Orientation, Width, Height, and other parameters. Click
printer as the Destination. Click the Print button. (See
Figure 15-6.)

6. Disconnect from the spectrometer. Click Acquisi-
tion > Disconnect From Spectrometer. The monitoring
panel will disappear.

Figure 15-6 Testing the printer.

Print
Viewport
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Initial Setup of Xepr
7. Exit Xepr. Click File and then Exit in the menu bar. A
dialog box appears asking you if you want to save the
changes. Click Yes and then OK to exit Xepr program.
(See Figure 15-7.) Next time you launch the Xepr soft-
ware, you will find the Server Name appearing in the
Connect to Spectrometer dialog box. The printer will
be ready to print.

8. Logout from your account. It is always a good idea to
logout from your account when you finish your work.

Figure 15-7 Saving the changes and exiting.

If you do not save your
changes, none of your
ch a n g es  wi l l  b e
remembered the next
time you start Xepr.

Exit
Xepr

Save
Changes
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How to Start and Stop Xepr
How to Start and Stop Xepr 15.6
This section describes different ways to start the Xepr program.
It also describes how to abort the Xepr program when things go
wrong and the system hangs up.

Starting Xepr from a UNIX shell 15.6.1
There are two basic ways to launch the Xepr program. One is to
double click the Xepr icon. You can find the Xepr icon on the
Desktop or in the Icon Catalog: Applications window. The
alternative way to start Xepr is to launch Xepr from a UNIX
shell.

1. Open a UNIX shell. Click Desktop > Toolchest >
Open UNIX Shell. A shell window will open.

Figure 15-8 Opening a UNIX shell.

Open UNIX
Shell
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How to Start and Stop Xepr
2. Start Xepr with a shell command. Move the mouse
pointer inside the shell window, type Xepr, and then press
the Enter key. The Xepr program will start. You can leave
the UNIX shell window open for now. That gives you an
option to abort Xepr program. (See the next section.)

Figure 15-9 Launching the Xepr program from a UNIX
shell.

UNIX is case sensi-
tive. You need to capi-
talize the X when you
type the shell command
Xepr. 
Elexsys E 500 User�s Manual: Advanced Operations 15-17



Aborting Xepr
Aborting Xepr 15.7
Normally you need to exit Xepr by clicking File in the menu bar,
and then clicking Exit to terminate the Xepr program. However,
when something goes wrong or the system hangs up, you may
not be able to exit Xepr by normal methods. Keep in mind,
sometimes Xepr needs more time to execute certain functions
especially the communications between the system and slow
devices. It may not respond to your command instantly. Give
Xepr some extra time. Avoid continuously clicking the mouse
button: it only make the system even busier. When memory is
running too low or there is too much network traffic, Xepr might
hang up. Keep clearing up the Result Dataset. Avoid loading
too many large data files into Xepr. Reduce network activities
particularly when you connect to the spectrometer. These things
will help you reduce the possibility of hanging up. If you fail to
close Xepr in the normal way, we suggest the following. First try
the normal procedure to exit Xepr. If that fails, try aborting by
the methods described in this section. After you abort Xepr, turn
off the console and turn on the console again before you recon-
nect to spectrometer.

Logout from the Current Account. 15.7.1
This is the easiest way to abort Xepr. Simply follow the logout
procedure described in Appendix A of the Elexsys E 500 User�s
Manual: Basic Operations and the Xepr program will be termi-
nated.

The Ctrl-C command 15.7.2
If you start the Xepr program from a UNIX shell, you can also
use the Ctrl-C command to abort Xepr program. This is a grace-
ful way to terminate the Xepr. Minimize (iconize) the Xepr win-
dow. Move the mouse pointer inside the UNIX shell window
from which you launched Xepr program. Press the <Ctrl> key
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Aborting Xepr
and the c key simultaneously. The Xepr program will be termi-
nated. If you started Xepr by clicking the icon, the Ctrl-C com-
mand will not terminate the Xepr program. 

If you start Xepr as a background process by using the shell
command Xepr &, you need to use the command jobs to find
out the job number of Xepr. Type kill %<job number> to termi-
nate the Xepr program, where <job number> is the number you
found with the jobs command.

The Kill Command 15.7.3
Alternatively you can use the kill command to abort Xepr with-
out logging out of your account. You need to open a UNIX shell.
Enter ps -ef | grep .xepr. This command will display the pro-
cess number of Xepr. Enter kill -9 <process#> where <pro-
cess#> is the number the ps command displayed. The Xepr
program will be terminated.

Figure 15-10 �Killing� Xepr.

Process
Number
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The Xepr Printer
The Xepr Printer 15.8

Reinstalling the Xepr Printer 15.8.1
The Xepr installation script will install the printer drivers for
you. If you have printing problems with the Xepr program, first
check that the printer is turned on, connected, and on line. Next,
c h ec k  th e  p r in te r  s e tu p  as  d es c r ib e d  in  St ep 4 .  o f
Section 15.5.2. If the problem still exists, follow these instruc-
tions to reinstall the printer.

1. Launch the Printer Manager. Click the System menu
of the Toolchest, and then the Printer Manager com-
mand. (See Figure 15-11.)

Figure 15-11 Starting the printer manager.

Check if your printer is
connected, turned on,
and on-line.
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The Xepr Printer
2. Delete the printer that does not work. If there is a
listed XeprPrinter that does not work, select it by clicking
its icon with the left mouse button and then click the
Delete button. (See Figure 15-12.) If you did not log in
as root or a privileged user, you will be requested to enter
the root password.

3. Add a new printer. Click the Add button in the dialog
box and a dialog box for installing a new printer appears.
(See Figure 15-13.) Type XeprPrinter in the New
Printer Name box. Select Local Host if the printer is
connected directly to the UNIX workstation. You can
enter some information about the location of this printer
in case you want to share this printer with others. Choose
Bruker as the Vendor and Bruker Xepr Printer as the
Printer Type. If the printer is connected to the parallel
port click Parallel and in the Parallel Ports box the
words Built in will be highlighted. The printer that Bruker
provides with the spectrometer is connected to the parallel

Figure 15-12 The Printer Manager dialog box.

Add
Button

Delete
Button
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The Xepr Printer
port. Click Apply and then OK to close the Printer Man-
ager window.

Figure 15-13 Adding a new printer.
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The Xepr Printer
4. Set up the printer for Xepr. Follow the instructions in
Step 4. of Section 15.5.2 to set up and test the printer.

Printing a Spectrum to a File 15.8.2
Xepr not only supports printers from various vendors but can
also print the spectrum to a graphics file such as a postscript,
pdf, jpeg, tiff file, etc. 

1. Set the printer up. Click the Printer Setup command
in the File menu. Select the file type in the Printer Type
drop-down list in the PrinterSetup dialog box. In our
example, we are selecting a jpeg file. Then click Set to
apply the changes.

Figure 15-14 Setup for printing to a file.
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The Xepr Printer
2. Print to a file. Click Print Viewport in the File menu.
Click File in the Destination section. Enter a file name
and select the desired options for the data set plot. (See
Figure 15-15.) Click Print and the file will be saved into
your home directory.

Figure 15-15 Printing to a file.
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The Xepr Printer
When Printing Goes Wrong 15.8.3
Sometimes, printing from the Xepr can go wrong. For example,
if you choose the wrong printer by mistake in the Printer Setup,
the printer spills out many pages of useless printing code. If that
happens we recommend the following:

1. Turn off the printer. Turn off the printer immediately.

2. Open the printer manager. Click Toolchest > Sys-
tem > Printer Manager. (See Figure 15-16.)

3. Check the printer status. Double click the
XeprPrinter icon in the Printer Manager dialog box.

Figure 15-16 The Printer Manager dialog box.
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The Xepr Printer
4. Remove all print jobs. Highlight the job in the Printer
Request Queue box and click Queue > Cancel in the
menu bar to remove the print job from the queue. You
need to  remove  a l l  the  jobs  in  the  queue.  (See
Figure 15-17.)

5. Check the printer setup. Carefully follow the instruc-
tions described in Section 15.5.2, Step 4. to make sure
the printer is set up correctly. You may need to reinstall
the printer. (See Section 15.8.1.)

6. Stop printing the many pages. You may be able to
stop the flood of paper with useless code by disconnecting
the printer cable from the workstation, turning on the
printer, and then reconnecting the printer cable.

Figure 15-17 Removing print jobs.

Make sure you have
selected the correct
printer in the Printer
Setup of Xepr.
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Networking & Remote Operation 15.9
The Elexsys E 500 series EPR spectrometer is designed to oper-
ate in a networked environment. The workstation is equipped
with two Ethernet cards. The primary network adapter (ec0)
connects the workstation to the outside network. The secondary
network adapter (ec1) is solely dedicated to communication
between the workstation and the acquisition server of the EPR
spectrometer. This client/server architecture resolves the conflict
between multi-user/multi-tasking on the one hand and real-time
functionality on the other hand. Therefore, multiple users from
different locations are able to access Xepr remotely. However,
excessive communication between the workstation and the out-
side world not only slows down the Xepr program but also
opens the door for unauthorized access. Although the worksta-
tion is capable of functioning as a general network server it is
highly recommended to use the Elexsys EPR workstation for
acquiring EPR spectra only. The administrator of the worksta-
tion needs to carefully balance the security of the Elexsys work-
station and public network access. This section discusses data
transfer through the network and remote login to the work sta-
tion. 

Remote Access to Xepr 15.9.1
You can log onto the workstation remotely, allowing multiple
users access to the Xepr software at the same time. Each user
remotely logs into the workstation and launches the Xepr soft-
ware. In the following section we refer to the workstation
directly connected to the Elexsys spectrometer as the EPR server
and the other computers connected to the EPR server through
network as clients.
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Networking & Remote Operation
Remote Logon to the EPR Server 15.9.2
The client and the EPR server should be assigned appropriate IP
addresses and connected to the same network. The primary net-
work connection (ec0) of the EPR server should be used to con-
nect to the network. In order to display the Xepr application
window on the client�s monitor, you must either activate remote
display on the client computer (if the client has a UNIX operat-
ing system) or use special software, such as PC-Xware (if the
operating system is Windows). You also need a valid user
account on the EPR server.

From a UNIX
System

On the client computer, remote display is enabled by executing
the shell command,

xhost + <EPR server’s IP address>

In the shell window, enter 

telnet <EPR server IP address>

Enter the user�s name and password when you are prompted.
After logging into the EPR server, type Xepr to launch the Xepr
program.

From a Windows
System

Refer to the documentation for your X-terminal application for
details on enabling remote display.

After you remotely launch the Xepr program you can execute all
the Xepr functions.
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Remote Control of the Spectrometer 15.9.3
You can also control the EPR spectrometer remotely. Make sure
there are no other Xepr users connected to the spectrometer.
Click Acquisition > Connect to Spectrometer after you
launch the Xepr program remotely. In the dialog box, enter the
name of the spectrometer and then click Connect. Spectrometer
control operations including tuning, acquiring spectra, etc. are
now available to you through the Xepr software. Note that only
one instance of the Xepr application can connect to the spec-
trometer at a time. After one connection is established, all other
connections are blocked.

Data Transfer Via the Network 15.9.4
There are several ways to transfer data between the workstation
and other computers connected to the network.

FTP FTP (File Transfer Protocol) is one of the most commonly used
methods for data transfer. Elexsys data files are in BES3T® for-
mat. Each EPR spectrum consists of a binary data file with a
*.DTA extension and an ASCII description file with a *.DSC
extension. You must select binary transfer mode to transfer
*.DTA files properly. 

SAMBA SAMBA is an option for data sharing with the Microsoft Win-
dows and other platforms.

NFS NFS (Network File System) can be configured on your worksta-
tion for data sharing with other UNIX workstations. There are
also versions of NFS that run on Windows and Mac platforms.
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Xepr Under Linux 16
Bruker delivers either SGI O2 or Linux workstations for the user
interface of the Elexsys series EPR spectrometers. This chapter
describes various system administration issues related to the
Xepr program for the Linux workstations. The names, terms, or
methods described in this chapter may be slightly different for
the SGI O2 system, but the principles are the same. Refer to
Chapter 15 and SGI documentations for details if you have an
SGI O2 workstation.

Most of the commands and operations in this chapter require
root or super user privileges. In addition, the commands also
require at least some basic knowledge of the UNIX operating
system. This chapter assumes that you already are familiar with
general administration of the Linux operating system. There are
many web sites and documentation describing Linux administra-
tion. Be cautious when making changes to the workstation con-
figuration: some mistakes can lead to an unusable workstation.
Consult your local Bruker EPR service representative if you are
unsure of the changes you are making.

General Information 16.1
The Linux workstation comes with two Ethernet cards. Most of
the GUI (Graphical User Interface) operations in this chapter are
based on GNOME, the default desktop manager. If you prefer to
use other GUIs refer to the corresponding manuals and docu-
mentation. Much of the configuration is based on Red Hat
Linux 7.0. If your workstation is not running under Red Hat
Linux 7.0 you may find the settings or commands are slightly
different, but the essentials are the same.
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General Information
If you wish to check the system information for your worksta-
tion, click Main Menu > System > System Info. To check the
information and configuration of the network cards use the
/sbin/ifconfig command in a shell window.

You must have X-windows running to launch the Xepr program.

The system as delivered by Bruker has two visible accounts: the
root account with the password xepr@linux and the xuser
account with the password user@xepr. For your security,
change the root password immediately after the system has been
installed.

Most of the Xepr files reside in the /usr/xepr folder. These files
belong to root. Please do not alter those files unless it is abso-
lutely necessary. Each user should have links to some of the files
related to Xepr. Shared directories and files can be read or exe-
cuted but not written/rewritten by the users. 
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Network Settings
Network Settings 16.2

eth0 and eth1 16.2.1
The two Ethernet cards in the workstation are labeled eth0 and
eth1. eth0 is used for connecting to the outside world and is
configured as the primary interface. eth1 is devoted to commu-
nications between the workstation and the acquisition server
(OS9) of the spectrometer and is configured as the secondary
interface. When the workstation is delivered, the hostname and
IP address of eth0 are set to default values. You need to ask your
local network administrator to assign a hostname and an IP
address for your workstation. Change the hostname and IP
address of eth0 only. Never change the hostname and IP address
of eth1. The shell command /sbin/ifconfig displays the details
of all the Ethernet cards settings.

NFS (Network File System) 16.2.2
Xepr uses NFS to transfer files between the UNIX workstation
and the acquisition server. Never turn off or deactivate NFS.

Name Server 16.2.3
Some name services allow you to use easily remembered host
names instead of easily forgotten IP addresses. The most com-
mon services are files, DNS (Domain Name Service), and NIS
(Network Information Service).

Files This is the most controllable way to provide network informa-
tion. Entries in the /etc/hosts file connect an IP address with a
corresponding host name. You can simply edit this file to define
the names and IP addresses of the computers in your local net-
work as well as on the Internet. The hosts file must contain the
local host. 

Never change eth1 to
primary.
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Network Settings
The format is:

IP address hostname.subdomain.domain hostname
127.0.0.1 localhost

123.123.123 Elexsys.university.edu Elexsys

192.168.99.1 Xepr

192.168.99.5 E500

DNS Your local network usually has one or more DNS servers. You
can get the IP addresses of the DNS servers from your local net-
work administrator.

NIS Although NIS offers many benefits, the complexity and integra-
tion with other products can lead to problems. Do not activate or
use NIS on the EPR workstation.

You need to setup a proper lookup order for these servers. Login
as  root .  C l ick  Main Menu >  Program > System >
Control Panel.

Scroll down the panel and click the System Configuration but-
ton. (See Figure 16-1.)

Figure 16-1 The System Configuration button.

System
Configuration
16-4



Network Settings
On the left part of the window click Networking > Client tasks
> Host name search path. The Name service access panel
appears on the right side of the window. Select hosts, dns or
hosts if you do not have a DNS server. (See Figure 16-2.) Click
the Accept button at the bottom of the window and then click
Act/Changes on the left. Click Quit to exit the System Con-
figuration window.

Figure 16-2 Name service access.
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Network Settings
Routing 16.2.4
Although the EPR workstation has two Ethernet cards and is
able to function as a router, doing so will jeopardize the commu-
nication between the workstation and the EPR acquisition
server. Modification of the routing table could also direct net-
work traffic to eth1, which would slow down the response of the
Xepr program or even cause the Xepr program to hang up.
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Linux Workstation Service Configuration 16.3

Flags 16.3.1
Flags are used to activate and deactivate various services that the
workstation can offer. Here is the default configuration of the
Linux workstation as delivered by Bruker. You can check the
configuration by typing /sbin/chkconfig --list in a shell win-
dow. The command will list all the flag statuses under all run-
ning levels. Check the flag statuses under level five. tftp and
bootps under xinetd based services, network, and nfs ser-
vices must be on to allow the workstation to boot and communi-
cate with the acquisition server properly. Although you can turn
on more services than the default configuration, keep in mind
that the more services you turn on, especially network related
services, the slower the workstation responds. You may also
need to turn off some services to increase the security. Table
16-1 shows a default service configuration for Red Hat
Linux 7.0. The nameserv and sophed flags are for the XSophe
program. If you do not have XSophe installed you may not have
these services.

Flag Status Flag Status

syslog 5:on anacron 5:on

 crond 5:on httpd 5:on

netfs 5:on apmd 5:on

network 5:on arpwatch 5:off

random 5:on atd 5:on

rawdevices 5:on named 5:off

xfs 5:on keytable 5:on

Table 16-1 Standard configuration for workstation services running under level five.
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Linux Workstation Service Configuration
amd 5:off gpm 5:on

xinetd 5:on innd 5:off

reconfig 5:on ipchains 5:on

irda 5:off snmpd 5:off

isdn 5:on rhnsd 5:on

pcmcia 5:on ypbind 5:off

kdcrotate 5:off yppasswdd 5:off

kudzu 5:on ypserv 5:off

linuxconf 5:on autofs 5:on

lpd 5:on bootparamd 5:off

mars-nwe 5:off ciped 5:off

nfs 5:on dhcpd 5:off

nfslock 5:on gated 5:off

sshd 5:on kadmin 5:off

identd 5:on kprop 5:off

portmap 5:on krb524 5:off

postgresql 5:off krb5kdc 5:off

pppoe 5:off mcserv 5:off

rstatd 5:off mysqld 5:off

rusersd 5:off nscd 5:off

rwalld 5:off ntpd 5:off

rwhod 5:off ups 5:off

smb 5:off pxe 5:off

Flag Status Flag Status

Table 16-1 Standard configuration for workstation services running under level five.
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Linux Workstation Service Configuration
sendmail 5:on rarpd 5:off

routed 5:off nameserv 5:on

squid 5:off sophed 5:on

vncserver 5:off

xinetd based services:

amandaidx: off comsat: off

amidxtape: off imap: off

finger: on imaps off

linuxconf-web: off ipop2 off

rexec: off ipop3 off

rlogin: on pop3s off

rsh: on eklogin: off

swat: off gssftp: off

ntalk: off klogin: off

talk: off krb5-telnet: off

telnet: on kshell: off

tftp: on bootps: on

wu-ftpd: on

Flag Status Flag Status

Table 16-1 Standard configuration for workstation services running under level five.
Elexsys E 500 User�s Manual: Advanced Operations 16-9



Linux Workstation Service Configuration
Type chkconfig --add <name> to turn the service on where
<name> is the service name. Type chkconfig --del <name> to
turn off the service. You may need to indicate the run level by
using the shell command: 

chkconfig [--level <levels>] <name> <on|off|reset>.

Activate the service by the shell command: 

service <name> start

or

service <name> restart

or rebooting the workstation.
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Swap Space 16.3.2
The best way to determine the optimal swap space size is to try
several sizes. The swap space size we recommend is four times
the RAM size. When the swap space is not large enough there
will be an error message in the /var/log/messages file. If you
routinely process several large 2D datasets in Xepr you may
need to increase your swap space. There are two types of swap
space: the swap partition and the swap file. The swap file is
slower than the swap partition. To increase the swap partition
size you need to repartition the hard drive which wipes out the
contents of the hard disk. 

Security 16.3.3
Functionality, accessibility, and convenience may compromise
the system security. Balancing these considerations is not a sim-
ple job. Refer to the workstation administrative manual for secu-
rity settings that best suit you. We suggest the following.

Lock accounts There are a few accounts such as the nobody and lp accounts
utilized by Xepr and other application programs. Never delete
the nobody and lp accounts. Instead, lock these accounts and
other �open to the public� accounts. 

Root and Super
User

Avoid logging in as root or super user. Only do so when you
must perform system administration tasks. Most tasks can be
performed by logging in as a normal user and then switching to
root by using the su - shell command. You should always run
Xepr from a normal user account except for testing or diagnosis.

Service Access
Control

You can control network access to tighten security. However,
you need to be very careful not to block access for the acquisi-
tion server. Here is an extreme case where most services are
blocked to all clients except the acquisition server. Modify the
file /etc/xinetd.conf by adding the following line to the default
{} section:
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Linux Workstation Service Configuration
only_from = 192.168.99.0/24

where 192.168.99.0 is the subnet address assigned to the ACPU
when the acquisition server was installed. If a different subnet
address is set in the ServerSetup file you need to use it to
replace the above IP address. 24 is the number of bits for the net-
work and subnetwork. However, if you make the above change,
y o u  m u s t  a p p e n d  t h e  f o l l o w i n g  l i n e  t o  t h e  f i l e
/etc/xinetd.d/bootps:

only_from = 0.0.0.0/0

Otherwise, the acquisition server will not boot.

You can put addresses of any trusted hosts/subnet in this entry
separated by space so that these hosts can access the services
controlled by xinetd. 

There are many ways to tighten security. Bear in mind that any
security settings must allow the acquisition server to access
bootp, tftp, NFS, and other services.
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Reinstalling or Upgrading Xepr 16.4

List of Important Files 16.4.1
The following files are very important and must be backed up
before you reinstall the operating system or the Xepr software. 

License File /usr/xepr/sharedSetup/license.dat

or

/usr/Bruker/flexlm/licenses/license.dat

Hall Probe
Calibration File

/ us r / xep r /Acqu is i t i onServe r /OS9/Serve rs
/FUSETUP/FUEr032t/hall####.cal and hall####.dat (where
#### is the serial number.)

ACPU Information /usr/xepr/AcquisitionServer/admin/ServerSetup

Signal Channel
Calibration Files

/usr/xepr/AcquisitionServer/OS9/Servers/<Server name: e.g.
E500, E580, etc.>/FUSETUP/FUSct/CalibData/*.cal

Spectrometer.ini
File

/usr/xepr/Acquis i t ionServer/OS9/Servers/<Server
name>/Spectrometer.ini

Pulse System
Configuration

Files

If you have an E 580 or E 680: /usr/xepr/Acquisition-
Server /OS9/Serve rs /< S e r v e r
name>/FUSETUP/FUFTEpr/XBand (and/or WBand)/*.cfg
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Performing an Installation or Upgrade 16.4.2
1. Check the current version of Xepr. Use the shell

command Xepr -i to determine the version of the cur-
rently installed Xepr software.

2. Follow the instructions in the release note. Login
as root to install Xepr. Read the release note on the Xepr
CD first. Follow the instructions for installing Xepr. Use
the default installation settings to avoid any unforeseen
problems. Sometimes you may need to delete the
/usr/xepr folder before you install the Xepr software. 

3. Restore the backed up files. Put the files you backed
up in Section 16.4.1 into the folders from which they
came.

4. Install the acquisition server. Each time you reinstall
Xepr or upgrade the acquisition package you must rein-
stall the acquisition server. The acquisition server installa-
t i o n  s c r i p t  i s  l o c a t e d  i n  t h e  f o l d e r
/usr/xepr/AcquisitionServer/admin/. Make sure you
have the correct ServerSetup file. Change to the above
directory and type ./installServer to install the acquisi-
tion server.

5. Reboot the UNIX workstation. If you do not, the
upgrade or installation will not work properly.
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Initial Setup of Xepr 16.5

Creating a New User Account 16.5.1
Normally users have their own accounts. A user�s account has a
user�s account name, user ID, and a password to log into the
account. As root you can create a new user account by typing
useradd <newUserName>; passwd <newUserName> in a
shell window. It will prompt you for the password. Enter and
confirm the temporary password for the new user. Linux creates
a private group for the new user account. You can add the new
u s e r  t o  t h e  d e f a u l t  users  g r o u p  b y  t y p i n g
usermod -G users <newUserName> in a shell window. We
recommend adding all users to the users group so that they can
share their files. If you prefer to use a GUI refer to the corre-
sponding manual to find out how to create a new account. Make
sure the new account is in the users group. After new users log
into their account, they can customize the desktop, windows,
UNIX shell type, and other features. They should change their
password the first time login. Refer to the Integrated Help Sys-
tem for details on configuring the account. When running Xepr
for the first time in the new account, Xepr will automatically
configure its home directory to set up Xepr.
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Setting Up Xepr for a New Account 16.5.2
1. Start the application launcher. Click Main menu >

Panel > Add to panel > Launcher. 

2. Set up the Xepr launcher. In the Create launcher
applet dialog box enter Xepr for the program name. In
the Command line enter Xepr. Click the Icon button.
(See Figure 16-3.) 

Figure 16-3 Setting up the Xepr launcher applet.

Linux is case sensitive.
You need to capitalize
the X when you type
the command Xepr. 

Icon
Button
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Initial Setup of Xepr
3. Select the Xepr icon. In the Choose an icon window
scroll down and click on xeprIcon.png to highlight it.
Click the OK button to exit. (See Figure 16-4.)

4. Exit the launcher applet creator. After selecting the
Xepr icon, the icon will appear next to Icon in the Create
launcher applet window. Click OK to exit. A launcher
with the Xepr icon will appear in the bottom panel. You
can drag the icon onto to the desktop if you want to launch
the Xepr software from the Desktop.

Figure 16-4 Selecting the Xepr icon.

Xepr
Icon
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Initial Setup of Xepr
5. Start the Xepr application for the first time. Single
click the Xepr icon in the bottom panel or double click the
Xepr icon on the desktop. The Xepr program will auto-
matically configure your account to run Xepr and launch
the Xepr program. You can perform the same operation
directly from a shell. Simply type Xepr in a shell.

Linux is case sensitive.
You need to capitalize
the X when you type
the  she l l  command
Xepr. 
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Setting Up the Properties of the Xepr Software 16.5.3
1. Maximize the Xepr window. Since Xepr has so many

components, a full screen window is recommended. Click
the maximize button on the right top corner. 

2. Select the monitoring panel position. First make
sure the spectrometer is on and booted. You can choose
either to put the monitoring panel above or below the
Viewport. Click the Properties button in the menu bar,
and then Panel Properties. A dialog window will appear.
Cl ick  ei ther  Top  or  Bottom  and then OK .  (See
Figure 16-5.)

Figure 16-5 Selecting the monitoring panel position.

Panel
Properties

Monitoring
Position
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Initial Setup of Xepr
3. Connect to spectrometer. Click Acquisition in the
menu bar and then Connect To Spectrometer. A dialog
box will appear prompting for the Server Name. Enter
the acquisition server�s name in the blank box and click
OK. (See Figure 16-6.) If you do not know the acquisi-
tion server�s name, ask the system administrator. The typ-
ical servers names are e500, e580, e600, or e680,
depending on the type of spectrometer.

Figure 16-6 Connecting to the spectrometer.

Enter
Server
Name
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Initial Setup of Xepr
4. Set up the printer. Click File in the menu bar and then
Setup Printer. A dialog box appears. Click the arrow but-
ton next to the Printer Type. A drop-down list of printers
will appear. Select the correct Printer Type for your
printer.  The Printer Command  should be set as
lpr -P <printername>, where <printername> should be
replaced by the name of the printer. You can also enter lpr
which will print to the default printer. The Preview Com-
mand should be set to gv -landscape -media letter (or
A4). Now that the critical settings are selected, you can
choose the other options which are available in the dialog
box. Click Set to exit this dialog box. (See Figure 16-7.) 

Figure 16-7 Setting up the printer.
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Initial Setup of Xepr
5. Test the printer. Load an EPR spectrum. Display the
spectrum in the viewport.  Click Print  in the File
drop-down menu. A dialog box appears. Select the proper
Orientation, Width, Height, and other parameters. Click
printer as the Destination. Click the Print button. (See
Figure 16-8.)

6. Disconnect from the spectrometer. Click Acquisi-
tion > Disconnect From Spectrometer. The monitoring
panel will disappear.

Figure 16-8 Testing the printer.
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Initial Setup of Xepr
7. Exit Xepr. Click File and then Exit in the menu bar. A
dialog box appears asking you if you want to save the
changes. Click Yes and then OK to exit Xepr program.
(See Figure 16-9.) Next time you launch the Xepr soft-
ware, you will find the Server Name appearing in the
Connect to Spectrometer dialog box. The printer will
be ready to print.

8. Logout from your account. It is always a good idea to
logout from your account when you finish your work.

Figure 16-9 Saving the changes and exiting.

If you do not save your
changes, none of your
ch a n g es  wi l l  b e
remembered the next
time you start Xepr.

Exit
Xepr

Save
Changes
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How to Start and Stop Xepr
How to Start and Stop Xepr 16.6
This section describes different ways to start the Xepr program.
It also describes how to abort the Xepr program when things go
wrong and the system hangs up.

Starting Xepr from a UNIX shell 16.6.1
There are two basic ways to launch the Xepr program. One is to
double-click the Xepr icon on the desktop or single-click it in
the bottom panel. The alternative way to start Xepr is to launch
Xepr from a UNIX shell.

1. Open a UNIX shell. Click the right mouse button to
open a menu and then left click on New > Terminal. You
can also click the Terminal icon in the bottom panel.

Figure 16-10 Opening a UNIX shell.

Open UNIX
Shell

Open UNIX
Shell
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How to Start and Stop Xepr
2. Start Xepr with a shell command. Type Xepr, and
then press the Enter key. The Xepr program will start.
You can leave the UNIX shell window open for now. That
gives you an option to abort Xepr program. (See the next
section.)

Figure 16-11 Launching the Xepr program from a UNIX
shell.

UNIX is case sensi-
tive. You need to capi-
talize the X when you
type the shell command
Xepr. 
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Aborting Xepr 16.7
Normally you need to exit Xepr by clicking File in the menu bar,
and then clicking Exit to terminate the Xepr program. However,
when something goes wrong or the system hangs up, you may
not be able to exit Xepr by normal methods. Keep in mind,
sometimes Xepr needs more time to execute certain functions
especially the communications between the system and slow
devices. It may not respond to your command instantly. Give
Xepr some extra time. Avoid continuously clicking the mouse
button: it only make the system even busier. When memory is
running too low or there is too much network traffic, Xepr might
hang up. Keep clearing up the Result Dataset. Avoid loading
too many large data files into Xepr. Reduce network activities
particularly when you connect to the spectrometer. These things
will help you reduce the possibility of hanging up. If you fail to
close Xepr in the normal way, we suggest the following. First try
the normal procedure to exit Xepr. If that fails, try aborting by
the methods described in this section. After you abort Xepr, turn
off the console and turn on the console again before you recon-
nect to spectrometer.

Logout from the Current Account. 16.7.1
This is the easiest way to abort Xepr. Simply follow the logout
procedure described in Appendix B of the Elexsys User�s Man-
ual: Basic Operations and the Xepr program will be terminated.

The Ctrl-C command 16.7.2
If you start the Xepr program from a UNIX shell, you can also
use the Ctrl-C command to abort Xepr program. Minimize
(iconize) the Xepr window. Move the mouse pointer inside the
UNIX shell window from which you launched Xepr program.
Press the <Ctrl> key and the c key simultaneously. The Xepr
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Aborting Xepr
program will be terminated. If you started Xepr by clicking the
icon, the Ctrl-C command will not terminate the Xepr program. 

The Kill Command 16.7.3
Alternatively you can use the kill command to abort Xepr with-
out logging out of your account. You need to open a UNIX shell.
Enter ps -ef | grep .xepr. This command will display the pro-
cess number and the process name (/usr/xepr/shared-
Bin/I686_LINUX/xepr) of Xepr. Enter kill -9 <process#>
where the <process#> is the process number that the ps com-
mand displayed. (See Figure 16-12.) The Xepr program will be
terminated. Identify the correct process for Xepr. The ps com-
mand may pick up the grep .xepr process which is not the pro-
cess you want to terminate. 

Figure 16-12 �Killing� Xepr.
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The Xepr Printer
The Xepr Printer 16.8

Installing a Printer 16.8.1
The printer coming with the spectrometer should already be
installed and configured when the Elexsys spectrometer was
installed. If you have printing problems with the Xepr program,
first check the printer setup described in Section 16.5.3, Step 4.
You may also consult in the Linux documentations about the
printer. If the problem still exists you can follow these instruc-
tions to reinstall the printer. Make sure the printer is physically
connected before you start.

1. Launch the Print System Manager. Login as root.
Click Main Menu > Programs > System > Control
Panel, and then the Print System Manager button. (See
Figure 16-13.)

Figure 16-13 Starting the print system manager.

Check if your printer is
connected, turned on,
and on-line.

Print
System
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The Xepr Printer
2. Delete the printer that does not work. If the listed
printer does not work, select it by clicking its entry with
the left mouse button and then click the Delete button.
(See Figure 16-14.).

3. Add a new printer. Click the Add button in the dialog
box and a dialog box for adding a new printer appears.
(See Figure 16-15.) Select Local Printer and click OK. 

Figure 16-14 The Print System Manager dialog box.

Figure 16-15 Adding a new printer.

Add
Button

Delete
Button
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The Xepr Printer
4. Identify the printing device. An info box appears tell-
ing you what printing devices are detected. If no device is
detected, check the hardware and its connections. Other-
wise, click OK to close this window. (See Figure 16-16.) 

Figure 16-16 Info window identifying printing devices.
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The Xepr Printer
5. Name the printer. Type in a name for the printer in the
Names box. (See Figure 16-17.) Avoid using spaces in
t h e  n a m e .  C h a n g e  t h e  Spoo l  D i rec to ry  t o
/var/spool/lpd/<printerName>. The Printer Device
should match the detected device in the info box. Do not
close this window yet. Instead, click the Select button
next to Input Filter.

Figure 16-17 Naming the printer.
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The Xepr Printer
6. Configure the filter. In the Configure Filter window
select the proper printer model. On the right side of the
window, select the desired Paper Size and Color
Depth/Uniprint Mode.  Also make your Printing
Options choices. These options may need to be set differ-
ently for different printers. Usually choosing all three
options works. After you finish configuring the filter,
click OK to exit. (See Figure 16-18.)

Figure 16-18 Configuring the filter.
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The Xepr Printer
7. Exit Local Printer Entry. The filter you configured will
automatically fill in the Input Filter box in the Local
Printer Entry window. Click OK button to exit. (See
Figure 16-19.)

8. Restart lpd. In the Print System Manager window
click lpd > Restart lpd. (See Figure 16-20.) 

Figure 16-19 Closing the Local Printer Entry window.

Figure 16-20 Restarting lpd.
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The Xepr Printer
9. Test the printer. Select the printer by left clicking on
the printer entry. Click Tests > Print ASCII test page to
verify the text printer. (See Figure 16-21.) Click Tests >
Print Postscript test page to verify that Postscript print-
ing is working properly. If the test page is printed out cor-
rectly close this window and the Control Panel window.
If there is a problem follow the instructions on the test
page or consult the Linux documentations. 

10. Set up the printer for Xepr. Follow the instruction in
Section 16.5.3, Step 4. to set up the printer for Xepr and
test the printer.

Figure 16-21 Testing the printer.
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The Xepr Printer
Printing a Spectrum to a File 16.8.2
Xepr can print a spectrum to a graphics file such as a postscript,
pdf, jpeg, tiff file, etc. 

1. Set the printer up. Click the Printer Setup command
in the File menu. Select the file type in the Printer Type
drop-down list in the PrinterSetup dialog box. In our
example, we are selecting a jpeg file. Then click Set to
apply the changes.

Figure 16-22 Setup for printing to a file.
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The Xepr Printer
2. Print to a file. Click Print Viewport in the File menu.
Click File in the Destination section. Enter a file name
and select the desired options for the data set plot. (See
Figure 16-23.) Click Print and the file will be saved into
your home directory.

Figure 16-23 Printing to a file.
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The Xepr Printer
Print Preview 16.8.3
You can preview your plot first before you print a hard copy or
print to a file. Select preview from the Destination buttons. The
contents in the selected viewport will be sent to ghostview for
display. (See Figure 16-24.)

Figure 16-24 Previewing with ghostview.
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The Xepr Printer
When Printing Goes Wrong 16.8.4
Sometimes, printing from the Xepr can go wrong. For example,
if you choose the wrong printer by mistake in the Printer Setup,
the printer spills out many pages of useless printing code. If that
happens we recommend the following:

1. Turn off the printer. Turn off the printer immediately.

2. Check the print queue. Use the lpq command to
check the print queue of the default printer. The -P<print-
erName> option allows you to specify the printer if your
printer is not the default printer. You will find the print job
ID numbers from the response of this command. (See
Figure 16-25.)

3. Remove all print jobs. Remove all the print jobs using
the shell command lprm <jobID>. (See Figure 16-25.)
You may need root privilege to remove any printing jobs
that belong to someone else.

Figure 16-25 Removing a print job.
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The Xepr Printer
4. Check the printer setup. Carefully follow the instruc-
tions described in Section 16.5.3, Step 4. to make sure
the printer is set up correctly. You may need to reinstall
the printer. (See Section 16.8.1.)

5. Stop printing the many pages. You may be able to
stop the flood of paper with useless code by disconnecting
the printer cable from the workstation, turning on the
printer, and then reconnecting the printer cable.

Make sure you have
selected the correct
printer in the Printer
Setup of Xepr.
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Networking & Remote Operation 16.9
The Elexsys E 500 series EPR spectrometer is designed to oper-
ate in a networked environment. The workstation is equipped
with two Ethernet cards. The primary network adapter (eth0)
connects the workstation to the outside network. The secondary
network adapter (eth1) is solely dedicated to communication
between the workstation and the acquisition server of the EPR
spectrometer. This client/server architecture resolves the conflict
between multi-user/multi-tasking on the one hand and real-time
functionality on the other hand. Therefore, multiple users from
different locations are able to access Xepr remotely. However,
excessive communication between the workstation and the out-
side world not only slows down the Xepr program but also
opens the door for unauthorized access. Although the worksta-
tion is capable of functioning as a general network server it is
highly recommended to use the Elexsys EPR workstation for
acquiring EPR spectra only. The administrator of the worksta-
tion needs to carefully balance the security of the Elexsys work-
station and public network access. This section discusses data
transfer through the network and remote login to the work sta-
tion. 

Remote Access to Xepr 16.9.1
You can log onto the workstation remotely, allowing multiple
users access to the Xepr software at the same time. Each user
remotely logs into the workstation and launches the Xepr soft-
ware. In the following section we refer to the workstation
directly connected to the Elexsys spectrometer as the EPR server
and the other computers connected to the EPR server through
network as clients.
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Remote Logon to the EPR Server 16.9.2
The client and the EPR server should be assigned appropriate IP
addresses and connected to the same network. The primary net-
work connection (eth0) of the EPR server should be used to
connect to the network. In order to display the Xepr application
window on the client�s monitor, you must either activate remote
display on the client computer (if the client has a UNIX operat-
ing system) or use special software, such as PC-Xware (if the
operating system is Windows). You also need a valid user
account on the EPR server.

From a UNIX
System

On the client computer, remote display is enabled by executing
the shell command,

xhost + <EPR server’s IP address>

In the shell window, enter 

telnet <EPR server IP address>

Enter the user�s name and password when you are prompted.
After logging into the EPR server, type Xepr to launch the Xepr
program.

From a Windows
System

Refer to the documentation for your X-terminal application for
details on enabling remote display.

After you remotely launch the Xepr program you can execute all
the Xepr functions.
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Remote Control of the Spectrometer 16.9.3
You can also control the EPR spectrometer remotely. Make sure
there are no other Xepr users connected to the spectrometer.
Click Acquisition > Connect to Spectrometer after you
launch the Xepr program remotely. In the dialog box, enter the
name of the spectrometer and then click Connect. Spectrometer
control operations including tuning, acquiring spectra, etc. are
now available to you through the Xepr software. Note that only
one instance of the Xepr application can connect to the spec-
trometer at a time. After one connection is established, all other
connections are blocked.

Data Transfer Via the Network 16.9.4
There are several ways to transfer data between the workstation
and other computers connected to the network.

FTP FTP (File Transfer Protocol) is one of the most commonly used
methods for data transfer. Elexsys data files are in BES3T® for-
mat. Each EPR spectrum consists of a binary data file with a
*.DTA extension and an ASCII description file with a *.DSC
extension. You must select binary transfer mode to transfer
*.DTA files properly. 

SAMBA SAMBA is an option for data sharing with the Microsoft Win-
dows and other platforms.

NFS NFS (Network File System) can be configured on your worksta-
tion for data sharing with other UNIX workstations. There are
also versions of NFS that run on Windows and Mac platforms.
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Acquisition Server Diagnostics 17
The Elexsys E 500 series EPR spectrometer is a multi-computer
system. It consists of a UNIX workstation, an OS9 acquisition
server CPU (ACPU), and a transputer for each transputer con-
trolled device. Normally, when you turn the console on, every-
thing boots up and initializes in an orderly fashion. This chapter
describes what to do in the unlikely event that it does not.
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What Is Normal? 17.1
This section describes the connections, indicators, and booting
procedures for a normal spectrometer booting process.

Connections 17.1.1
Figure 17-1 shows the important connectors and indicators of
the ACPU.

The ACPU is connected to the UNIX workstation via a thinnet
cable (RG-58 coaxial cable), hub, and a RJ-45 (twisted pair)
cable. Figure 17-2 shows how all these components are con-
nected together.

Figure 17-1 The ACPU rack.
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What Is Normal?
See Section 13.2.4 for information regarding the transputer con-
nections.

Figure 17-2  The Ethernet connections.
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What Is Normal?
A Normal Booting Process 17.1.2
A normal booting process proceeds as follows.

1. Turn on the hub�s power. 
2. Boot up the UNIX workstation. If the workstation is

not already on, you must turn on the workstation. The
UNIX workstation needs to be fully booted up and run-
ning before you turn the spectrometer console on. 

3. Turn on the Elexsys console. Press the ON button of
the Elexsys console. The ACPU should start booting. The
Acquisition Server CPU (ACPU) board has two red and
eight green LEDs on its front panel. To judge whether the
ACPU boots properly watch these LEDs closely during
booting. When the ACPU boots, LEDs A and B should
blink in the first few seconds after power up. (See
Figure 17-3.) This may take a minute. (See Figure 17-1.)
The following indicates the function of some of the LEDs
on the ACPU board.

Figure 17-3 The LEDs on ACPU board.
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What Is Normal?
4. Boot up the transputer devices. After the ACPU
boots up from the UNIX workstation, it immediately
begins to boot the transputer devices. As each device is
identified its R LED will blink once briefly. When the
transputer device is booting, the R LED blinks rapidly
about 10 times and then stays on. Upon successful booting
of the ACPU and the transputer devices, the GSI board�s
Ready LED will light. (See Figure 17-1.)

5. Connect to the spectrometer. Select the Connect to
Spectrometer command in the Acquisition menu.
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Trouble Shooting 17.2
If you were not able to connect to the spectrometer in the previ-
ous section, follow the primary diagnostics chart to determine
the source of the problem. 

Figure 17-4 The primary diagnostics chart.
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ACPU Diagnostics 17.2.1

Figure 17-5 The ACPU diagnostics chart.
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Trouble Shooting
If the LED of the GSI board is not lit, it is likely that the ACPU
is not booted correctly. Follow the flow chart of the ACPU diag-
nostics to locate the problem.

1. Check the hardware connections. 

�  Check the console computer rack power supply. 

�  Make sure both ends of the thinnet connection are
terminated with 50 	 loads. 

�  Check the power and the connection of the hub. Do
not use uplink.

�  Carefully inspect all the network cables and their
connectors. 

�  Make sure the second ethernet card is functioning
properly. 

2. Reboot the workstation after installation of the
Xepr software and the Acquisition Server. You
must restart the UNIX workstation after you install Xepr
and the Acquisition Server in order for the spectrometer
to work properly.

3. Check the booting process. You can use the cu com-
mand to check the booting process of the ACPU. Connect
a terminal cable (part number E5002111) from RS1 on
the ACPU to port 2 of the SGI O2 workstation (connector
closest to the edge) or the first (1) RS232 port of the
Linux workstation. In a UNIX shell window type
cu - l /dev/ t tyd2 for  an  SGI  O2  worksta t ion o r
cu -l /dev/ttyS0 for a Linux workstation. The shell will
respond �connected�. Reboot the acquisition server by
either pressing the Reset switch to the left or switch the
console power off and on. If the ACPU boots correctly the
display in the shell window of the workstation monitor
should look similar to what follows.

Use the letter �el� not
the number �one� with
the cu command.
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eleXsys ~> cu -l /dev/ttyd2
Connected

P4X: SELF-TEST
Duart1     test: completed
Mpu        test: MC68040 completed

Clock      test: completed
Mmu        test: completed
Calender   test: completed

Centronics test: not ready
Fpu        test: completed
Ethernet   test: completed

Checking Memory: 0008 Mbytes RAM detected

OS-9/68K System Bootstrap

Will try to Boot from network

To get the boot menu press Esc 

Now trying to Boot from network.

inetboot: using P4x (MC68360) Ethernet @ 0xFFD80C00 MTU=1500
bootp: 0:40:98:0:0:c5 broadcasting for server
bootp: recv waiting 50 ticks

GOT BOOTP RESPONSE from server 192.168.99.1!
My IP address will be: 192.168.99.5
My tftp bootfile is: /usr/xepr/Acquisition
Server/OS9/CPU/P4X/BOOTP/os9boot
My bootfile size is: 1380 (512-byte) blocks
My subnet mask is: 255.255.255.0

<<no timeoffset tag>>
tftp: fetch 1380 blocks
tftp: server response 192.168.99.1 port 1044

tftp: expected 1380: received 1379:76 blocks (690Kb)
A valid OS-9 bootfile was found.
-------------------------------------------------------------------

CPU Board Name: P4X
-------------------------------------------------------------------
starting ISP subsystem ...

+4

IP Routing Table:

Add gateway = 0.0.0.0 gateway = 192.168.99.1 to NET routing list
+8

-------------------------------------------------------------------
mounting '/xacq' ...
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mounting '/dd' ...
mounting '/r0' ...
-------------------------------------------------------------------

Mount Status     13:17:06
OS-9        Remote      Gid/Uid     Mount
Device      System      Map         Point

------      ------      --------    -----
/xacq       BootWS      yes         /usr/xepr/AcquisitionServer/OS9
/dd         BootWS      yes         /usr/xepr/Acquisition
Server/OS9/CPU/P4X
/r0         BootWS      yes         /usr/xepr/Acquisition
Server/OS9/Servers/E500/r0

-------------------------------------------------------------------
PROMPT=E500# 
PATH=/dd/CMDS

HOME=/r0
AcqSvCPURootPath=/dd
AcqSvRootPath=/xacq/Servers

AcqSvCPUName=P4X
AcqSvHostName=E500
+21

AcqSvG: 'AcqServerD' started ...
-------------------------------------------------------------------

E500# 

If the ACPU is not booted correctly there will be error
messages. The following demonstrates what happens
when the ACPU hardware address is incorrect or the
ACPU is not connected to the UNIX workstation cor-
rectly.
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Now trying to Boot from network.
inetboot: using P4x (MC68360) Ethernet @ 0xFFD80C00 MTU=1500
bootp: 0:40:98:0:0:c5 broadcasting for server
bootp: recv waiting 50 ticks
bootp: retry 1 with new timeout=0
bootp: 0:40:98:0:0:c5 broadcasting for server
bootp: recv waiting 50 ticks
bootp: retry 2 with new timeout=0
bootp: 0:40:98:0:0:c5 broadcasting for server
bootp: recv waiting 50 ticks
bootp: retry 3 with new timeout=0
bootp: 0:40:98:0:0:c5 broadcasting for server
bootp: recv waiting 50 ticks
bootp: retry 4 with new timeout=30
Exiting after 5 retry
This error occurred during the  Internet boot boot driver!
The OS-9 error code is: #007:025.

Now trying to Reconfigure the boot system.

BOOT SYSTEM RECONFIGURATION

Boot drivers available:

1 - Boot from Teac SCSI floppy drive
2 - Boot from OMTI 5400 SCSI floppy drive
3 - Boot from SCSI hard drive
4 - Boot from SCSI tape drive
5 - Boot from ROM
6 - Boot from network

The priority of these boot drivers can be set below and will remain
set even when power to your system is turned off.  This priority
determines the order that the boot drivers will be selected when
your
system is configured to boot automatically.  It also determines the
order that they appear in the "boot driver menu" as well.

The current system boot driver priority is: 6

Enter the numbers of the boot drivers in the order that you want
them prioritized. -> 
that you want them prioritized. -> 
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4. Find the correct ACPU address. A common error is
an incorrect ACPU address. This address is the hardware
address of the ACPU�s ethernet adapter, not the ACPU�s
IP address. There are several ways to find the correct
ACPU hardware address. 

�  From the output of the cu command: 

bootp: 0:40:98:0:0:c5 broadcasting for server

where 0:40:98:0:0:c5 is the hardware address. However,
y ou  ne ed  to  co nv er t  to  t he  fo l lo wi ng  fo rmat ,
0x0040980000c5, when you edit the ServerSetup file.

�  From the SYSLOG or messages file. In a UNIX shell
window type tail -f /dev/adm/SYSLOG for an SGI O2
workstation or tail -f /var/log/messages for a Linux
workstation. Then reset the ACPU. The screen display
will indicate the correct ACPU hardware address.

eleXsys /> tail -f /var/adm/SYSLOG
Aug  8 22:15:44 6B:eleXsys Xsession: xuser: login

Aug  8 22:17:21 6D:eleXsys bootpd[673]: reading new "/etc/bootptab"
Aug  8 22:17:21 6D:eleXsys bootpd[673]: read 4 entries (1 hosts) from "/etc/bootptab"
Aug  8 22:17:21 5D:eleXsys bootpd[673]: Ethernet address not found: 0040980000C5

Aug  8 22:17:32 5D:eleXsys bootpd[673]: Ethernet address not found: 0040980000C5

For a Linux system the error message is slightly different.

Aug  8 22:17:32 epr-linux bootpd[5504]: unknown client Ethernet address 00:40:98:00:00:C5

�  From the ACPU board label. The ethernet adapter has a
label attached to it indicating the adapter hardware
address.
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5. Check the bootptab file. Open the /etc/bootptab file.
The file contains the information for the ACPU to boot.
(See Figure 17-6.)

6. Check the Ethernet configuration (IRIX). The ec0
ethernet adapter should be set as primary while ec1
should be set as secondary with the host name of Xepr. If
you reconfigure the ethernet settings you need to reboot
the workstation. Instead of rebooting the workstation you
can recycle the network script if you are a UNIX expert.

Figure 17-6 The contents of the bootptab file.

# First, we define a global entry which specifies the stuff every
# host uses.
#
# the bs tag is required for OS-9 BOOTP clients
# bf is set to os9boot to cause the bootfile.host lookup action
# hn is set so that the client host name is sent in the vendor 
# specific area
#
allOS9PECO43:sm=255.255.255.0:td=/:hd=/usr/xepr/AcquisitionServer
/OS9/CPU/PECO43/BOOTP:bs=auto:hn:bf=os9boot:
allOS9P4X:sm=255.255.255.0:td=/:hd=/usr/xepr/AcquisitionServer/OS9
/CPU/P4X/BOOTP:bs=auto:hn:bf=os9boot:
allOS9MVME162:sm=255.255.255.0:td=/:hd=/usr/xepr/AcquisitionServer
/OS9/CPU/MVME162/BOOTP:bs=auto:hn:bf=os9boot:
#                        
# individual hosts
#                                          
E500:tc=allOS9P4X:ht=ethernet:ha=0x0040980000c5:ip=192.168.99.5

Server IP
Address

Server
Name

Type of
CPU

Hardware
Address
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7. Check the Ethernet configuration (Linux). Type
/sbin/ifconfig in a terminal window and you will receive
information regarding your network settings. For exam-
ple:

eth0      Link encap:Ethernet  HWaddr 10:00:00:42:54:01 
          inet addr:137.1.7.27  Bcast:137.1.255.255  Mask:255.255.0.0

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1
          RX packets:5298627 errors:0 dropped:0 overruns:0 frame:0
          TX packets:24 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:100 
          Interrupt:19 Base address:0x1080 

eth1      Link encap:Ethernet  HWaddr 10:00:00:42:54:02 
          inet addr:192.168.99.1  Bcast:192.168.99.255  Mask:255.255.255.0
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:248023 errors:0 dropped:0 overruns:0 frame:0
          TX packets:180600 errors:0 dropped:0 overruns:0 carrier:0
          collisions:0 txqueuelen:100 

          Interrupt:19 Base address:0x1000 

lo        Link encap:Local Loopback  

          inet addr:127.0.0.1  Mask:255.0.0.0
          UP LOOPBACK RUNNING  MTU:3924  Metric:1
          RX packets:139 errors:0 dropped:0 overruns:0 frame:0

          TX packets:139 errors:0 dropped:0 overruns:0 carrier:0
          collisions:0 txqueuelen:0 

Check that the following is set for eth1:

inet addr: 192.168.99.1

Bcast: 192.168.99.255

Mask: 255.255.255.0

8. Check the services. It is crucial for the acquisition
server to be able to access some critical services such as
bootp, tftp, and nfs. If a booting problem only exists after
you configure the services or turn off some flags, you may
have blocked critical services from the acquisition server.
Reconfigure the services or turn the flags on. The nfs flag
must be on to allow Xepr to work properly. Use chkcon-
fig to check the flags. Make sure the nfs and network flags
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are on. If they are off you need to turn them on and restart
the workstation. (See Section 15.3.1 or Section 16.3.1.)

9. Check the lookup sequence. Set files as the first
choice for the lookup sequence. Setting the NIS or DNS
servers prior to files in the lookup sequence may cause
ACPU booting problem. (See Section 15.2.3 or
Section 16.2.3.)

10. Check the guest or nobody account. Although the
guest or nobody account has been locked and hidden,
Xepr uses this account to transfer files. Do not delete this
account. If the guest or nobody account does not exist you
need to create one.

11. If problems still exist. You may need to reinstall the
Xepr software and acquisition server. Sometimes, deleting
the existing Xepr folder (/usr/xepr) before reinstallation
may help you to get rid of problems. (See Section 15.4 or
Section 16.4.) If problems still persist call your Bruker
EPR service representative.

Xepr running on an
SGI IRIX workstation
uses the guest account.
Xe p r  ru n n i n g  on  a
Linux workstation uses
the nobody account.
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Transputer Diagnostics 17.2.2
If the ACPU is booted but the transputer device LEDs are not lit,
the transputer devices are not booted correctly. Follow the chart
to locate the problem.

Figure 17-7 The transputer device diagnostics chart.
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Trouble Shooting
1. Check the hardware. Check the Burndy cable for each
transputer device. The power (+5 V) and the clock
(10 MHz) are supplied through the Burndy cable. Check
the transputer links. The black end connects to OUT and
the red end connects to IN. Check if the links are valid.
(See Section 13.2.4.)

2. Check the transputer network. You can use a com-
mand called callispy to check the transputer network. 

�  If the cu command is still active you will find a # prompt
sign after the server name when the ACPU boots prop-
erly. Typing callispy followed by the Enter key will
launch the diagnostics program.

�  You can also open a UNIX shell window and type telnet
server name. Use root as the user name and root! as the
password. After you login you can enter callispy when
the prompt sign # appears. 

The output of the callispy command displays information
about the transputer network. The example in Figure 17-8
shows a typical Elexsys system with a TVI transputer
board, a field controller, a high frequency signal channel,
a low frequency channel, and a bridge controller.
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Figure 17-8 The output of the callispy command.

E500# 

E500# callispy
Using FCF00000 ispy 2.31x
   # Part rate Mb Bt [  Link0  Link1  Link2  Link3 ]
   0 T805g-20 0.53 0 [   HOST    1:0    ...    ... ]
   1 T16  -20 1.51 0 [    0:1    2:0    ...    ... ]
   2 T16  -20 1.46 0 [    1:1    3:0    ...    ... ]
   3 T16  -20 1.51 0 [    2:1    4:0    ...    ... ]
   4 T16  -20 1.51 0 [    3:1    ...    ...    ... ]

Link number to which this link is connected
Device number to which this link is connected
Link transfer rate (in Mbits/s)
Transputer clock (in MHz)
Type of transputer
Device number in the order they were found
(device 0 = TVI Transputer board)

IN OUT1 OUT2
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3. Check the device type ID. In order to boot the trans-
puter devices, the server needs to know not only how the
devices are connected but also which devices they are.
Each device is identified by a Bruker Board Identification
System (BBIS) device type ID number that is contained in
an EEPROM. Upon the acquisition server prompt # sign,
use the command TRPDiag. Typical output is as follows.

E500# TRPDiag
Following Transputer Bootfile Version have been installed:
HALL V2.20
MBCT V2.25
SCT V2.22
SCTL V2.22

Display BBIS Information ? ( Y/N )

All 4 transputer devices (the Hall field controller, the
microwave bridge controller, the high frequency signal
channel, and the low frequency signal channel) are prop-
erly identified and the bootfiles have been installed. If you
answer Y to the question Display BBIS Information?
(Y/N) the detailed information about each device such as
the serial number, EC-level, BBIS version, device type,
number of links, etc., will be displayed. 

The TRPDiag  com-
mand does not work
immediately after the
command cal l ispy.
Reboot the acquisition
server before you start
the  TRPDiag  com-
mand.
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4. Check the transputer booting files. The server
needs to know where to find the correct bootable files for
each device. A file called trpboot lists the device type ID,
the corresponding bootable file, and the path of the file.
You can check the trpboot file in a UNIX shell window.
Change to the /usr/xepr/AcquisitionServer/OS9/Serv-
ers/<Server name: e.g. E500, E580, etc.>/r0 directory
and then type os9view trpboot. The contents of the trp-
boot file looks as follows.

eleXsys /usr/xepr/AcquisitionServer/OS9/Servers/E500/r0> os9view trpboot
****************************************************************************
*
* BOOT FILE FOR THE TRANSPUTER SYSTEM
*
* The instructions and comments.
*
*******************************************************************************************

#DEVICE:        /trp/root               * name of ROOT transputer

#BOOTFILES

        0       0       /xacq/Servers/TRPBTL/ident16.btl        * Initial Loading File
        1       0       /xacq/Servers/TRPBTL/ident32.btl        * Initial Loading File
        4       0       /xacq/Servers/TRPBTL/er032t_win.btl     * ER032T Field Controller
        5       0       /xacq/Servers/TRPBTL/mbct_win.btl       * Microwave Bridge Controller
        6       0       /xacq/Servers/TRPBTL/sct_win.btl        * High Frequency Signal Channel
        7       0       /xacq/Servers/TRPBTL/mwb_win.btl        * Microwave Bridge Controller
        10      0       /xacq/Servers/TRPBTL/sctl_win.btl       * Low Frequency Signal Channel
        11      0       /xacq/Servers/TRPBTL/ppu.btl            * Pulse Programmer
        12      0       /xacq/Servers/TRPBTL/tsa_win.btl        * Transient recorder

#DUMMYFILES

        0       0       /xacq/Servers/TRPBTL/dummy16.btl        * Dummy Loading File
        1       0       /xacq/Servers/TRPBTL/dummy32.btl        * Dummy Loading File
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5. Check for transputer device booting errors. If the
bootable file for the device type ID is missing, file
name/extension is incorrect, or the file is in a wrong direc-
tory the transputer device will abort the booting proce-
dure. The error messages are stored in the file called
trpstart.out in the same directory as the trpboot file. You
can view this file by typing os9view trpstart.out.
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A
accessories 12-1 to 12-44

accumulations per point (See rapid scan.)
ACPU (See acquisition server.)
acquisition server

address 17-12
booting process 17-4, 17-5
connections 17-2, 17-3
diagnostics 17-1 to 17-21
installation 15-8, 16-14
network interface

Linux 16-3
SGI 15-2

trouble shooting 17-6 to 17-21

ADF 6-1 to 6-19

accumulations 6-1
AI 13-19, 13-20
AUX 13-18, 13-19
connectors 13-18 to 13-20
digitizing rate 6-1
externally controlled field sweep 14-33,

14-34
indicators 13-17, 13-18
transient signal capture 14-32

AFC trap 2-15, 3-4

automatic post-processing 9-1 to 9-14

$nr-Start 9-5
activating 9-2 to 9-7
Auto #2 9-8 to 9-10

Auto #3 9-8, 9-11, 9-12
calling sub-routines 9-8, 9-9
chain routine 9-8 to 9-14
checking 9-6, 9-12, 9-13
command 9-4
defining 9-3, 9-10, 9-12
enabling 9-3, 9-10, 9-12
FFT-type 9-4
handle number 9-5
multiple routines (See automatic

post-processing, chain routine.)
post-save 9-4
raw-save 9-3
save-file 9-4
save-path 9-4
save-title 9-4
storing 9-4

B
bridge (See microwave bridge.)
BVT 1000 (See variable temperature.)
BVT 2000 (See variable temperature.)
BVT 3000 (See variable temperature.)

C
calibration (See individual units or acces-

sories.)
cavity
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calibration (See signal channel, calibra-
tion.)

configuration
Linux workstation 16-7 to 16-12
magnetic field 4-1 to 4-4
microwave band 4-5
microwave frequency counter 4-6
SGI workstation 15-4 to 15-6
signal channel 4-10, 4-11
signal paths (See wiring & connectors.)
spectrometer 4-1 to 4-11
temperature controller 4-8
transient recorder 4-9

connector (See wiring & connectors.)
console module arrangement 13-1

D
delay time (See rapid scan, field sweep,

delay time.)
digitizer (See ADF.)
DIP switches (See microwave bridge con-
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DNS 15-2, 15-3, 16-3 to 16-5, 17-15

double modulation (See setup.)
DPPH 2-2, 2-3, 2-5, 2-9, 2-12, 2-13, 2-17,

2-18, 2-20, 7-12, 12-28, 12-29, 14-8

E
E 033M (See FF-Lock.)

E 035M (See teslameter.)
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ER 218PG1 (See goniometer.)
ER 4111 VT (See variable temperature.)
ER 4112 HV (See variable temperature)
ER 4121 VT (See variable temperature.)
ER 4131 VT (See variable temperature.)
ESR OUT 13-2, 13-11, 13-19
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configuration 17-13, 17-14
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experiment setup 14-1 to 14-34

EXT. MOD OUT 13-2, 14-25

EXT. MOD. IN 13-3, 13-13, 14-19, 14-25

EXT. SIG. IN 13-2, 13-11, 14-24, 14-25

EXT. TRG 13-2, 13-3, 13-11

external modulation (See setup.)
external trigger (See setup.)

F
fast digitizer (See ADF.)
FF-Lock 12-17 to 12-30

button 12-21, 12-22
cable 11-2
configuration 4-2
connecting

ER 032 T cable 12-18
GSI board 12-20
IEC 625 12-20
I-2



Index
MAG IN 12-19
MAG. OUT 12-18
MOD OUT 12-20
Modulation/Sweep 12-20
power supply cable 12-20
probe head 12-20
SIG IN 12-20
signal cable 12-20
SWA 12-19

error 12-24, 12-25, 12-30
external standard 12-17, 12-26, 12-28
IEEE 488

DIP switches 12-21
installation 12-18 to 12-21
lock-in mode 12-21 to 12-23
lost lock 12-24
marker 12-27
marker mode 12-26 to 12-30
maximum sweep width 12-25
offset calibration 4-2, 12-28, 12-29
operating range 12-17, 12-24, 12-25
probe 12-17, 12-18, 12-20, 12-26, 12-28
troubleshooting 12-24, 12-25

field controller
(See Hall field controller.)

field frequency lock (See FF-Lock.)
field offset (See Hall field controller, field

offset.)
Fremy�s salt 5-2

frequency counter 12-2 to 12-5

Bruker frequency counter 12-4
cable 11-2
configuration 4-6
EIP 12-4, 12-5

HP 12-4, 12-5
MBC 12-2, 12-3

calibration 12-3
configuration 12-2

frequency drift 12-17

FTP 15-6, 15-29, 16-42

G
gaussmeter (See teslameter.)
g-factor

display 5-10
DPPH 2-2
measurements 5-9, 5-10
perylene 5-2
pitch sample 2-3
precision 5-10

goniometer 12-39 to 12-44

2D experiment 12-43, 12-44
cables 12-39
configuring 12-40 to 12-44
defining experiments 12-40
defining zero 12-42
initializing 12-42
installation 12-39, 12-40
set angle 12-42

GSI 12-20, 12-32, 17-2, 17-5, 17-6

H
Hall field controller
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configuration 4-2
connectors 13-15
field offset 5-1 to 5-9

calibration 4-2
measurement 5-2 to 5-7
measurement tips 5-8, 5-9
standards 5-1

indicators 13-5, 13-15

HCPU (See Hall field controller)
help

accessing 10-4
file format 10-1, 10-2
file locations 10-3
filenames 10-3
implementing 10-1 to 10-4
keyword 10-4
selection box 10-4

high pass filter 2-15, 3-4, 14-23, 14-28

hysteresis 5-8, 6-13

I
IEC 625 12-20, 12-32

IEEE 488
address

FF-Lock 4-2, 12-21
frequency counter 4-6
ITC 5 12-10
temperature controller 4-8
teslameter 4-3
transient recorder 4-9

connection
FF-Lock (See FF-Lock, connecting.)
frequency counter 12-5

indicators & connectors 13-2 to 13-7

input mode (See rapid scan, time sweep or
rapid scan, field sweep.)

IRIX (See SGI workstation.)
ITC 503 (See variable temperature)

L
Linux workstation 16-1 to 16-42

configuration 16-7 to 16-12
general information 16-1, 16-2
network setting 16-3 to 16-6

LOCK OUT 13-2, 13-11

M
macro 8-1 to 8-16

%ARG 8-11
%DESC 8-10
%NOHIS 8-10
%TERM 8-10
argument 8-11
comments 8-15
data type 8-12
default value 8-12
dialog box 8-13, 8-14
editing 8-10 to 8-16
example 8-15, 8-16
executing 8-6
flag 8-12
hotkey 8-8
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naming 8-3
recording 8-2 to 8-6
user button 8-7 to 8-9

microwave bridge
changing 11-1 to 11-8
cooling water

connecting 11-5
disconnecting 11-1

installing 11-4 to 11-8
iris motor controller cable 11-2
power supply cable

connecting 11-5
disconnecting 11-2

remote control cable 11-2
connecting 11-5

removing 11-1 to 11-3
signal cable

connecting 11-6
disconnecting 11-2

microwave bridge controller
DIP switches 11-7, 11-8
frequency offset calibration 4-6

MOD REF 13-2, 13-10

modulation amplifier 13-13, 13-14

monitoring panel
selecting position 15-11, 16-19

N
networking

Linux workstation 16-3 to 16-6, 16-40 to
16-42

SGI workstation 15-2, 15-3, 15-27 to
15-29

NFS 15-2, 15-4, 15-5, 15-29, 16-3, 16-7,
16-12, 16-42

nonlinear 2D experiment 7-9 to 7-12

user defined scan 7-10

nonlinear acquisition 7-1 to 7-12

nonlinear field sweep 7-2 to 7-8

user defined sweep 7-5

P
PADS (See Fremy�s salt.)
perylene 5-2

PID 12-16

pitch samples 2-3

printer
installing

Linux workstation 16-28 to 16-34
SGI workstation 15-20 to 15-23

setup
Linux workstation 16-21, 16-22
SGI workstation 15-13, 15-14

printing
Linux workstation 16-35 to 16-37
printer setup (See printer.)
SGI workstation 15-23, 15-24
trouble shooting

Linux workstation 16-38, 16-39
SGI workstation 15-25, 15-26
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Q
quadrature detection (See setup.)

R
ramp-down time (See rapid scan, field

sweep.)
ramp-up time (See rapid scan, field

sweep.)
rapid scan

2D experiment 6-16, 6-17
configuration 4-4
field sweep 6-7 to 6-15

accumulations per point 6-14, 6-15
calibration 6-18, 6-19
center field offset 6-11, 6-13, 6-19
configuration 6-8
defining experiment 6-9
field parameters 6-11
input mode 6-12, 6-13
rapid scan coils 6-8
repetition frequency 6-15
RSC trigger mode 6-12, 6-13
sweep delay time 6-12, 6-15
sweep ramp-down time 6-12, 6-15
sweep ramp-up time 6-12, 6-14
sweep width 6-11, 6-13

time sweep 6-1 to 6-6
accumulations per point 6-5
defining experiment 6-2
external point 6-6
external sweep 6-6
input mode 6-6
internal point 6-6
internal sweep 6-5
sweep time 6-5

trigger mode 6-5
trigger slope 6-6

rapid scan coils (See rapid scan, field
sweep.)

remote operation (See networking.)
repetition frequency (See rapid scan.)
RESONATOR 1 13-3, 13-14, 14-2

RESONATOR 2 13-3, 13-14, 14-2

RS 232
Bruker frequency counter 12-4
VT system 12-6

RS IN 13-3, 13-14

RS OUT 200 G 13-3, 13-14

RS OUT 50 G 13-3, 13-14

RSC
calibration (See rapid scan, field sweep.)
connectors 13-21 to 13-23
indicators 13-21
trigger 13-21, 13-22

(See also rapid scan, field sweep and set-
up, external trigger.)

S
safety

chemical i-iv to i-vi
electrical i-iv
microwave i-vi

SCT (See signal channel)
SCT-PS
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connectors 13-2, 13-8
indicators 13-9

server name 15-12, 16-20

setup
double modulation 14-24 to 14-29
external field modulation 14-19, 14-20
external trigger

ADF 14-15, 14-16
RSC 14-17, 14-18
SCT 14-13, 14-14

externally controlled field sweep 14-33,
14-34

field sweep with ADF 14-3
field sweep with SCT 14-2
other modulation 14-21 to 14-23
quadrature detection 14-5 to 14-12

using ADF 14-30, 14-31
rapid field scan with ADF 14-4
time sweep with ADF 14-3
time sweep with SCT 14-2
transient quadrature capture 14-32

SGI workstation 15-1 to 15-29

configuration 15-4 to 15-6
general information 15-1
network setting 15-2, 15-3

SIG. IN 13-2, 13-8, 13-11, 14-24

signal channel
calibration 2-1 to 2-27

cryostat removal before calibration 2-9
DPPH sample positioning 2-18
dual cavity 2-14
file 2-13
harmonics 2-13
modulation amplitude 2-5, 2-6

modulation amplitude limit 2-23 to 2-25
modulation frequency 2-12, 2-26
modulation phase 2-7
parameters 2-10 to 2-18
practice 2-9 to 2-27
resonator

1st 2-14
2nd 2-14
EN 801 2-18
ER 4105DR 2-14
ER 4119HS 2-25
ER 4122SHQ 2-13
ER 4122SHQE 2-25

theory 2-4 to 2-8
tuning box 2-6
tuning capacitor (See tuning capacitors.)

configuration (See configuration, signal
channel.)

connectors 13-2, 13-3, 13-10 to 13-12
indicators 13-4, 13-12
LEDs (See indicators.)
power supply (See SCT-PS.)

signal to noise measurement 3-2 to 3-28

calculation 3-22 to 3-26
formula 3-2
linear drift 3-21
noise 3-13 to 3-22
parameters 3-3, 3-28
signal 3-6 to 3-12
standard cavity 3-28
weak pitch 3-4

slow device bus
ER 4111 VT 12-6
goniometer 12-39

standard samples 2-2, 2-3
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strong pitch (See pitch samples.)
SWADV 13-2, 13-8, 13-15, 14-33

system performance tests 3-1 to 3-28

T
telnet 15-28, 16-41, 17-17

TEMP 13-4, 13-9

temperature controller (See variable tem-
perature.)

teslameter 12-31 to 12-38

activating 12-33, 12-34
configuration 4-3
installation 12-31 to 12-33
modulation 12-35
offset calibration 4-3, 12-37, 12-38
optional control 12-36
resolution 12-35
search direction 12-36
search limit 12-36
standard control 12-35
troubleshooting 12-38

transient recorder
configuration 4-9

transient signal capture (See setup.)
transputer

booting 17-5
connectors 13-6 to 13-7
diagnostics 17-16 to 17-21

trigger mode (See rapid scan, time sweep
or rapid scan, field sweep.)

trigger slope (See rapid scan, time sweep.)
TTL 13-2, 13-3, 13-8, 13-11, 13-15, 13-18,

13-21, 13-22, 14-13, 14-15, 14-17,
14-21, 14-25, 14-31, 14-32

tuning
capacitors 2-5 to 2-7, 2-12, 2-22, 4-11

typographical conventions 1-4

V
variable temperature 12-6 to 12-16

BVT 1000 (See ER 4111 VT.)
BVT 2000 (See ER 4121 VT.)
BVT 3000 (See ER 4131 VT.)
configuring 4-8, 12-7, 12-11
connecting 12-6, 12-10
defining experiments 12-9, 12-12
ER 4111 VT 12-6 to 12-9
ER 4112 HV 12-10 to 12-16

gas flow 12-15
heater 12-15
ITC Control 12-14 to 12-16
PID 12-14, 12-16
set temperature 12-12
setting up 12-10 to 12-12
temperature folder 12-12, 12-13
tolerance 12-13

ER 4121 VT 12-6 to 12-9
ER 4131 VT 12-6 to 12-9
ITC 5 (See ER 4112 HV.)
offset 4-8

VT or VTU (See variable temperature)
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W
waveguide

extension 11-4

weak pitch (See pitch samples.)
wiring & connectors 13-1 to 13-23

X
Xepr

aborting
Linux workstation 16-26, 16-27
SGI workstation 15-18, 15-19

files to backup
Linux workstation 16-13
SGI workstation 15-7

icon 15-9, 16-17
initial setup

Linux workstation 16-15 to 16-23
SGI workstation 15-9 to 15-15

reinstalling
Linux workstation 16-13, 16-14
SGI workstation 15-7, 15-8

starting
Linux workstation 16-24, 16-25
SGI workstation 15-16, 15-17

upgrading
Linux workstation 16-13, 16-14
SGI workstation 15-7, 15-8

Xepr printer (See printer.)
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